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GlobalSCAPE Replication Software 

GlobalSCAPE's 100% software solutions inexpensively deliver new levels of acceleration, remote-site file 
sharing, and continuous backup. The software runs on your existing Windows servers - just load the 
Agent on a server at one or multiple sites. Only file differences at the byte level, compressed, ever 
transfer. The software operates in real time, with advanced acceleration and optimization techniques 
performed end-to-end. 

GlobalSCAPE's replication software delivers real-time, global data solutions for all Windows server 
platforms. The software mirrors multidirectionally between any number of remote servers, without file 
conflicts, open-file issues, or changes to any LAN, WAN, router, or user configuration.   

Wide Area File Services (WAFS) allows branch office users to access and share files over the WAN at 
LAN speeds through proprietary algorithms that continuously monitor file changes at the byte level and 
transfer only the differences. WAFS also supports native file locking, so users can access files with WAFS 
exactly the same way they do on the LAN, except that they can share files and work with any branch 
office, anywhere, as if it were locally connected. 

Continuous Data Protection (CDP) backs up all of your data as quickly as changes are made. If you 
need to roll back to a previous version of a file, with CDP you can restore that backup to any point in time. 
The servers back up files to your backup site in real time as they change. The backup site can be at the 
same location or any remote location. CDP ensures that bandwidth use is minimized and that latency will 
not affect the integrity and availability of the mirrored data. Should anything happen to your servers, you 
can failover to the backup or any other redundant backup site. The backup server can keep any number 
of past versions of each file, including deleted files, and allows you to restore from point-in-time 
snapshots. You can restore via browser, directly from disk, or you can recreate an entire server 
transparently over the network. 

Enterprise combines the functionality of WAFS and CDP into one package. Run Enterprise on your 
servers if you need a true wide area file service with file acceleration and real-time mirroring, but you also 
need continuous file server backup that keeps track of all changes made and allows you to restore data to 
any point in time.  

An example Enterprise deployment at an engineering firm includes the following software: 

 In Boston, deploy Enterprise to provide a multidirectional solution for engineering files.  

 In Chicago, deploy WAFS Multi-Directional, which coherently synchronizes the engineering files 
with the Boston and Denver sites.  

 In Denver, deploy WAFS Multi-Directional, which coherently synchronizes the engineering files 
with the Boston and Chicago sites.  

 Finally, deploy a Backup in NYC, to backup the accounting files.  

For examples of how GlobalSCAPE customers are using WAFS in their organizations, review the various 
case studies available at http://www.globalscape.com/products/casestudies.aspx. 

What's New? 

Changes in version 3.7.1 

 Bandwidth settings have been improved. There are now three settings: Low, High, and Auto. The 
new setting labeled „Low‟ is closest to the setting previously labeled „Normal‟. The new „High‟ 
setting is closest to the previous setting „VHigh‟, but with significant improvements. Auto behaves 
as it did previously, dynamically changing the throttling based on recent activities. As before, 
upload and download are each set separately. Due to the performance improvements in this 
release, „High‟ is now the recommended setting for most users. „Low‟ is only recommended for 
users that have very slow network connections. „Auto‟ remains the default for both upload and 

http://www.globalscape.com/products/casestudies.aspx
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download. When Auto is selected, the Agent will check the activity on regular intervals to 
determine whether to use high or low bandwidth. This interval can be set in the registry. 

3.6.2 3.7.1 

Normal Low 

High High 

VHigh High 

Auto (default) Auto (default) 

Changes in version 3.6.2 

 Added support for Autodesk Revit Worksharing Monitor.  

 Added support for Windows Vista  (both 32-bit and 64-bit version) and Windows 2008 (both 32-bit 
and 64-bit version) 

 On Windows 2008, both the Server and Agent are installed as applications, with no option to run 
as a service. You can configure the Agent and/or Server to start when you log in to the computer. 

 Web Admin Interface file list can be sorted by name, type, size, and modified date.  

Changes in version 3.6.1 

 Revit Support - Allows WAFS to work more efficiently with AutoCAD Revit files. 

 Filtering capabilities - Using filters, you can exclude certain files, file types, or folders from being 
replicated. 

 Retention of Opened Files and Directories - Opened file handles are now retained at the Server 
for disconnected Agents, which prevents more than one person from editing a file at the same 
time. 

 Offline Mode - Administrators can specify that users should have full access or read-only access 
when an Agent is disconnected from the Server. 

 Unmonitored Mode - Administrators can specify that users should either have access or not have 
access to files when an Agent is not running. 

 User interface improvements - More intuitive, cleaner layout. 

 Improved stability 

For the Best WAFS/CDP Experience 

For the best WAFS/CDP experience, you should read the entire user guide to familiarize yourself with the 
concepts and procedures. The Table of Contents and the Index contain the topic titles of every topic in 
the user guide. The Table of Contents is organized in the order in which most users will need the 
information (i.e., Installing the Software, Configuring and Using the Server, Configuring and Using the 
Agent, Configuring and Using Jobs). The Technical Notes section provides procedures for advanced 
users (e.g., Using the Software with IIS, Deploying a Multiple Server Configuration, Changing the Server's 
IP Address and Port). 

If you are unable to find an answer to your question in the user guide, Knowledge Base, or user forum, 
please contact GlobalSCAPE Customer Support at http://www.globalscape.com/support/.  

http://kb.globalscape.com/
http://forums.globalscape.com/tt.aspx?forumid=31
http://www.globalscape.com/support/
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Getting Started 

Get up and running in minutes with the following topics, which allow you to perform initial replication at 
new Agent sites quickly and easily.  

 WAFS Quick Start - how to deploy the software in a WAFS configuration 

 CDP Quick Start - how to deploy the software in a CDP configuration 

 Installing the Software 

 Getting Started with FastMerge - frequently asked questions regarding configuring and using 
FastMerge to complete initial data replication 

 Quick Reference - a quick reference for common questions regarding Server setup and operation 

 File-Naming Conventions - naming your files for successful replication 

WAFS Quick Start 

WAFS allows computers to synchronize their data in real time using very little bandwidth. When a user 
opens a WAFS-linked directory, every document in it is guaranteed to be current – even if a colleague 
elsewhere just made a change to it a split-second ago.  

WAFS is completely transparent; end-users open their files through the Windows Explorer or Open dialog 
box, just as they would any other file. 

 

The WAFS topology consists of the following: 

 Server computer. Acts as a "traffic cop" and data vault for retention of both current and previous 
versions of files  

o Runs the Server software 

Two or more Agent computers. Provide access to the most current versions of files to end users 

o Each computer runs the Agent software  

Jobs 

Jobs are the basic building blocks of a WAFS deployment and represent the collection of synchronized 
folders files. Jobs are created based on an existing top-level folder on the Agent machine. Once a folder 
has been selected for replication, full synchronization of that folder and its contents is ensured between 
that computer and the other computers that are also linked to that Job. 
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For example, suppose a firm‟s London office links a folder "clients" on their local file Server to a Job 
"CLIENTS" on the firm‟s Server in NYC. A branch in Tokyo links a local folder "clients" to the same Job 
"CLIENTS." From then on, the contents of London‟s "clients" folder and Tokyo‟s "clients" folder will be the 
same. Any change in one is synchronized to the "CLIENTS" Job, which then is replicated to every other 
folder linked to it. London and Tokyo‟s folders are both still local, so access to even large files is at LAN 
speeds.  

How to Install WAFS: Overview 

WAFS deploys in just three easy steps: 

1. Install the Server on the Server computer.  

2. Install the first Agent on the first Agent computer, and use it to create a Job. 

3. Install additional Agents on other Agent computers and link to that same Job. 

What’s Next? 

After you have finished installing WAFS, any change made in any folder linked to the Job you created 
appears in every other folder linked to that same Job. Try this out by creating a file in the linked folder of 
the first Agent. The file will show up in the second Agent‟s linked folder. Change that file in the second 
folder--the copy in the first folder will be changed, too.  

Review the user guide for important information, including how to: 

 Change the default administrator login account. 

 Create additional Jobs.  

 Link additional Agents to an existing Job. 

 Create user accounts so that only approved users can access the data.  

 Manage the Job‟s data, including retrieving past versions or deleted files, using the Server‟s web 
interface. 

 Unlink a given folder from a Job. You may also want to remove a Job from the Server altogether. 

 Use FastMerge for replicating large amounts of data more efficiently. 

 Access the Server, Agent, and Jobs with the user interfaces. 

 Configure advanced features. (For example, if you are using WAFS with Revit, refer to Using 
Revit with GlobalSCAPE WAFS.) 

 Configure the software to work with Microsoft XP, IIS, and antivirus software 

Common Problems with Establishing WAFS 

Most users set up WAFS quickly and easily using the deployment wizard. Below are common issues 
encountered when setting up WAFS, and recommended solutions. 

1. The Agent cannot connect to the Server. 
 
Make sure the Server is running, and that it is using a port that allows TCP/IP traffic between the 
two computers. By default, the Server uses TCP/IP port number 80, but that port may already be 
used on the computer (e.g., by IIS), or may be blocked by a firewall. You can change the port 
number in the Server Parameters dialog box and allow access in the firewall.  
 
There are also issues specific to XP firewalls and Microsoft ISA. 
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2. The master cannot create a backup Job because of the ACLs of files in the selected folder. 
 
The Agent works as a SYSTEM process, so it must have full control over all the files in order to 
access them. You must ensure that the SYSTEM account (a predefined "user" on every Windows 
computer) has full-control over every file and folder. You can let it add SYSTEM or you can add 
SYSTEM to every file/folder yourself, using Windows Explorer. You can also use Microsoft's 
cacls.exe or Xcacls.exe utility to display or modify access control lists (ACLs) of files. 

3. Some third-party applications may need adjusting. 
 
Old versions of StorageExec, QuotaAdvisor, PowerQuest, UltraBac, DoubleTake, and UnDelete 
may cause performance issues.  

CDP Quick Start 

CDP provides true, continuous, real-time, tape-less backup and disaster recovery. Any change made to 
files in selected folders on the master system is quickly mirrored onto a remote backup location, ready to 
be used if the master system breaks. Past versions of files, including deleted files, are also available. 
CDP runs on all Windows Server platforms. 

The CDP layout consists of two computers running three applications: 

 Master computer – source of data to be backed up  

o Runs CDP master Agent, which establishes the link to the Server  

Server computer – provides backup for current and past versions  

o Runs CDP Server, which provides the link for the master Agent  

o Runs CDP backup Agent, which provides access to the most recent versions of the files 
mirrored from the master  

 

 

A CDP deployment can have any number of masters, as long as each has a different Job. For 
example, you could have a master computer in San Antonio, a master in London, and a master in 
NYC, all connected to the same Server in Toronto. The process for setting up each additional master 
is identical to setting up the first one. 

The Server stores the current (real-time) version of all files from the master, and keeps past versions of 
files, even files that have been deleted. The Server also creates point-in-time snapshots and can initiate 
automatic failover and recovery. 

How to Install CDP: Overview 

CDP deploys in just three easy steps: 

1. Install the backup Server on the Server computer.  

2. Install the master Agent on the master computer and link the desired folder to the backup 
computer.  

3. Install the backup Agent on the backup computer and link it to the backed-up data.  

http://support.microsoft.com/kb/135268
http://support.microsoft.com/kb/318754
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What’s Next? 

After you have finished installing CDP, any change made to a file in the targeted folder on the master 
computer will be reflected in the folder you selected on the backup Server computer.  

Review the user guide for important information, including how to: 

 Change the default administrator login account. 

 Create additional Jobs.  

 Link additional Agents to an existing Job. 

 Create user accounts so that only approved users can access the data.  

 Manage the Job‟s data, including retrieving past versions or deleted files, using the Server‟s web 
interface. 

 Unlink a given folder from a Job. You may also want to remove a Job from the Server altogether. 

 Use FastMerge for replicating large amounts of data more efficiently. 

 Access Server, Agent, and Jobs with the user interfaces. 

 Configure advanced features  

 Configure the software to work with Microsoft XP, IIS, and antivirus software 

 Manage the backup data, including retrieving past versions or deleted files, using the web 
interface. 

Common Problems with Establishing CDP 

Most users establish CDP quickly and easily using the deployment wizard. Below are common problems 
with setting up CDP, and recommended solutions. 

1. The master cannot connect to the Server. 
 
Make sure the Server is running, and that it is using a port that allows TCP/IP traffic between the 
two computers. By default, the Server uses TCP/IP port number 80, but that port may already be 
used on the computer (e.g., by IIS), or may be blocked by a firewall. You can change the port 
number in the Server Parameters dialog box.  
 
There are also issues specific to XP firewalls and Microsoft ISA 

2. The master cannot create a backup job because of the ACLs of files in the selected folder. 
 
The Agent works as a system process, and so it must have full control over all the files in order to 
access them. You must ensure that the SYSTEM account (a predefined "user" on every Windows 
computer) has full-control over every file and folder. You can let it add SYSTEM, or you can add 
SYSTEM to every file/folder yourself, using Windows Explorer. You can also use Microsoft's 
cacls.exe utility from a command line. 

3. Some third-party applications may need adjusting. 
 
Old versions of StorageExec, QuotaAdvisor, PowerQuest, UltraBac, DoubleTake, and UnDelete 
may cause performance issues. 
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Quick Reference 

This topic provides a quick reference for common questions regarding WAFS/CDP setup and operation. 

To do this... Refer to this topic... 

Install and run a Server Installing the Software. After the installer finishes, it will start the Server and 

prompt you for the registration code, which determines the number of users and 
volumes (drives) on your system.   

Automatically restarting 
the Server after booting 
the computer 

The Server. The Server installation procedure places a shortcut to the Server 

application in the Windows Startup folder, causing the Server to start automatically 
whenever the Windows Server computer restarts. When configured as Services, 
the Server and Agent start automatically. 

Modify the 
communication 
parameters 

Server Parameters. Specify the port(s) to use and whether to use SSL. 

Support SSL encryption Securing Ports with SSL. You can purchase a security certificate for your 

domain from a third-party vendor (such as VeriSign). Install it per the instructions 
from the vendor. 

To save the costs of purchasing a third-party certificate, you can use a self-signed 
certificate. Using a self-signed certificate may cause a dialog box to appear at the 
client each time they access the Server.  

Manage Jobs Managing Jobs. For security, make sure you change the default 
administrator's username and password. 

Define user accounts Creating, Modifying, and Deleting Users. Users only need an account if they 

use the Web interface, administer the Server or Agent, or manage Jobs. Most 
users continue to use Windows Explorer on their local computer for file 
management. 

Access old versions of 
files 

Restoring a File in the Job Administration Web Interface. When the Web 

interface is enabled, any user has secure access to old versions of files via any 
Web browser. An administrator or users who have an account can restore files via 
the Web interface.  

Collecting and 
processing log 
information 

Server Parameters. The log files are stored in sub-directory _LOGS under the 

volume root directory, and are named after the date/time each log was started. 

You can delete old log files that are not needed without affecting system operation. 
  

Replicate large amounts 
of data more efficiently 

Using FastMerge to use an alternate copy of a Job's data to initially populate a 

linked folder. The disk on which the files are transferred must be formatted as 
NTFS. If you format the disk with FAT32, FastMerge will not transfer the files 
properly, because the file system time stamp is local time instead of Greenwich 
Mean Time (GMT). 

Prevent unnecessarily 
replicating thumbnail 
files 

Turning Off Thumbnail Caching. Windows creates a small file in some 
directories called thumbs.db. This file is a cache of thumbnail pictures in a directory 
to speed up the display of thumbnails when viewing a folder in Thumbnail view. 
You should turn off thumbnail caching; otherwise, the thumbnail files are constantly 
recreated and unnecessarily mirrored, resulting in excessive network traffic, which 
can contribute to performance issues.  

File-Naming Conventions 

WAFS/CDP follows the standard Windows naming conventions, with a few exceptions (such as no 
support for Unicode characters).  

For example: 
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 You can name files using almost any character for a name, except for the following reserved 
characters:  
< > : " / \ | ? *  

 The maximum length for a path is 255 characters. This limitation includes the drive letter, colon, 
backslash, directories, subdirectories, filename, and extension.  

 Characters that are valid for naming files, folders, or shortcuts include any combination of letters 
(A-Z) and numbers (0-9), plus the following special characters: 

o   ^   Accent circumflex (caret) 

o    &   Ampersand 

o    '   Apostrophe (single quotation mark) 

o    @   At symbol 

o    {   Brace left 

o    }   Brace right 

o    [   Bracket opening 

o    ]   Bracket closing 

o    ,   Comma 

o    $   Dollar sign 

o    =   Equal sign 

o    !   Exclamation point 

o    -   Hyphen 

o    #   Number sign 

o    (   Parenthesis opening 

o    )   Parenthesis closing 

o    %   Percent 

o    .   Period 

o    +   Plus 

o    ~   Tilde 

o    _   Underscore 

We currently do not support Unicode. 

For more information regarding file-naming conventions, refer to the Microsoft Windows Developer 
Network article Naming a File and the Microsoft TechNet article How NTFS Works.   

WAFS/CDP Components 

WAFS/CDP is comprised of the following components: 

The Server acts as the hub, directing traffic, synchronizing mirrors, ensuring file coherency, and resolving 
any file conflicts. In all deployment scenarios, a single instance of the Server is used. 

An Agent is installed on those computers in which data is directly accessed. Agents communicate directly 
and only with the Server.  

Jobs are the basic building blocks of a WAFS deployment. Jobs are a collection of synchronized folders 
and the links between them. Once an Agent adds a folder on its local computer to a Job, full 
synchronization is ensured between that folder and folders on other computers that are linked to that 
same Job. You can create up to 60 Jobs per Agent. 

The Vault is the working space on the Server that stores one or more Jobs' current file versions, past 
versions, deleted files, and log files. The default location is C:\AD.  

WAFS/CDP Folders 

When you install WAFS/CDP, in addition to subfolders in the Program Files directory (by default, 
C:\Program Files\Availl\Availl Server), the following folders are created and used by the Server and 
Agents:  

 A working directory/Vault (used by WAFS Server) is created (by default) at C:\AD. In the AD 
folder, subfolders are created for logging, templates, and Jobs. The Job called FirstFolder is 
automatically created; you can delete the Job named FirstFolder if you are not using it. When 

http://msdn.microsoft.com/en-us/library/aa365247.aspx
http://technet2.microsoft.com/windowsserver/en/library/8cc5891d-bf8e-4164-862d-dac5418c59481033.mspx?mfr=true
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you create a new mirror or backup between computers, you start by clicking Create a new "x" 
Job on the Agent menu (where "x" is the type of Job). The folder that you link to the Job is the 
folder that contains the data. That is, if you create a folder named WAFS_Job with a subfolder 
called EastCoast and you link the Job to EastCoast, the WAFS_Job folder does not contain any 
data, but EastCoast does. You can change the location of the Vault in the Server Parameters 
dialog box. Refer to Server Parameters for details. 

 

 AVMF is created by the Agent and should never be modified. It stores the data (P) and metadata 
(M) that it uses in its mirroring process. Although this folder has size, it is mostly offset by the fact 
that the directories you were replicating no longer have size. They are not duplicates of the 
Agent's data. The old location points to the WAFS drive letter, which in turn writes to the AVMF 
directory; you do not have to allocate extra space.  

o M is the Meta data; the revisions of files and the files that are deleted, but have yet to be 
purged. The files appear as folders because that is how they are stored in M. If you look 
into each, there are files that are revisions of the particular file. 

o P is the Physical data that is uploaded from the Agent to the Server for storage and 
replication to other Agents.  

 

 AVM0 is for legacy support. (Created by the Agent, this is where the data was stored before 
version 3.0) You can specify which drive it uses in the Agent Setup and Preferences dialog box 
in the Drive letter box. 

 

 

Remember, there is only one physical copy of the data on the hard drive. The "Availl drive" is just 
a link to the Job's folder, and is a convenient additional place to access the data that is normally 
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accessed from the folder linked to the Job. If you change the drive letter, restart the Agent in the 

Windows Services dialog box (Start > Run > type services.msc). 

 AVCStuff, installed with the Agent, contains various executables and two subfolders used by 
WAFS/CDP. 
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Installing the Software 

The topics below describe the software components, various deployment considerations, and 
requirements/recommendations for installing the software. 

Software Components 

The support page on globalscape.com offers the following downloads: 

 WAFS 3 Full (Multidirectional WAFS - AvaillDeploymentMulti.exe)  

 WAFS 3 CDP (CDP Backup - AvaillDeploymentUni.exe) 

 WAFS 3 Enterprise (Enterprise Backup - AvaillDeploymentEnt.exe) 

 WAFS 3 Upgrade (Upgrades any version 3 Server or Agent - AvaillDeploymentUpg.exe) 

The same installer is used to install the Server and Agent(s). 

When a Server and/or an Agent is installed, one or more of the following processes appear in the 
Windows Task Manager: 

Process Application Description 

AvlAgt.exe Agent The Agent application 

AANTS.exe Agent The Windows service component of the Agent application 

ASRV.exe Server The Server application 

ASRVNTS.exe Server The Windows service component of the Server application 

ACLMgr.exe ACL Manager Application responsible for replication of ACL information 

For example, when the Server service is started as a Windows service, ASRVNTS.exe is launched first, 
which in turn launches the Server application ASRV.exe. Therefore, when the Server service is started as 
a Windows service, you will see both processes running at the same time. Alternately, when the Server is 
started as an application, only the ASRV.exe process is running. 

Deployment Considerations 

The software provides the following configuration options: 

 Wide Area File Services (WAFS) provides multi-directional continuous mirroring, real-time file 
sharing with coherent locking between all connected systems both local and remote.  

 Continuous Data Protection (CDP) offers continuous backup/disaster-recovery of files, ongoing 
disk-to-disk mirroring of live data to a remote server, and the ability to restore data to any point. 

For other deployment considerations, refer to the following topics, as applicable, before installing the 
software: 

 Using WAFS on Windows Server 2008 or Vista 

 Using the Software on Microsoft XP 

 Using the Software with IIS 

 Setup for a Windows Cluster 

 Deploying a Multiple-Server Configuration 

 Firewall and Router Configuration 

 Issues with Other Applications 

http://www.globalscape.com/support/wafs.aspx
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 Antivirus Settings 

System Recommendations 

The GlobalSCAPE Quality Assurance team tests our products with a variety of operating systems, 
software, and hardware. It is possible for the WAFS/CDP Server and Agent to function with other 
operating systems, software, and hardware, but is only tested and approved for use with the operating 
systems, software, and hardware described below. 

System Recommendations for WAFS/CDP Agent 

 Operating Systems: 

o Windows 2000 

o Windows XP Professional 

o Windows XP Professional, 64-bit version (WAFS version 3.5.2 or later only) 

o Windows Server 2003 R2, 32-bit and 64 bit versions (WAFS version 3.5.2 or later only) 

o Windows Vista, 32-bit and 64-bit versions (WAFS version 3.6.2 or later only). 

o Windows 2008 R2, 32-bit and 64-bit versions (WAFS version 3.6.2 or later) only 

 1 GHz Pentium P4 or higher 

 Required RAM is dependent on the number of files being mirrored (recommended RAM is 3GB+) 

o Required RAM = 600 MB + (NumberOfFiles * 0.5 KByte per file) 

o 1 GB RAM minimum 

 Hard drive space equal to 110% of the amount of data being mirrored or backed up. 

o Please plan for natural dataset growth. 

 Internet Explorer 5.5 or higher 

 

On Windows 2008/Vista, WAFS/CDP runs as an application; therefore, the user account running 
the application must have full control to all files and folders within the Job's dataset. 

System Recommendations for WAFS/CDP Server 

 Operating Systems: 

o Windows 2000 

o Windows XP Professional 

o Windows XP Professional, 64-bit (WAFS version 3.5.2 or later only) 

o Windows Server 2003 R2, 32-bit and 64-bit (WAFS version 3.5.2 or later only) 

o Windows Vista, 32-bit and 64-bit versions (WAFS version 3.6.2 or later only) 

o Windows 2008 R2, 32-bit and 64-bit versions (WAFS version 3.6.2 or later only) 

 1 GHz Pentium P4 or higher 

 Memory: 

o Required RAM 1GB (Recommended RAM is 3GB+) 
(For a table of memory limits for each Windows version, refer to Memory Limits for 
Windows Releases on the Microsoft Developer Network.)  

o Hard drive space equal to 110% of the size of the data being replicated at all agents plus 
room for previous versions and deleted files.  

http://msdn.microsoft.com/en-us/library/aa366778(VS.85).aspx
http://msdn.microsoft.com/en-us/library/aa366778(VS.85).aspx
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o Additional storage capacity of 50% over the size of the data being replicated is 
recommend for storing previous file revisions. 

o A minimum of 5GB of free space is required to install the WAFS Server component. 

o It is not uncommon for deployments to take advantage of surplus storage capacity of up 
to 300% of the replicated data size. The additional space is used to store previous 
versions and deleted files used by our proprietary file revision system. 

 

If the Server and Agent are installed on the same computer, ensure that you provide the space 
requirements for both the Server and Agent using the above requirements. There are no disk space 
advantages to collocating the Server and Agent on the same computer; however, you may see 
performance improvements for a Server serving less than 5-10 Agents by collocation. 

 

Supported Media 

The software supports locally attached storage, NAS, iSCSI, SAN, and most other LAN-accessible 
storage media. 

 

WAFS Deployment 

In a WAFS deployment, files are up-to-date and local in real time at all locations. Any change made at 
any location is available at each of the other locations. Users do not notice a difference between 
accessing local files and files in remote locations. They still access the data from the network share on 
the office's existing file server. Each file server is synchronized in real time with the other remote file 
servers. Sharing data between cubicles in the same office is no different from sharing between remote 
offices. File access is fast, efficient, and fully transparent. File coherency and locking is maintained, 
ensuring that multiple users do not make changes to the same file at the same time. All files are usable, 
everywhere, at all times. 

Suppose your company has employees at three separate sites that need to share the same information. 
Your company uses large CAD files, and employees at all sites need to access and modify the designs 
concurrently. Use WAFS to connect the offices by installing the system as follows: 

 

This section is an overview of a WAFS deployment. For detailed installation instructions, refer to 
Installing the Server, Install the First Agent, and Install Additional Agents. 

1. Designate one location as the hub, and install the Server there. Typically, this should be the 
location with the largest number of users, highest traffic, or where your disaster recovery is 
located. 

2. Install an Agent at each location:  

a. Connect the first Agent to the Server by creating a Job. See Creating a New Job.  

b. Connect subsequent Agents to the Server by linking to that Job. See Linking to an 
Existing Job. 

c. Install an Agent on the computer running the Server, and connect it with the Server. 

3. Create a new, empty folder at any Agent where you want to link to a Job. 

You now have a directory that is mirrored between two computers, in two different locations. Any changes 
made to the contents on one computer are reflected on the other. File access works the same as if the 
files were on the same LAN, including native file locking.  
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The default share permission for Windows is usually read-only. To give WAFS the ability to change 
the contents of a folder that is linked to a Job, you must change the rights to the folder in Windows 
to Full Control, as you would normally share any folder. 
 
In Windows XP and 2003, you must run the Agent as an NT service in order for the data to be 
shared on the network. To do so, select the NT Service check box in the Agent's Preferences 
(General tab). If it is already selected, then you are already running the Agent as an NT Service. 
 
Some applications, such as Microsoft's WordPad and Notepad, do not support file locking. 

After running the initial testing, familiarize yourself with the following: 

 Windows Services - Optimize the Server and Agent(s) by running them as Windows services, 
meaning that they start automatically after the computers restart and do not require login. You 
can start and stop the service from the Windows Services control panel, or you can select or clear 
the NT Services check box on the Server and the Agent. 

 Job Administration console - Used to modify and delete Jobs. 

 

Continuous Data Protection Deployment 

In a CDP deployment, data is constantly being replicated to the specified backup computer. The backup 
computer can be on the same LAN or in any remote location. CDP performs continuous backup for any 
number of primary servers using just one central server as the backup repository. CDP can perform one-
to-one backup and uses negligible bandwidth. 

The source system has the live data in use, and the backup system has a mirror of the source system 
data. CDP provides flexible disaster recovery options. It can be configured to provide failover to a second 
server or it can maintain a mirror copy and make it available to perform a restore to the original location or 
the original server. You can also use CDP to restore single files. 

In a remote server deployment, the source system data is constantly mirrored to the server that is located 
off-site. If the source system breaks, then another Agent, which can be cohosted on the computer running 
the Server, provides alternate access to the files. (When a CDP/slave Job is accessed on a computer 
running the Server, you cannot manage passwords. You can manage passwords on any other Agent 
connected to the Job.) 

If the source fails, it is possible to deploy a new Agent anywhere quickly, including on the same LAN 
where the original Agent is. Name the new Agent the same name as the failed one and users will 
automatically redirect, or you can use DFS to automatically failover. 

 

For detailed installation instructions, refer to Installing the Server, Installing the First or Master 
Agent, and Installing Additional or Backup Agents. 

 

Installing the Server 

The process for installing the Server is the same whether you are installing Enterprise WAFS, 
Multidirectional WAFS, or CDP. Review the topics below for specific details of each installation. 

Installing Enterprise Backup Server 

On Windows 2008 and Vista operating systems, the Server runs only as an application and should be 
installed and run using the "Administrator" account. If you need to run WAFS on a different account you 
must disable UAC. Whichever account you plan to use to run WAFS, should also be used to install 
WAFS. 
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If you are upgrading, refer to Upgrading the Software for important guidelines. 

Installing Enterprise Backup includes: 

1. Installing the Backup Server at the backup site 

2. Installing a Master Agent on each system that contains the data 

3. Installing a Backup Agent at the backup site 

To install the Server 

1. Start the installation file (AvaillDeploymentEnt.exe) on the Server computer. The Welcome 
page appears. 

. 

2. Click Next. The License Agreement appears. 

 

3. Read the agreement, then click Yes to accept it. The Enterprise Deployment wizard appears.  
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4. Click Next. The Enterprise Deployment wizard appears. 
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5. Click Deploy Backup. The Backup Deployment wizard appears.  

 

6. Click Next. Step 1 of deploying the Backup Server appears.  
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7. Click Deploy Backup Server. The Server Installation Path dialog box appears.  

 

8. If you are installing the Server on Windows Server 2008 or Vista, a prompt appears asking if you 
want the Server to start automatically when a user logs in to the computer. You should only 
enable the autostart feature if you are either using the Administrator account to install and run 
WAFS or if UAC is disabled. 

 

 Click Yes to start the application upon user logon; click No if you want to start the 
application manually. 

9. Keep the default destination or provide a different path, then click OK. The Server wizard 
appears. 
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10. Click Next. The Activation page appears. 

 

11. Complete the activation information, then click Next. If this a trial, the trial confirmation box 
appears. 
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12. Click OK. The Storage and Communication Information page appears. 

 

13. In the Availl Server working place and central vault box, accept the default or click Browse to 
provide a different location. 

14. In the Availl Server's machine name or address box, leave the name of the computer or 
provide its IP address or external domain name. 

15. In the Port box, keep the default of 80, unless another device (such as Microsoft IIS) is using that 
port.  

16. If you are using SSL, select the SSL check box and change the Port value to the port used for 
SSL (443 by default). 

17. Click Next. The completed page appears. 

 

18. Click Finish. 
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Next Steps 

Using the same installer, install a Master Agent on each system that contains the data that you want to 
backup, then install backup Agents as needed. 

Installing the Multidirectional WAFS Server 

On Windows 2008 and Vista operating systems, the Server runs only as an application and should be 
installed and run using the "Administrator" account. If you need to run WAFS on a different account you 
must disable UAC. Whichever account you plan to use to run WAFS, should also be used to install 
WAFS.  

 

If you are upgrading, refer to Upgrading the Software for important guidelines. 

Installing multidirectional WAFS includes: 

1. Installing the Server 

2. Installing the First Agent 

3. Installing other Agents, as needed 

To install the Server 

1. Start the installation file (AvaillDeploymentMulti.exe) on the Server computer. The Welcome 
page appears. 

. 

2. Click Next. The License Agreement appears. 
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3. Read the agreement, then click Yes to accept it. The Deployment wizard appears. 

 

4. Click Next. 
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5. Click Next.  
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6. Click Deploy Server. The Server Installation Path dialog box appears.  

 

7. If you are installing the Server on Windows Server 2008 or Vista, a prompt appears asking if you 
want the Server to start automatically when a user logs in to the computer. You should only 
enable the autostart feature if you are either using the Administrator account to install and run 
WAFS or if UAC is disabled. 

 

 Click Yes to start the application upon user logon; click No if you want to start the 
application manually. 

8. Keep the default destination or provide a different path, then click OK. The Server wizard 
appears. 

 

9. Click Next. The Activation page appears. 
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10. Complete the activation information, then click Next. If this is a trial, the trial confirmation box 
appears. 

 

11. Click OK. The Storage and Communication Information page appears. 
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12. In the Availl Server working place and central vault box, accept the default or click Browse to 
provide a different location. 

13. In the Availl Server's machine name or address box, leave the name of the computer or 
provide its IP address or external domain name. 

14. In the Port box, keep the default of 80, unless another device (such as Microsoft IIS) is using that 
port.  

15. If you are using SSL, select the SSL check box and change the Port value to the port used for 
SSL (443 by default). 

16. Click Next. The completed page appears. 

 

17. Click Finish.  

Next Steps 

Next, using the same installer, install the First Agent on a system that contains the data that you want to 
replicate, then Install Additional Agents, as needed. 

 

Installing CDP Backup Server 

On Windows 2008 and Vista operating systems, the Server runs only as an application and should be 
installed and run using the "Administrator" account. If you need to run WAFS on a different account you 
must disable UAC. Whichever account you plan to use to run WAFS, should also be used to install 
WAFS. 

 

If you are upgrading, refer to Upgrading the Software for important guidelines. 

Installing CDP Backup includes: 

1. Installing the Backup Server at the backup site 

2. Installing a Master Agent on each system that contains the data 

3. Installing a Backup Agent at the backup site 
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To install the Server 

1. Start the installation file (AvaillDeploymentUni.exe) on the Server computer. The Welcome 
page appears. 

. 

2. Click Next. The License Agreement appears. 

 

3. Read the agreement, then click Yes to accept it. The Welcome page of the Backup Deployment 
wizard appears.  
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4. Click Next. Step 1 of the Backup Deployment wizard appears. 
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5. Click Deploy Backup Server. The Server Installation Path dialog box appears.  

 

6. If you are installing the Server on Windows Server 2008 or Vista, a prompt appears asking if you 
want the Server to start automatically when a user logs in to the computer. You should only 
enable the autostart feature if you are either using the Administrator account to install and run 
WAFS or if UAC is disabled. 

 

 Click Yes to start the application upon user logon; click No if you want to start the 
application manually. 

7. Click OK. The Server wizard appears. 

 

8. Click Next. The Activation page appears. 
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9. Complete the activation information, then click Next. If this is a trial, the trial confirmation box 
appears. 

 

10. Click OK. The Storage and Communication Information page appears. 
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11. In the Availl Server working place and central vault box, accept the default or click Browse to 
provide a different location. 

12. In the Availl Server's machine name or address box, leave the name of the computer or 
provide its IP address or external domain name. 

13. In the Port box, keep the default of 80, unless another device (such as Microsoft IIS) is using that 
port.  

14. If you are using SSL, select the SSL check box and change the Port value to the port used for 
SSL (443 by default). 

15. Click Next. The completed page appears. 

 

16. Click Finish. 

Next Steps 

Using the same installer, install a Master Agent on each system that contains the data that you want to 
backup, then install backup Agents as needed. 

Installing the First or Master Agent 

On Windows 2008 and Vista operating systems, the Agent runs only as an application and should be 
installed and run using the "Administrator" account. If you need to run WAFS on a different account you 
must disable UAC. Whichever account you plan to use to run WAFS, should also be used to install 
WAFS. 

Agents are installed on any computer that contains data to be shared. 

 

If you are upgrading, refer to Upgrading the Software for important guidelines. 

To install the First or Master Agent 

1. On the first Agent computer, start the installation package and follow the installation wizard. (Use 
the same installer that you used to install the Server.) 

2. Do one of the following: 
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 For WAFS (Enterprise or Multidirectional) deployment, click Next until the Deploy First 
WAFS Agent button appears, then click Deploy First WAFS Agent. 

 For CDP deployment, click Next until the Deploy Master Agent button appears, then 
click Deploy Master Agent.  

If you are installing the Agent on Windows Server 2008 or Vista, a prompt appears asking if you 
want the Agent to start automatically when a user logs in to the computer. You should only enable 
the autostart feature if you are either using the Administrator account to install and run WAFS or if 
UAC is disabled. 

 

 Click Yes to start the application upon user logon; click No if you want to start the 
application manually. 

3. The Agent installs, then the Select a folder page appears. 

 

4. Click Browse to select the target folder for the first Job or backup Job, then click Next. The target 
folder is the folder that contains the files you want to mirror using WAFS or back up using CDP. 
The Create a new Job page appears. 
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5. Provide the IP address or name of the Server. If the port number is not 80 (the default), provide 
the server name followed with the port number in the format Servername:port. For example, type: 

AVSRD:711 

 

If you are unable to connect to the Server, verify that you are not using port 80 for 
something else, such as Microsoft IIS. If so, designate a different port for the Server in the 
Server Parameters dialog box.  

6. The name of the folder appears in the Job name box; keep the name or specify a new name for 
the Job.  

7. Click Next. The Job Summary appears.  

 

8. Review the settings.  

 If you want to change any settings, click Back.  

 If you want to specify certain file types to include or exclude from the Job, click Edit 
Filter. Refer to Filtering Jobs for details of specifying filters. 
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 If you are satisfied with the settings, click Link to Job. 

9. If you are warned that all of the files in the target folder must be closed and not in use while the 
target folder is mapped for the first time, verify that no files are open and that no applications are 
using files in the target folder, then click OK. 

The Agent links with the Server and all of the files in the target folder are replicated in the Server Vault. 

Next Step: Install Additional or Backup Agents 

 

Installing Additional or Backup Agents 

On Windows 2008 and Vista operating systems, the Agent runs only as an application and should be 
installed and run using the "Administrator" account. If you need to run WAFS on a different account you 
must disable UAC. Whichever account you plan to use to run WAFS, should also be used to install 
WAFS. 

After you have installed the Server and the first or master Agent, install Agents on any other computer on 
which you want to set up a WAFS mirror or CDP backup. 

To install additional or backup Agents 

1. On the computer on which you are installing the Agent, create an empty folder. This folder will be 
populated with the contents of the first or master Agent's target folder. 

2. Start the installation package and follow the instructions in the installation wizard. 

3. Do one of the following: 

 For WAFS deployment, click Next until the Deploy another WAFS Agent button 
appears, then click Deploy Another WAFS Agent. 

 For CDP deployment, click Next until the Deploy Backup Agent button appears, then 
click Deploy Backup Agent.  

If you are installing the Agent on Windows Server 2008 or Vista, a prompt appears asking if you 
want the Agent to start automatically when a user logs in to the computer. You should only enable 
the autostart feature if you are either using the Administrator account to install and run WAFS or if 
UAC is disabled. 

 

 Click Yes to start the application upon user logon; click No if you want to start the 
application manually. 

The Agent installs, then the Select a folder dialog box appears.  
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4. Click Browse to specify the empty folder you created in step 1, then click Next. The Link to an 
existing Job page appears. 

5. Specify the IP address or name of the Server. If the port number is not 80 (the default), provide 
the server name followed with the port number in the format Servername:port. For example, type: 

AVSRD:711 

6. Click Next. The Job Summary page appears. 

7. Click Link to Job. The Agent links with the Server and all of the files related to the Job are 
replicated in the folder you selected in step 4. 

8. Repeat the above steps on any other computer that you want to add to the system as a mirror or 
backup. 

 

Upgrading the Software 

Important Pre-installation Notes:  

 All Servers and Agents must be upgraded and running the same version of the software. Using 
different versions among Servers or Agents will result in performance degradation and possible 
synchronization problems or data loss.  

 If you are upgrading from WAFS 3.0, contact Customer Service for a free upgrade license key.  

 Upgrade the Server first, then upgrade all of the Agents.  

 Do not uninstall the Server or the Agents.  

 If you are using anti-virus software that scans processes, you must add the Agent process 
(AvlAgt.exe) to the exclusion list. Refer to Antivirus Settings for more information. 

 If the Agent is configured for delayed startup, the Agent upgrade process will be slowed. To turn 
off Delayed Startup:  

a. Click the Windows system tray icon , then click Agent Setup and Preferences.  

b. On the General tab, clear the Delayed startup check box, then click OK. 

Delayed Startup is normally not selected. Selecting this check box causes the Agent not to 
start until after the computer boots up, delayed by approximately one minute. 

http://www.globalscape.com/support/customerservice.aspx
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 As a precaution, a complete backup before any software upgrade is recommended.  

To upgrade the Server 

1. Download the most recent release of the software upgrade version from the WAFS Support 
Center and save it to a convenient location on the Server computer.   

2. Stop the Server service as follows:  

a. Click Start > Run, type services.msc, then press ENTER. The Windows Services 

dialog box appears. 

b. Click Availl Server, then click the Stop Service icon.  

3. Start the installer downloaded in step 1 above and then follow the instructions in the wizard.   

4. On the Upgrade Server page, click Upgrade Server. When the upgrade is finished, the Server 
will restart.  

5. Verify the new version number is displayed in the Server Console title bar or click Help > About 
Availl Server.  

To upgrade the Agents 

If you are upgrading from the next most recent release, the Server may automatically push the upgrade to 
each individual Agent, in which case a message will appear at each Agent prompting the user to upgrade. 
  

 

Follow the instructions. When the upgrade process is finished, the Agent service restarts. 

If you are upgrading from an older version, or if the Agent upgrade notification message does not 
appear automatically, then you must upgrade the Agent manually: 

1. Download the most recent release of the software from the WAFS Support Center and save it to 
a convenient location on the Agent computer.   

2. Stop the Agent service as follows:  

a. Click Start > Run, type services.msc, then press ENTER. The Windows Services 

dialog box appears. 

b. Click Availl Agent, then click the Stop Service icon.  

3. Start the installer downloaded in step 1 above and then follow the instructions in the wizard.  

4. On the Upgrade Agent page, click Upgrade Agent. Restart the Agent computer if prompted to do 
so.  

5. The Agent service and the Agent should start automatically. If not, then restart the Agent service 
as follows:  

a. Click Start > Run, type services.msc, then press ENTER. The Windows Services 

dialog box appears 

b. Click Availl Agent, then click the Start Service icon.  

6. Click the Windows system tray icon , then click Agent Setup and Preferences. 

http://www.globalscape.com/support/wafs.aspx
http://www.globalscape.com/support/wafs.aspx
http://www.globalscape.com/support/wafs.aspx
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7. On the General tab, confirm that the Run as NT Service check box is selected and then click 
OK. 

8. Click the Windows system tray icon , then click About Availl Agent and verify the version 
number to confirm that the upgrade has been successfully completed. 

9. Repeat this procedure for each additional Agent. 

Troubleshooting Connection Problems 

If another service is using port 80, such as Microsoft IIS Server, you must specify a different, unused port 
to avoid conflicts. If you specify port 80 and another service is using that port, you will not be able to 
connect to the Server. If you installed the Server using port 80 and are unable to connect, specify a 
different port, then restart the Server. 

For more information about special configurations, considerations for use with other applications, and 
connection problems, refer to Technical Notes. 

Using Revit with WAFS 

The Revit product suite by Autodesk supports simultaneous access and modification to models via a 
functionality known as Worksharing. When Worksharing is enabled in a Revit model, work is coordinated 
through a master copy of the model file known as the Central file. The Central file is used to store the 
current ownership information for all entities and worksets in the project, and acts as the distribution point 
for all changes published to the file. When operating in Worksharing mode, users work on a local copy of 
the Revit model and can save changes to the Central file so that other users can see their work. 

When using Revit with the WAFS system, the Central file and its ancillary files are stored within WAFS 
Jobs and efficiently replicated to applicable sites. This includes optimized transfer of not only Central files 
during Save to Central operations, but also the other files used by Revit when performing Worksharing 
operations. These additional files are found in the <Central files>_backup directory created along with 
the Central file and include files such as the eperms.dat and wperms.dat files that are used to manage 
entity and workset borrowing coordination.  

Thus, when using Revit with the WAFS system, users will not only see an improvement in data 
transmission during Save to Central and Reload Latest operations, but also for general editing activity 
during which Revit must access the permissions files. 

Recommended Reading 

Prior to using Revit with the WAFS System, it is highly recommended that Revit users and WAFS system 
administrators familiarize themselves with the concepts of multi-user collaboration within Revit using Revit 
Worksharing. Various Revit white papers can be downloaded from the Autodesk Website. (You will need 
Adobe Acrobat Reader to access the files.) 

The following articles are of particular interest: 

 The white paper entitled “Multi-user Collaboration with Autodesk Revit Worksharing” specifically 
addresses the topic of Revit Worksharing. 

 The technical note entitled “Revit Platform 2009 Model Performance Technical Note” discusses 
performance considerations and guidelines for working with Revit, including use in Worksharing 
environments. 

Central File Access 

A single adjustment must be made on user workstations for users that will be working on work-shared 
Revit models being replicated by the WAFS system. The modification requires the creation of a new drive 
letter mapping using the Windows SUBST command. 

http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=8480751
http://images.autodesk.com/adsk/files/Multi_User_Collaboration_Revit_8-10.pdf
http://images.autodesk.com/adsk/files/revit_platform_2009_model_performance_technical_note.pdf
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When Revit creates a Central file, it stores the path of the Central file within the Central file and 
associated local files. This path is used by the Revit workstations in conjunction with the local copies of 
the Central file to identify where the Central file resides for actions such as Save to Central, Reload 
Latest, and borrowing. 

When replicating Central files via the WAFS system, the Central files will be located on different file 
servers at each site. Thus, the UNC path will be different at each site and will result in Revit failing to 
locate the Central file when working in the work-shared mode. Supposing there are 2 offices, users at 
Office A will access a shared drive on FileServerA and users at Office B will access a shared driver on 
FileServerB. If a user at Office A creates a new Central file, the Central file will internally store a UNC 
path with \\fileservera\Revit Projects. When a user at Office B accesses the file, which has been 
replicated by WAFS to FileServerB, Revit will expect to see a UNC of \\fileserverb\Revit Projects and 
will issue a warning that the Central file has been relocated. 

Typically, this is resolved by creating a mapped drive at each site using the same drive letter. However, 
when creating a Central file, Revit internally converts the Central file path to a UNC format path 
and stores it as such, thus defeating the purpose of using the same drive letter. 

To rectify this issue, user workstations must instead be configured to create a new drive letter using the 
SUBST command. The SUBST command simply creates a new drive letter that maps to an existing drive 
or a UNC path. However, due to the nature of the SUBST command, Revit is unable to convert drive 
letters created using the command to UNC paths. Ultimately, this prevents Revit from storing a UNC path 
internally and it will instead store and use the proper drive letter. 

On end-user workstations, use of the SUBST command to create the appropriate drive can be performed 
manually from a command prompt or using a batch file, or can be automated using login scripts. 

 On Windows XP-based and Vista-based user workstations the drive mapping can be created 
from the command line as follows: 

SUBST <New Drive Letter>: <UNC to Shared WAFS Replicated Folder on 

File Server> 

If you are creating a new drive letter M and the WAFS Replicated Folder is shared from the 
DENVERSRV File Server using the path RevitProjects, then the following command would be 
used: 

SUBST M: \\DENVERSRV\RevitProjects 

End-users at all sites would now use the new M: drive letter when access work-shared Revit 
Central files. 

 

To view the usage of the SUBST command, at a command prompt, type: SUBST /? 

 On Windows 2000-based user workstations the SUBST command does not support use of 
UNC paths. Instead, a normal drive mapping must first be established to the shared WAFS 
Replicated Folder and then this drive is used in place of the UNC path in the SUBST command. 
From the command line, a normal mapped drive can be created using the net use command. 

The normal drive mapping may be created from the command line as follows: 

NET USE <Drive Letter>: <UNC> 

For example, if the WAFS Replicated Folder is shared from the DENVERSRV file Server using the 

path RevitProjects, then the following command would be used to create a new mapped drive N: 

NET USE N: \\DENVERSRV\RevitProjects 

Once the drive mapping has been established, the SUBST command can be used to create the 
drive that must be used when accessing the Revit Central files. The drive mapping can be 
created from the command line as follows: 

SUBST <New Drive Letter>: <Existing Mapped Drive Letter>: 
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For example, if you are creating a new drive letter M and the existing mapped drive is N, then the 
following command would be used 

SUBST M: N:\ 

End-users at all sites should now use the new M: drive letter when access work-shared Revit 
Central files. 

 

To view the usage of the net use command, at a command prompt, type: NET USE /? 

Note: A side effect of using the SUBST command is that the SUBST drive letter initially appears in 
Windows Explorer as "Disconnected Network Drive." This is nothing to be concerned about and the drive 
can simply be renamed, if desired. 

Recommended WAFS Job Configuration 

To ensure the proper operation of Revit when used in Worksharing mode in a WAFS environment, certain 
WAFS Job settings must be configured in a specific way. 

These settings may be different from the desired or typical settings used when working with other types of 
projects. Because of this, it is highly recommended that Revit projects be located in their own specialized 
WAFS Job. This allows for specialized configuration of Job settings without affecting the standard 
workflow of other projects. 

 Replicated Data Access Options 

To ensure proper coordination of changes in a work-shared environment the WAFS System must 
prevent the possibility of simultaneous modification of the work-shared Revit Central file at the 
various Agent locations. To ensure this behavior we strongly recommend setting the Replicated 
Data Access options for the Job as follows: 

o When Agent is not running: Prohibit access 

o When disconnected from Server provide: Read-only access 

Filters 

The files *.tmp and *.slog are used by the WorkSharing Monitor. In version 3.6.1, you should filter 
out these temporary and logging-related files. In version 3.6.2, you do not need to filter out these 
files; however, if you are not using Worksharing Monitor, filtering out those files would improve 
Revit performance. 

Configure Unique Revit Usernames 

For editing permissions (Borrowing) to function correctly in Worksharing mode, all users working on a 
model must ensure they have configured a unique username within the Revit configuration settings. 

When working with Revit in Worksharing mode, Revit coordinates editing permissions from the multiple 
users based on the configured username. The username for each user operating within the same model 
must be unique. If multiple users mistakenly operate on the model using the same username, Revit may 
fail to ensure only one user can borrow an entity or workset at a time. 

Revit will automatically use the username of the authenticated operating system user when Revit is 
initially run on the workstation. However, be aware that Revit will continue using this initial username on 
subsequent runs even when a different user is logged into the workstation. Please refer to the Revit user 
guide(s) for more information about, and the importance of, usernames in relation to work-sharing. 

Compacting the Central File 

When performing a Save to Central operation, Revit offers users the option to compact the Central file to 
reduce the amount of disk space it consumes.  
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Compaction of the Central file is supported by the WAFS system; however, it is recommended that users 
not perform the compaction on every Save to Central operation. This is recommended because one of 
WAFS primary features for providing performance improvements for the Save to Central and Reload 
Latest actions is its delta technology. This technology allows the WAFS system to transfer only the 
changed portions of the file. The Compact Central File option causes the majority of the Central file‟s 
contents to change. When this occurs, the benefits of the delta technology are generally reduced. 
However, when Central file compaction is required due to file size, WAFS will still be able to make use of 
other optimizations, such as data compression, when transmitting the updated file. 

When the Compact Central File option is used, users at the other physical locations may experience a 
longer than usual delay in access to the Central file while the larger amount of data is replicated by the 
WAFS software.  

Revit Worksharing Monitor 

The Revit Worksharing monitor provides monitoring and statistical capabilities to end-users working with 
work-shared Revit Central files. Typically it will notify users of edit requests from other users, track edit 
requests sent to other users, keep users apprised of other user‟s actions and the progress of those 
actions, and provide notifications of system events (such as an failed edit request). 

Features of Worksharing Monitor 

 Display of users and their current workspace (Local or Central) 

 Progress of users actions (Saving to Central) 

 Display of currently pending edit requests 

 System Notifications 

 System Performance 

 

Worksharing Monitor is unaware of WAFS transfer activities.  

Save to Central/Reload Latest 

When performing operations such as Save to Central the Revit application must first obtain solitary 
access to the Central file before it can perform the remainder of the operation. If another user is currently 
in the process of performing a Save to Central users may see a message similar to: 

 

When working within the WAFS environment, users may also see this message when no other user is 
actively accessing the file. This occurs when a WAFS Agent must maintain solitary access to the file while 
it uploads the set of changes in the file to the central WAFS Server for distribution to other WAFS Agents. 
In most cases, this transfer of data is optimized by transmitting only the differences (or delta) in the file 
contents rather than the entire file. 

 

Worksharing Monitor will display all user actions, but is unaware of WAFS transfer activities. 
Therefore, when no other user is actively accessing the file, Worksharing monitor will indicate that 
no other user is actively accessing the file. However, the file lock will remain until the WAFS 
transfer has completed, and users may see the same message when they click Save to Central.  
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When performing a Save to Central or Reload Latest operation, if a user is presented with the above 
dialog box, it is recommended that the user close the dialog box and try again a minute or two 
later. If the user leaves the dialog box open, Revit will perform the command immediately after the 
Central file lock is released. When this occurs, it forces the WAFS system to immediately stream in the 
entire Central file down to the local WAFS Agent. This streaming mode prevents the WAFS System from 
downloading only the file changes. 

Note that after pressing Cancel on the above message in Revit 2008, users may see the following dialog: 

 

While the message in this dialog may seem severe, it is just a standard warning that it was unable to 
complete the Save to Central operation. Users may perform a subsequent Save to Central and once the 
file is available for solitary access the operation will complete.  

Workflow Recommendation 

If you experience slow Save to Central and Reload Latest times, end-user performance may be 
improved by coordinating times at which Save to Central operations are performed at remote sites.  

For example, suppose users A, B, and C are in New York, and users X, Y, and Z are in California. If users 
X, Y, and Z can perform their Save to Central in a different time-slot than users A, B, and C, then all 
users will experience local-disk speeds. On the other hand, if the locations alternate their saves, say for 
example, A, X, B, Y, C, Z, then the users will need to wait for the file changes to move between New York 
and California, which can introduce delays in their save times. 

This type of coordination typically requires organizing worksets such that remote users may isolate their 
changes when possible and check in their changes at a less frequent rate. Different users at the same 
location do not need to coordinate amongst themselves; they will all experience local-disk performance. 

Using the Software on Microsoft XP 

If you are installing the software on a Windows XP computer, especially one that has SP2 (service Pack 
2) or Windows 2003, you may need to alter or turn off Windows Firewall and/or Windows ISA services. 
Open the Windows Services dialog box (Start > Run > services.msc) to determine if the services are 
running. The software communicates over HTTP, and your ISA or firewall might be configured to stop all 
communications and connections, especially via port 80. 

If you see connectivity issues or cannot manage Jobs via the Web interface, try turning off the 
Firewall/ISA service (as a test), and/or click "unblock" if prompted. Then restart the Server service. 

Or, you might try this change: 

For remote servers to make connection to the internal Server (using port 711 in this example) 

ISA: New Protocol Definition:  Server 711 - TCP Inbound port 711 

New Server Pub Rule:  Pub Rule:  Specify Int IP address + specify Ext 

IP address 

Configure to use above Protocol Definition 

Restart ISA server 

Other personal firewalls, such as Symantec/Norton, might create the same issue. If your Agent will not 
connect, shut off these services and restart the Server service. See Using Antivirus Software for other 
important tips on exclusions. 
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Using XP as a "server": XP only supports the connections of 10 workstations or fewer 

Using the Software with IIS 

If you plan to use the software for Microsoft IIS content mirroring, do the following (for every version of 
IIS): 

 When setting up the software to do the mirror, shut off IIS for a few seconds when creating the 
new Job.  

 IIS must always be stopped before the Agent; IIS must always be started after the Agent is 
running.  

 On each computer on which an Agent is installed, right-click the Agent system tray icon, then 
click Agent Setup and Preferences. On the General tab, select the Auto Explorer refresh 
check box. 

 Do not use the new drive letter. 

Using WAFS/CDP on Windows Server 2008, Vista, or 7 

On Windows Server 2008, Vista, and 7, both the Server and the Agent are run only as applications. The 
Run as NT Service check box is not available for the Agent installed in Windows Server 2008 or Vista. 
Because they are running as applications, the user account must be logged on to the computer. The 
application will stop when the user account that launched the application logs off.  

The best solution is to run the Server on a dedicated computer; however, if other users need to log on to 
the computer, you can switch users and leave the WAFS user logged in. At minimum, you should define 
an account that is dedicated to WAFS that will not be logged off while WAFS is in use. Each WAFS Agent 
should also run on its own dedicated machine. 

You should use the same user account to install WAFS that you will be using to run WAFS. You should 
use the "Administrator" account or a user account that has administrator privileges, because it will need 
access to each of the folders and files that it is to replicate. (If you need to run WAFS on an account other 
than the Administrator account, you must disable UAC.) Again, whichever account you plan to use to run 
WAFS, should also be used to install WAFS. 

 

On Windows 2008/Vista/7, WAFS/CDP runs as an application; therefore, the user account running 
the application must also have full control to all files and folders within the Job's dataset. 

You can configure the Server and/or the Agent applications to start automatically when the administrator 
account logs on or to be manually started. During installation, you are offered the option to configure the 
applications to start automatically or manually. You should only enable the autostart feature if you are 
either using the Administrator account to install and run WAFS or if UAC is disabled. 

To start the Server or Agent 

You can start the applications manually from the Start menu (right-click the application name, then click 
Run as Administrator).  

 Start > All Programs > Availl > Availl Server  

 Start > All Programs > Availl > Availl Agent 

To stop the Server 

1. Click the Server icon  in the host server's system tray. The Server Console appears. 

2. In the Server Console, click Server > Exit. 

To stop the Agent 

 In the Windows Task bar, right-click the Agent icon , then click Exit. 
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Disabling UAC 

Windows 2008, Vista, 7 can reduce the potential of security breaches with User Account Control (UAC). 
UAC forces users that are part of the local administrators group to run as if they were regular users with 
no administrative privileges. Before disabling UAC, you should be aware of the security risks that 
disabling UAC can pose. For details of UAC, refer to the Microsoft Knowledge Base article How to use 
User Account Control (UAC) in Windows Vista. 

To disable UAC in Windows Vista 

1. Click Start > Run. 

2. In the Run dialog box, type msconfig, then press ENTER. The System Configuration dialog 

box appears. 

3. Click the Tools tab. 

4. Click Disable UAC, then click Launch. 

5. Restart the computer. 

To disable UAC in Windows 2008 

1. Click Start > Control Panel > User Accounts. 

2. Click Turn User Account Control on or off. The Turn User Account Control on or off. dialog 
box appears. 

3. Clear the Use User Account Control (UAC) to help protect your computer check box. 

4. Click OK.  

5. Restart the computer. 

To disable UAC in Windows 7 

1. Click Start > Control Panel > User Accounts. 

2. In the User Accounts tasks window, click Turn User Account Control on or off. 

3. If UAC is currently configured in Admin Approval Mode, the User Account Control message 
appears. Click Continue. 

4. Clear the Use User Account Control (UAC) to help protect your computer check box, and 
then click OK.  

5. Click Restart Now to apply the change right away, or click Restart Later and close the User 
Accounts tasks window. 

http://support.microsoft.com/kb/922708
http://support.microsoft.com/kb/922708
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License Information 

The Server License Information dialog box displays the activation key, number of Servers licensed, and 
any options licensed. This information is useful for customer support.  

You can also reset the license key in this dialog box using the procedure below. When an upgrade is 
purchased, such as to enable more users, and the upgrade includes a new key, or the Server application 
is removed from this computer, possibly in order to transfer the license to another computer, you might 
need to provide a new key.  

To view the Server license information  

1. On the Server computer, click the Server icon , then click Display Server control panel. 

2. Clicking License info. The Server License dialog box appears. 
 

 

To provide a new key  

1. Click Reset. A warning appears and then the registration key is erased. There is no undo option. 

2. Click OK to erase the key (or Cancel to abort and keep the key). 

3. If you are activating a new key, restart the Server. The activation wizard appears in which you are 
asked to provide the new key. 

To update to the latest version 

Refer to Upgrading the Software. 
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Permissions and Security 

The topics below describe how to configure and manage permissions for the system. 

Access Control Lists (ACLs) 

An ACL (access control list) is a property of every file and folder in Microsoft's NTFS file system. An 
access control entry (ACE) is an element in an access control list (ACL). It allows an administrator to limit 
the access to given files to a selected group of users. The ACLs of a file or folder can be set from the 
Security tab of the file or folder's properties, which can be accessed by right-clicking on the file or folder. 

 

Make sure no shares have been set to the Windows 2003 default "read-only" (look in the Share tab) 
or it will override the permissions you set in the Security tab. 

WAFS/CDP fully supports ACLs; therefore, you can set the security of each file (i.e., set the access 
rights) exactly like in NTFS on the Security tab.  

Because the software runs under SYSTEM account credentials, the "user" SYSTEM must have full 
access rights to the replicated files and folders. On the Security tab, make sure SYSTEM is listed with full 
control. Failure to give the SYSTEM account full control of every file and folder results in users or 
applications not being able to access, move, or otherwise modify these files and folders. 

ACL Settings between Agents 

For each Job, one Agent must be selected as the Source, and its ACLs will be projected to the Job on all 
other Agents linked to the same Job. 

Granting Full Access to Everyone 

1. In Windows Explorer, right click the top-level folder of the Job, then click Properties. 
 

 

2. The Properties dialog box appears. Click the Security tab.  

3. Allow full control to Everyone and to SYSTEM.  

4. Select Advanced, choose Replace permissions entries on all child objects, then click OK.   

For example, suppose you create a new folder in a Job, and want to give users jsmith and jjones 
full access to the folder and to all the files that would be stored in it. In NTFS, you would open the 
Security tab, then add user jsmith and jjones. You would do the exact same thing with the WAFS 
folders, but you must also include the "user" SYSTEM and give it full access. 

ACL Replication Direction 

The ACL Security Manager allows you to replicate between Agents the Windows security settings for all 
files and sub-folders in the displayed linked folder.  



WAFS/CDP User Guide 

52 

To specify replication direction 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

2. Click the Change Options tab. The Change Options tab allows you to control various aspects of 
the selected Job. 

 

3. Click Sync Security ACLs. The ACL Security Manager dialog box appears. 

 

4. Specify whether the current Agent is the master (ACL Source) or the slave Agent (ACL Target) 
that receives the data. If your replication mode is unidirectional (CDP), the direction of the ACL 
copy is automatically set from master to backup slave.  

5. Specify whether you want the ACLs to replicate automatically whenever they are changed on the 
master (Auto), or select Manual and click Start to replicate once. On all slave Agents, select 
Auto. ACL replicating in Manual  mode updates the AVmgr file. The targets attempt to read the 
AVmgr file approximately every 30 Minutes. Manual is recommended when you have a large 
number of files.  
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Limiting Access to a Selected Group of People 

This is similar to the previous example, except that instead of Everyone, you would have to include the list 
of people and groups that are allowed to access the volume; ensure SYSTEM is included and has full 
control on every file and folder. 

Registry Keys 

When the source Agent is configured for automatic ACL replication, the source Agent checks for ACL 
changes every 30 minutes (by default). The default value of 30 minutes can be changed by a registry key 

named ACLP_src_cycle. (It is an integer value and the unit is minutes.) After each ACL check, the 

source Agent calculates the duration to process the ACL, and multiplies it by a factor of 10 (by default), 

compares this new value to the cycle time defined in ACLP_src_cycle, then chooses the larger value 

as the new cycle time. The default factor of 10 can be changed in a registry key named 

ACLP_src_factor. 

The new cycle is formulated as:  Max (ACLP_src_cycle, Duration * ACLP_src_factor) 

On the target side, the default cycle is controlled by ACL_trg_cycle  and the default factor is controlled 

by ACLP_trg_factor. Each of these registry key REG_DWORDs are per-Job based and are located in 

HKey Local Machine/SOFTWARE/AVAILL/AvaillClient/I/S/[servername]/V/[jobname]/.  

For these registry keys to take effect, the Agent must be restarted after you create or change them.  

 

Permission and Network Share 

When you network-share a Job or a folder in a Job, verify that the network-share permissions are 
appropriate for your users.  

To check the network-share permissions 

1. In Windows Explorer, right-click the Job, then click Properties.  

2. Click the Sharing tab, then click Permissions. 

3. If necessary, refer to Windows documentation for information about specifying permissions. 

 

For information on setting file sharing permissions, see Article ID: 304040 (and others) at 
http://support.microsoft.com/default.aspx. 

 

Roaming Profiles 

There are installations that use roaming profiles to provide a centralized Active Directory service to a 
distributed organization. For example, a company might have a site in San Diego with the main Active 
Directory server, and have another site in Chicago that "roams" via VPN to the Active Directory server in 
San Diego. 

Situations like this often result in slowness related to obtaining security information. For example, if you 
view the security of a file, you will see a set of hexadecimal numbers in the security list, each representing 
a user ID. These numbers resolve into actual names within a second or more of opening the list. This is 
because the local computer has to access the remote Active Directory to translate the user-ID to an 
actual name. 

Two operations are affected by this slowness of the "roaming" process: 

1. During the process of creating a new Job, the Agent scans the folder and verifies the security 
settings. This is "step 1" of the two-step mapping process. Although the Agent does not check 
every single file, the process may be extremely slow. 

http://support.microsoft.com/default.aspx


WAFS/CDP User Guide 

54 

2. If you set ACL copy to copy security between sites (either automatic or manual), the process 
might take a very long time. For example, if there are 100,000 files in a job, the ACL copy process 
might take more than a day.  

The best way to avoid the slowness problem is by using security of predefined users. For example, before 
mapping a folder to a new Job, change its security, as well as the security of all the files and subfolders 
under it, to SYSTEM and EVERYONE having full control. Because these are predefined permissions, the 
local computer does not need to roam, allowing everything to process very quickly. 

If possible, it is desirable to keep this security even after the creation of the job (and control user access 
via the share permissions).  

If that is not an option, then use the following process to create a new Job: 

1. Check the actual security of the folder, so that you can restore it later.  

2. Change the security of the folder and all its content to SYSTEM and EVERYONE having full 
control.  

3. Using an Agent, create a new Job for this folder.  

4. At the end of the mapping process (which may take a few minutes), you will get a confirmation 
dialog box. Verify on the Agent that the Job has been created.  

5. Stop the Agent. Preferably, this should be done after the files finished the initial upload, but it is 
OK to stop it before they are done uploading.  

6. Restore the security as desired.  

 

Always include SYSTEM full-control on every file and subfolder. Otherwise, the Agent might 
not be able to access it.  

7. Start the Agent. 

If the above process is not feasible, e.g., if there is a very complex security setting that will be difficult to 
restore, a special procedure is available that will accelerate the process by disabling the security check 
during Job creation. Please contact GlobalSCAPE Technical Support for the procedure. 

See also ACLs. 

Deleting Roaming Profiles 

When WAFS replicates a roaming profile, a user or administrator might not be able to delete the user's 
roaming profile directory and/or subdirectories.  

Depending on the level of the directory selected for deletion, the user or administrator might receive 
the message "Error Deleting File or Folder - Cannot remove folder <Folder>: The directory is not empty" 
or the folder will appear to delete, but then be replicated again from the WAFS Server.  

Before you can delete a roaming profile directory and/or subdirectories, you need to remove the "Read-
only" attribute on the applicable roaming profile subdirectories under the WAFS Job's 
("RoamingProfiles") P directory in the WAFS Server vault ("AD"). 

To remove the read-only attribute from multiple subdirectories 

1. Open a Windows Command Prompt on the WAFS Server computer. (Click Start > Run, type 

cmd, then click OK or press ENTER). 

2. Change directories to the top-level directory of the profile you want to delete. For example, type:  

c:  

cd AD\RoamingProfiles\P\jsmith 
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3. Using the attrib command, recursively remove the read-only setting from child files/folders. Type: 

attrib -R -S -H * /S /D 

You can now delete the directory from any Agent using an administrator account.  

To prevent you from accidentally deleting folders from the Agent machine, pressing 
DELETE alone will not work. When deleting WAFS-replicated folders from the Agent 
machine, press SHIFT+DELETE.  

Configuring and Using the Server 

The topics below describe using and managing the Server. 

The Server 

The Server operates in a hub-and-spoke topology with all the clients.  

The Server:  

 Manages Jobs 

 Stores past versions in its Vault 

 Provides a Web interface to access Jobs 

 Provides the data transfer interface to and from all Agents 

 Maintains mirror coherency 

 Maintains file lock coherence 

 Maintains link security 

 Maintains access rights 

 Allows snapshots, failover, and alarms in case of disconnection from an Agent 

Server Console 

The Server Console is used to manage the Server. 

To open the Server Console 

 In the Windows system tray, click the Server icon . The Server Console appears.  

 

Closing the Server Console does not shut down the Server. 
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The information and options available in the Server Console are described below. 

o The Server menu provides options for administering the Server. 

 

 Manage Jobs launches the Web interface for managing Jobs, setting the owner 
login and password, setting the maximum amount of space the Job may take, 
managing the Job's files (including old versions), or even deleting the Job. Refer 
to Configuring and Using Jobs for details of managing Jobs. 

 Manage Snapshots and Failover opens the interface to create point-in-time 
snapshots of a Job and run automated processes, such as an alarm if an Agent 
goes offline due to an unplanned event. Refer to Snapshots and Failover for 
details of the Snapshots and Failover dialog box. 

 Edit Parameters opens the Server Parameters dialog box, which allows you to 
view and modify Server parameters, such as its port number, or to change where 
the Server uses disk space for its Vault. Refer to Server Parameters for details of 
the Server Parameters dialog box. 

 Auto Run as NT Service controls whether the Server runs as a user program (if 
not selected), or as an NT Service (if selected); you can switch between the two 
modes. Typically, you run the Server as an NT Service so that it runs 
automatically after reboot. 
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 Exit stops the Server if it is running as a process. Typically, the Server is running 
as an NT service, and you must stop it from the Windows Services control panel. 

o The Help menu provides the following options: 

 

 Availl Server Help opens the Server's online help in the default browser. 

 Licensing displays the license options and allows you to reset the registration 
key.  

 About Availl Server displays the version number of the software, a link to 
globalscape.com, and copyright information. 

o Disk usage and Auto-cleanup threshold manages how the Server handles available 
disk space. Used now displays the size of your entire disk, and the total amount of the 
disk that is currently used for any reason. The Server can be a small or large part of this 
total, depending on what else you have on the disk. Threshold allows you to determine 
how much disk can be used before the Server runs its auto-cleanup operation on the 
Vault. Refer to Managing Disk Space on the Server for more information. 

o Clients displays information on all clients that have accessed the Server, including 
Agents and users logged into the Web interface. Information is displayed for all clients 
currently connected and all clients connected since the Server last started. This area also 
displays how many of those connections were made through HTTPS, how many packets 
were transferred and how many errors were encountered. 

o File statistics displays the number of files currently open and number of files and bytes 
transferred to and from the server. 

o Data communication displays information about the amount of data that has been 
transferred In to (from clients) and Out of (to clients) this Server.  

 

Server Parameters 

The Server Parameters dialog box is used to change/specify the computer name, Server working space, 
port, Server cleanups, SSL certificates, log settings, volume display, and Web interface options. 

To open the Server Parameters dialog box 

1. Click the Server icon  in the host server's system tray. The Server Console appears. 

2. Click Server > Edit Parameters. The Server Parameters dialog box appears. 
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 Machine name / IP address / domain is used by the Agents to connect (via TCP/IP) to 
the Server. If the Server is only used inside a corporate LAN, the computer's domain 
name is typically the computer name, e.g. AVSRV5 (from the desktop, right-click My 
Computer, click Properties, then click the Computer Name tab. Use the Full computer 
name.) You can also use the IP address of the computer such as 196.178.1.110, or a 
name known to DNS. This is the computer name Agents use when creating or linking to a 
Job. 

 Server cleanups of old versions and deleted files can be set to occur at any time or only 
during designated hours. Cleanups only occur if the Server uses more space than is 
allocated to it in the Server Console.  

 Agent communications specifies the main Port number the Server will use. The 
Server's default protocol is HTTP over port 80 so that it can traverse firewalls. In 
situations where port 80 is not used for the Server, a port number of 5000 or higher is 
recommended to minimize the chance of conflicting with other applications. To use 
secure ports, refer to Securing Ports with SSL.  

The port will be used for requests to handle the following: 

o Communications with the client (either using the "native" protocol or using 
HTTP/HTTPS, as selected by the optional proxy settings of the Agent) 

o Remote Job administration, a special Web-interface mode for server 
administrators. Note that if a server supports SSL, the normal port is never used 
for Job administration.  

o Communications in Web-interface mode from any Web browser. To log in to the 
server from a Web browser, simply point your browser to http://server:port (if the 
port is 80, http://server will suffice). After the first-time setup, the port is set to 80. 
Some IT administrators may prefer to use a port other than port 80 (port 80 is the 
default HTTP port). A different port might be used because: 
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 Port 80 is already taken by another Web server. If port 80 is already 
used by another application (such as IIS), you must select another port 
number. After installation, if Manage Jobs does not work, the likely 
cause is a conflict on port 80. Additionally, some applications may cause 
an intermittent conflict. 

 For security policy reasons, a company does not want to open this HTTP 
port 

 The Server is running in a local network, and the system administrator 
wants to map the port to the corporate firewall running on another 
computer. 

 

If you do change from port 80, remember it for all the Agent installs. Whenever you 
are asked for the Server name, append the port number to the Server name with a 
colon, as in server_name:port. 

 Additional Channels - This feature allows you to identify multiple ports for Server-to-
Agent communications. See Additional Channels. 

 Server working space - The Server working space specifies where the Server keeps the 
Vault, which includes Jobs' current file versions, past versions, deleted files, and log files. 
The default location is C:\AD. (See To make changes using the Server Console 
below.) Before launching the Server as an application, copy the current Vault directory to 
its new location. Once the server is back up, check that the Server is using the correct 
location and that all of the Jobs are intact. If they are, it is safe to delete the old folder. 

 Log Settings specifies the level of detail written to the log file. Log files are written to the 
folder _Logs in the Vault. Each time the Server runs, it creates a new log file with a name 
containing the date and time when the Server was started (e.g., 
Srv_20070706_1536_001.txt). You can delete old log files. Click Edit Log Settings to 
edit log levels. Refer to Logging Server Information for more information. 

 List volumes protected by passwords - Allows users who are linking to Jobs to see the 
list of all available Jobs. If the check box is not selected, only Jobs that have the 
username U and password P are displayed. 

 Web interface to files specifies how users can view Jobs through their Web browser. By 
default, users can download, rename, and upload files in Jobs in their Web browser (as 
long as they know the Job's login and password).  

o To restrict such access to read-only or disallow it altogether, select the 
appropriate option: Full (R/W) web access, Limited (R/O) web access, No web 
access.  

o To allow Job administration through the Web interface, select the Allow job 
administration check box. 

3. Click OK to save the parameters. 
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Additional Channels 

 

Do not use additional channels before setting up a complete network using just the main channel. 
After the system is successfully deployed, you can add more channels as needed. 

Normally, all of the Agents connect to the Server via the specified channel using the computer name and 
port number. Each Agent might have several activities that need to be executed at the same time. For 
example, for a given Job, the Server might need to download a new file (created by an Agent), upload a 
file updated locally, and obtain the latest content of a given folder. With multiple Jobs, the likelihood of 
having to execute several tasks at the same time increases.  

With one channel, these activities are serialized. Suppose a new file has to be uploaded and that the 
entire upload activity requires 20 TCP/IP packets. The Server interleaves packet streams from different 
activities. For example, after sending the fourth upload packet, it might send a packet for informing the 
Server of another file's rename, and then continue with the fifth upload packet. The interleaving is done 
using a sophisticated priority mechanism that ensures responsiveness for higher priority activities while 
assigning lower priority for background activities such as file downloads. 

Prioritized serialization works very well and provides performance nearing that of a local disk, even if the 
Agent and Server are on a WAN; however, on low-bandwidth networks, the packet round-trip time can 
adversely affect interactive performance. For example, suppose a user opens a spreadsheet and, as a 
result, the Agent needs to send a packet to the Server to verify that the local data is coherent and that the 
file is not opened by another user on another Agent. The round-trip of this file-open packet might be 
relatively quick, but if another upload packet is now being sent, then the Agent needs to wait for the 
Server to reply to that packet before sending the file-open packet. Even though the file-open packet has 
higher priority than upload packets, the Agent still needs to wait, slowing down file activities. 

By defining multiple channels, the Agent can use channels for concurrent activity. All of the additional 
channels are used only for upload and download activities, freeing the main channel (the main port) for 
foreground file activities such as file-open or file-lock. 

 You can define up to 9 additional ports.  

 Specify the additional channels by port numbers. The Server listens to these ports, and they are 
opened on each Agent.  

 You must make sure the proper firewall setting enables traffic on these ports. You can use any of 
the fields for port definition. 

 In some rare cases, you may want to connect several physical links and use different IP 
addresses to route Agent traffic. In that case, specify the Server using the computer name, IP, or 
DNS, followed by the port number.  

To specify additional channels 

1. Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. 

2. Click Server > Edit Parameters. The Server Parameters dialog box appears. 
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3. In the Agent communications area, click Edit Additional Channels. The Additional 
Channels dialog box appears. 
 

 

4. Type a port number in the channel box or an IP address and port number if using a different IP 
address. For example, you could open two additional channels using ports 801 and 802 (the 
Agent connects to these channels using the same Server specification as for the main channel), 
and one additional channel using another IP address and port: 22.30.111.1:803. 

5. Click OK. The Server Parameters dialog box updates with the additional channels.  
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Securing Ports with SSL 

All communications are encrypted end-to-end by default; SSL is only used for regulatory reasons. Using 
the SSL option allows communication with clients (both the Agent and Web interface) over HTTPS with 
encryption keys of up to 128 bits. The port for HTTPS is typically 443. 

SSL can be used on any Windows client, but only Servers running on Windows 2003 and some versions 
of Windows 2000 can be configured to use SSL. 

You need a security certificate to use SSL. This is typically purchased from a Certificate Authority (such 
as VeriSign), but it can also be self-signed. Using a self-signed certificate may cause a warning dialog 
box to appear at the client computer. A self-signed certificate is also less secure than a signed certificate.  

To manage certificates 

1. Click the Server icon  in the Server's system tray. The Server Console dialog box appears. 

2. Click Server > Edit Parameters. The Server Parameters dialog box appears. 

 

3. In the Agent communications area, select the SSL check box. The port number updates with 
the default SSL port number. Change the port number if you use a different port for SSL. 
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4. Click Edit SSL Certificate. The Edit SSL Certificate dialog box appears. 
 

 

5. Do one of the following: 

 To import a certificate, click Import. The Open dialog box appears in which you can 
browse for and select a certificate. 

 To generate a certificate: 

a. Click Generate. The Generate Certificate dialog box appears.  

 

b. The Subject Name box contains the Server name and is not editable. Provide the 
City, State, Country, and Months valid, then click OK. The certificate is generated. 



WAFS/CDP User Guide 

64 

The information appears in the Edit SSL Certificate dialog box. 

 

6. Click Close to close the Edit SSL Certificate dialog box, then click OK to save the Server 
parameters. 

Starting and Stopping the Server Service 

On all Windows versions prior to Windows 2008 and Vista, the Server starts automatically and runs as a 
Windows system service, if so configured. For Windows 2008 and Vista, refer to Using WAFS on 
Windows Server 2008 or Vista. 

To start or stop the Server service using the Windows Services dialog box  

1. Click Start > Run, type services.msc, then press ENTER. The Windows Services dialog box 

appears.  

2. Right-click or double-click the Server service, then click Start (or Stop). 

3. After the service is started or stopped, close the Services dialog box. 

To start or stop the Server service from the command line 

1. Click Start, then click Run. 

2. Enter cmd  or command. 

3. Click OK. 

4. To start the Server service, at the prompt type: 

Net start "availl server"  

(Include the quotation marks.) 

5. To stop the Server service, at the prompt type: 

Net stop "availl server" 

(Include the quotation marks.) 

6. After the service is started or stopped, close the Command Prompt (e.g., type Exit). 
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Server Logs 

Each time the Server is started, it creates a new log file with a name containing the date and time when 
the Server started (e.g., Srv_20070706_1536_001.txt). Log files are written to the Vault in a folder called 
_Logs (e.g., C:\AD\_Logs). You can specify the detail of information saved in the log (when instructed to 
do so by GlobalSCAPE Customer Support), and you can delete old log files.  

To change the log level 

1. Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. 

2. Click Server > Edit Parameters. The Server Parameters dialog box appears. 

 

3. In the Log Settings area, click Edit Log Settings. The Edit Log Levels dialog box appears. 

 

 The Log Category column lists the type of information that is saved to the log. 
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 The Log Level column lists the level of logging selected: 

o OFF, SEVERE, ERROR, WARN, TRACE, DEBUG, ALL - Logs more detail for 
diagnostic use. Logs will grow very quickly. Do NOT use these settings unless 
instructed to do so by GlobalSCAPE Customer Support. 

o INFO - Logs basic information such as the date/time the Server was started, 
computer name, software version, listening port, and so on. 

 

Unless asked by GlobalSCAPE Customer Support to change the log level, 
leave it at the default of INFO. 

4. To specify the level of detail written to the log, click the drop-down menu to select a level, then 
click Set all levels to. The default is INFO. 

 Click Restore Defaults to reset the log level to INFO. 

 Click Apply to save changes without closing the dialog box. 

 Click OK to save changes and close the dialog box. 

 Click Cancel to cancel changes and close the dialog box. 

5. If you selected TRACE, a warning message appears stating that this setting will significantly 
increase the log size. Click Yes to keep the level of TRACE or No to cancel. 

Viewing Server Statistics 

In the Job Administration Web interface, you can view a Server's statistics, such as the current time on 
the Server, how long the Server has been up, connected clients, and transferred data size in bytes. 

To view Server statistics 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

The Job Administration interface appears and displays the Job List. 

 

For information about Opened Files/Directories, refer to Viewing and Closing Opened Files and 
Locked Directories. 

2. Click Server Statistics. 
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The Client Information area displays the number of Agents that are connected and online, the 
number of Web connections to the Server, the number of users who are currently online, and so 
on. You cannot make any changes to the Server in this interface. This information can be useful 
for Customer Support to help you analyze any issues. For example, the number in the Errors 
column indicates how many TCP errors exist. If you see a large number of errors, it is likely that 
you have a network problem; however, this is rare. The Error number is cleared after a Server 
restart. 

The Data Bytes In/Out area displays the number of bytes sent (Out) and received (In), 
compressed (Raw) and uncompressed (Pre-compress). 

3. When you finished reviewing the statistics, click Done. You are returned to the Job List. 

Managing Disk Space on the Server 

The disk space used by the Server is in C:\AD by default. The Vault (in the AD directory) is where the 
latest copies are kept, in addition to past versions and deleted files, up to the space specified by the 
threshold. The auto-cleanup deletes oldest version of files until the used space falls below the set 
threshold. The cleanup only affects old versions of files and deleted files; current files are not deleted.  

To manage disk space 

1. In the Windows Task bar, double-click the Server icon .The Server Console appears. 
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2. In the Disk usage/Auto-cleanup threshold area, the size of the disk and total disk space 
currently in use are displayed. 

 Used now displays the size of your entire disk, and the total amount of the disk that is 
currently used for any reason. The Server can be a small or large part of this total, 
depending on what else you have on the disk. To move the space that the Server uses to 
a different device, open the Server Parameters dialog box. 

 Threshold allows you to determine how much disk can be used before the Server runs 
its auto-cleanup operation on the Vault. It is not a good idea to keep the threshold bar so 
close to the used bar that cleanup happens very often.  

3. Adjust the threshold after which automatic cleanup should take place. Move it as far to the right 
as you can afford in drive space. 

 

You can force a cleanup at any time by moving the Threshold bar to the left of the Used now 
area, thus allocating less space than is currently used and forcing the Server to delete files. This 
may slow performance of the Agents for a few minutes as files are cleaned up. 

Housekeeping is idle means that no cleanup is in progress. 
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Configuring and Using the Agent 

 

Agent Menu 

The Agent places an icon in the system tray when started. View the status of the Agent (online or offline) 
by placing your cursor over the system tray icon . Click the icon to display the Agent menu. 

The Agent menu gives you access to all the functions of the Agent, including Job management, Agent 
setup and configuration, and Agent preferences. 

To open the Agent menu 

 On the Agent computer, click the Windows system tray icon . 
 

 

The menu provides the following options: 

 Availl Agent Help - Links to the online help file. 

 About Availl Agent provides a link to the About dialog box and displays the version number of 
the software. 

 Create a new WAFS or Mirror Job - Opens a wizard that helps you create a new Wide Area File 
System Job. The first step is to choose the source folder for the Job. This can be a folder on any 
local hard drive, including SAN and iSCSI drives, but not a mapped drive.  

 Add this Machine to an Existing WAFS or Mirror Job - Link a local, empty folder to an existing 
Job. When you link a folder, it immediately populates the folder with the data associated with the 
Job, and makes the data fully accessible according to read/write permissions. 

 Create a New File Backup Job - Create a Job to provide continuous data backup. 

 Add this Machine to an Existing Backup Job - Link a local, empty folder to an existing 
continuous backup Job. When you link a folder to an existing Job, the backed up data populates 
in the folder in read-only mode. 

 Availl Job Properties and Options - The Job Properties and Options dialog box allows you to 
view current Jobs and change Job properties such as type, bandwidth throttling, and password 
management. 

 Agent Setup and Preferences - The Setup and Preferences dialog box allows you to monitor 
the status of the Agent and make configuration changes to the Agent. 

 Edit Log Settings - Opens the Change Log Levels dialog box, which specifies the level of detail 
written to the log file. Log files are written to the folder C:\AVCStuff\logs.SYSTEM. Each time the 
Agent runs, it creates a new log file with a name containing the date and time when it was started 
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(e.g., Agn_20080604_1100_001.txt). You can delete old log files. For details of log settings, refer 
to Agent Logs. 

 Explore folders linked to Availl Jobs - Opens a submenu of folders linked to Jobs, which you 
can click to open the folder in Windows Explorer. 

 Exit the Availl Agent - Used to close the Agent if you are not running the Agent as a service. (If 
you are running the Agent as a service, you must use the Services dialog box or a command line 
to stop the service.) 

 

Configuring Agent Preferences 

The Agent Setup and Preferences dialog box controls configuration options of the Agent, such as mirror 
location, proxy settings, and scheduling when mirroring occurs. 

General Tab 

The General tab of the Agent setup and preferences dialog box is used to view/edit Agent information. 

To open the General tab 

1. In the Windows system tray, click the Agent icon , then click Agent Setup and Preferences. 

2. Click the General tab. 

 

 Currently opened files and folders - Displays the number of files and folders that are 
opened. Click Details to view a list of opened files.  

 The Delay file upload check box is cleared by default. When the check box is cleared, a 
file is replicated when it is saved or closed. When the check box is selected, the file is 
replicated only after it is closed. Refer to AutoCAD Tips for one use of this check box. 

 Drive letter - You change the drive letter used to access the data in Windows Explorer. 
Remember, there is only one physical copy of the data on the hard drive. The drive, 
which is just a link to the Job's folder, is a convenient additional place to access the data, 
which is normally accessed from the folder linked to the Job. After you change the drive 
letter, restart the Agent by going to the Windows Services control panel, stopping the 
Agent service, and restarting it.  

 The Auto Explorer refresh check box is cleared by default.  

o When the check box is cleared, if two Agents both have folders linked to the 
same Job and one creates a file in its local folder, the change is replicated 
immediately and the file is placed in the other Agent's folder. The new file does 
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not appear in the second Agent's Windows Explorer until it is manually refreshed 
(e.g. by pressing F5).  

o If the box is selected, it will alert Windows Explorer and force it to refresh the 
display. Selecting the check box causes a slight overhead, but it may be 
important for some applications, such as IIS, which rely on Windows Explorer 
updates in order to manage their cache.  

 Communication Parameters – Reads and displays the set of communications 
configuration parameters used to control how the Agent communicates with the server. 
These parameters are defined in the registry under 

HKEY_LOCAL_MACHINE\SOFTWARE\Availl\AvaillClient\Settings\Comm.  

 

 [Reset] – Clears the communication counters and resets internal communication 
variables to the values contained in the registry. For the communication parameters not 
in the registry, it resets their value to 0; values not in the registry include internal counter 
variables, which are displayed as a counter parameter at the bottom of the information 
displayed by clicking Communication Parameters. 

 

 Mirror on Disk - Opens the Locate the Mirror Directory dialog box in which you can 
specify a different directory. 

o To specify a different drive for the mirror, click the Move the mirror to disk box, 
click a different drive letter, then click OK. 

 Change Name - Opens the Change Agent Name dialog box in which you change the 
Agent's name. 

 Run as NT service - If the check box is selected, the Agent will run as an NT Service. 
For production, always run the Agent as an NT Service. 
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 Delayed startup - Normally not selected. Selecting this check box causes the Agent not 
to start until after the computer boots up, delayed by approximately one minute. 

 

 

Proxy Setting Tab 

A proxy is a software program that allows several computers to share one Internet connection. When the 
Agent is connected directly to an Internet Service Provider (ISP), the computer is connected directly to 
the Internet and there is no need for a proxy. Even in a corporate environment in which many computers 
share the same Internet connection, it may not be necessary to specify a proxy.  

To open the Schedule tab 

1. In the Windows system tray, click the Agent icon , then click Agent Setup and Preferences. 

2. Click the Proxy Setting tab. 

 

By default, the Agent and Server communicate via HTTP protocol. Clearing the check box causes 
the client to use a proprietary WAFS protocol. The advantage of using HTTP is that some 
firewalls allow HTTP, but will not allow proprietary protocols to pass through. In this case, HTTP 
protocol is recommended. 

 If the connection fails without a proxy, configure the Agent for a proxy environment. In 
most cases, the connection with the Server will be established after you select the Use 
Internet Explorer proxy settings check box.  

 If selecting the Use Internet Explorer proxy settings check box does not work, you may 
need to configure the proxy settings manually. If so, select the Use a proxy server check 
box and provide the Address and Port of the proxy server. Ask your system 
administrator for the proxy server's IP address and port number.  

 

Proxy settings are for advanced users only. Specify a proxy only if you have tried to connect 
to a Server from a LAN environment and the connection could not be made.   
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Schedule Tab 

The Schedule tab of the Agent setup and preferences dialog box is used to specify a replication mode. 

Mirror settings have no effect on other Agents on other computers, which will continue to mirror on their 
own schedules. File-locking is not available when mirroring is suspended. If two or more users edit the 
same file while mirroring is suspended, the last version of the file uploaded is considered the current file; 
however, as always, all versions are saved and any version can be made the current version. For 
example, suppose an Agent in Istanbul connects to the Server and uploads myfile.doc. Then an Agent in 
Chicago connects to the Server and uploads myfile.doc. Because the Chicago Agent uploaded last, that 
file version prevails over the version uploaded by the Istanbul Agent. 

To open the Schedule tab 

1. In the Windows system tray, click the Agent icon , then click Agent Setup and Preferences. 

2. Click the Schedule tab. 

 

3. Click a replication mode: 

 Mirror continually - The default mode, real-time, always-on replication. Any change to 
any file or folder is automatically mirrored. 

 Suspend mirroring - The Agent is in offline mode. Users can still access the files and 
modify them, but these changes are not replicated to the Server or to other Agents. Once 
this change is applied, the Agent will display an alert in the system tray to indicate that it 
is no longer connected to the Server and the Agent icon changes to the Agent Offline 
icon . It may take up to a minute for the alert to appear and the icon to change. 

 Mirror on a schedule - You can specify to allow replication only at certain times, such as 
Mondays and Wednesdays between 2:30 a.m. and 4:30 a.m. Select the check boxes of 
the days desired, Start time (in 24-hour format, e.g., 18:00 = 6 p.m.), and Duration. The 
Agent is disconnected from the Server except during these times. (Users can still access 
the files and modify them, but these changes are not replicated to the Server or to other 
Agents until mirroring begins.) 

4. Click OK or Apply to save the changes. 
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Placing the Agent Offline 

There are certain times, such as before restoring a file or making changes to the registry, when you might 
need to place the Agent offline.  

To place the Agent offline 

1. On the Windows system tray, right-click the Agent   icon. The Agent menu appears. 

2. Click Agent Setup and Preferences. The Agent setup and preferences dialog box appears. 

 

3. Click the Schedule tab, click Suspend mirroring, then click Apply. The Agent should disconnect 
in 2 minutes or less. 

4. Confirm that the Agent is disconnected: In the Windows system tray, click the Agent  icon. The 
Agent menu appears. 

5. Click Job Properties and Options. The Job Properties and Options dialog box appears. The 
Connection Status light is red (disconnected) or yellow (off-line) indicating that the Agent is off-
line and the Manage Passwords tab also indicates that the Agent is "Off-Line." 
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Starting and Stopping the Agent Service 

On all Windows versions prior to Windows 2008 and Vista, the Agent starts automatically and runs as a 
Windows system service. (For Windows 2008 and Vista, refer to Using WAFS on Windows Server 2008 
or Vista.) 

To start or stop the Agent using the Services option in the Control Panel 

1. In the Windows Services dialog box, right-click or double-click the Agent service and click 
Start (or Stop). 

2. Close the Services and Administrative Tools windows. 

To start or stop the Agent from the command line 

1. Click Start, then click Run. 

2. Enter cmd or command. 

3. Click OK. 

4. To start the Agent service at the prompt type: 

Net start "availl agent"  

(Include the quotation marks.) 

5. To stop the Agent service , at the prompt type: 

Net stop "availl agent" 

(Include the quotation marks.) 

6. After the service is started or stopped, type Exit. 

Agent Logs 

Each time the Agent is started, it creates a new log file. Log files are written to the folder 
C:\AVCStuff\logs.SYSTEM. Each time the Agent runs, it creates a new log file with a name containing 
the date and time when it was started (e.g., Agn_20080604_1100_001.txt). You can delete old log files. 
You can also change the default location of the logs. Refer to Changing the Default Location of the Agent 
Logs for details. 

To change the log level 

1. On the Agent computer, click the Windows system tray icon . 

2. Click Log Settings. The Edit Log Levels dialog box appears. 
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 The Log Category column lists the type of information that is saved to the log. 

 The Log Level column lists the level of logging selected: 

o OFF, SEVERE, ERROR, WARN, TRACE, DEBUG, ALL - Logs more detail for 
diagnostic use. Logs will grow very quickly. Do NOT use these settings unless 
instructed to do so by GlobalSCAPE Customer Support. 

o INFO - Logs basic information such as the date/time the log was started, 
computer name, software version, IP address and port on which connected to the 
Server, and so on. 

 

Unless asked by GlobalSCAPE Customer Support to change the log level, 
leave it at the default of INFO. 

3. To specify the level of detail written to the log, click the drop-down menu to select a level, then 
click Set all levels to. The default is INFO. 

 Click Default to reset the log level to INFO. 

 Click Apply to save changes without closing the dialog box. 

 Click OK to save changes and close the dialog box. 

 Click Cancel to cancel changes and close the dialog box. 

4. If you selected TRACE, a warning message appears stating that this setting will significantly 
increase the log size. Click Yes to keep the level of TRACE or No to cancel. 

Viewing a List of Opened Files and Folders 

You can view the number of opened files and folders on the Agent's General tab, and open a list of the 
currently open files and folders.  

To view a list of opened files and folders 

1. In the Windows system tray, click the Agent icon , then click Agent Setup and Preferences. 

2. Click the General tab. 
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3. The Currently opened files and folders area displays the number of files and folders that are 
opened. Click Details to view a list of opened files. The list of open files and folders appears in 
the default .txt editor (e.g., Notepad). 

 

Changing the Mirror Directory 

If the computer on which the Agent is installed has more than one hard drive, you can specify which hard 
drive to use as the mirror. 

To change the mirror directory 

1. In the Windows system tray, click the Agent icon , then click Agent Setup and Preferences. 

2. Click the General tab. 

 

3. Click Mirror on Disk. The Locate the Mirror Directory dialog box appears. 
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4. Click the Move the mirror to disk box, click a different drive letter, then click OK. (It is not 
necessary to restart the service.) 

 

Changing the Name of the Agent 

When you install the Agent, the Agent takes the computer name by default. You can give it a different 
name when you install the Agent or you can change the name later. The WAFS system expects each 
Agent connecting to a Server to use a unique Agent name. Since the Agent will use the computer name 
by default, which must be unique within a domain, you typically use this default value. However, when the 
Agents are installed on computers in separate domains it is possible for a name collision to occur. To 
rectify this you must change the name of applicable Agents to ensure they use unique names. 

To change the name of the Agent 

1. In the Windows system tray, click the Agent icon , then click Agent Setup and Preferences. 

2. Click the General tab. 

 

3. Click Change Name. The Change Agent Name dialog box appears.  
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4. In the New name box, provide a new name for the Agent, then click OK. 

 

WAFS Agent Replicated Data Access 

The topics below describe the WAFS Agent replicated data access modes. 

To enforce the rules of the file system, the WAFS Agent must monitor access to the set of replicated data 
and then coordinate that access with all Agents participating in the applicable replication job. The 
coordination is performed through the WAFS Server. Each Agent communicates with the WAFS Server to 
ensure proper exclusive and/or shared access to resources. 

Additionally, the WAFS Server maintains the master set of replicated data. Agents must communicate 
with the Server to upload and download changes to that data so that the data at all Agents is current. 

When the Agent is running and connected to the WAFS Server, it is performing the “typical” type of 
replicated data access. During this time, the Agent is capable of performing the optimal set of functions to 
enforce the rules of the file system. However, certain occurrences can affect the Agent‟s ability to provide 
typical file system behavior, such as when the Agent is shut down or disconnected from the WAFS 
Server.  

Unmonitored Replicated Data Access 

To enforce the rules of the file system, the Agent monitors all access to the set of replicated data. The 
Agent achieves this through the use of a file system driver. When the Agent is running, file system access 
is directed through the Agent‟s file system driver and then processed through the rest of the WAFS 
system. However, it might occasionally be necessary to shut down the Agent for diagnostic purposes, 
such as when servicing the host operating system or during the short periods when the host machine is 
rebooting. Access to the replicated data during this period is considered to be “unmonitored” access. 

The WAFS Agent has the ability to either provide or prohibit access to the set of replicated data when it is 
not running. To provide access when not running, the Agent modifies the Job‟s top-level folder to redirect 
to the internal copy of the Agent‟s replicated data. When set to not provide access, the Agent does not 
perform this modification; accessing the top-level folder results in an “Invalid Access” warning when the 
Agent is not running.  

The "unmonitored access" setting must be specified during initial Job creation or when linking to an 
existing replication Job. This setting is also customizable on the Agent on the Change Options tab of the 
Availl Job Properties and Options dialog box. 
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Because the Agent is unable to monitor access to the replicated data when it is not running, it is unable to 
perform its duties of coordinating shared access to the data set across the multiple Agents. Thus, it is 
possible that a user might edit a file at one site while a user at another site edits the same file. This 
results in 2 disparate revisions of the file being uploaded to the WAFS Server after the Agent restarts. 
Additionally, the Agent is unable to ensure that the data is the most recent version residing at the WAFS 
Server, making it possible for a user to access out-of-date data. 

To prevent this possibly unexpected behavior, it is highly recommended that you configure the Agent to 
prohibit access to the replicated data when it is not running. Typically, the period when the Agent is not 
running is small and the affect on end users is minimal. However, a particular site might require that 
access be provided when the Agent is not running. In this case, the Agent can be configured to provide 
access. This setting may be modified at any time while the Agent is running. 

When the Agent is configured to prohibit access when not running, users receive a "The device is not 
ready" message if they attempt to access files and folders. 

 

Offline Replicated Data Access 

The WAFS Agent relies on the WAFS Server to coordinate shared access to the replicated data among 
multiple Agents. The Agent also consults with the WAFS Server to obtain modified data and ensure the 
data being accessed by users is up-to-date. When the Agent is not connected to the WAFS Server, it is 
unable to perform these typical functions and thus may result in unexpected behavior for the end users. 
Access at this time is considered an “offline” type of access. 

A WAFS Agent may become disconnected from the WAFS Server for a variety of reasons including 
network outage or errors, incorrect firewall reconfiguration, or due to running the WAFS Agent in the 
scheduled replication mode. 

The WAFS Agent is capable of either allowing full access to the set of replicated data or read-only access 
to the replicated data when disconnected from the Server.  

This "offline access" setting must be specified during initial Job creation or when linking to an existing 
replication Job. This setting is also customizable on the Agent on the Change Options tab of the Availl 
Job Properties and Options dialog. 
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If set to allow full access during these outages, it is possible that a user might edit a file at one site while a 
user at another site edits the same file. This will ultimately result in 2 disparate revisions of the file being 
uploaded to the WAFS Server after the Agent is reconnected to the Server.  

To prevent this possibly unexpected behavior, it is highly recommended that you configure the Agent to 
provide read-only access to the replicated data when it is not connected to the WAFS Server. However, a 
particular site might require that access be provided when the Agent is not connected. In this case, the 
Agent can be configured to provide full access. This setting may be modified at any time while the Agent 
is running. 

When the Agent is configured to provide read-only access when disconnected from the Server, users 
receive an "Access is denied" message if they attempt to create or edit files and folders. 
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Configuring and Using Jobs 

The topics below describe how to create and manage Jobs. 

What is a Job? 

A Job is a collection of synchronized folders and the links between them. You can define up to 60 Jobs 
per Agent, each connecting a different folder (including any folders within it). When a folder is linked to a 
Job, all of its data remains on the local drive, ensuring fast, disk-speed access (or LAN speed, if the 
computer is acting as a local file server). The Agent ensures that local data is the same as the data on 
other computers linked to that same Job, whether they are around the corner or around the world. 

 

If you need more than 60 Jobs, you may install additional Agents on separate Servers and define up 
to 60 Jobs on each Agent.  

Suppose a firm‟s London office links a local folder named Clients on their local file server to the Job 
CLIENTS on the firm‟s Server in New York. Another branch in Tokyo links a local folder also named 
Clients to the same Job CLIENTS. From then on, the Agent synchronizes the contents of London‟s local 
folder Clients and Tokyo‟s local folder Clients. Any change in one is synchronized by the CLIENTS Job, 
which makes sure that the contents in both local folders is the same. 

A Job has several attributes (see Job Properties and Options): 

 Name - This is used by Agents to link to the Job. 

 Job type - This can be either WAFS/mirror (multi-directional replication), or CDP/backup, in 
which only the master has read-write access, and the backup computer only has read access. 

 Quota - This sets the maximum amount of disk space the data in the Job can take up. 

 Username and password - A given login credentials required to connect to the Job may give full, 
read/write access to a Job, or read-only access. 

A new Job is created at an Agent by specifying a top-level folder to replicate. Any content in that folder is 
added automatically to the Job. Once the Job is created, other Agents can link to it. 

When a new Agent first links to a Job, all of that Job's data appears in seconds. If you open a file before 
its contents have been replicated from the Server, the Agent will immediately stream the required data in 
real time. 

 

Opening the Job Administration Web Interface 

The Job Administration Web interface is used to manage Jobs. For details of managing Jobs in the Job 
Administration Web interface, refer to Managing Jobs. 

 

To open the Job Administration Console on the Server computer 

1. In the Windows system tray, click the Server   icon, then click Display the Server control 
panel. The Server Console appears. 
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2. Click Server > Manage Jobs. The Job Administration Console appears. 

To open the Job Administration Console on the Agent computer 

1. In the Windows system tray, click the Agent   icon, then click Job Properties and Options. 
The Job Properties and Options dialog box appears. 

2. Click View and Retrieve. The Job Administration Console appears. 

Creating a New Job 

To create a new WAFS or Backup (CDP) Job between computers, you start by clicking Create a new "x" 
Job on the Agent menu, where "x" is the type of Job, WAFS or Backup (CDP). You should do this at the 
computer where the source or master data is stored. If none of the computers has the data yet, it does 
not matter where you start.  

 

You cannot create a Job within a Job, also known as nested or nesting Jobs. If you want to make it 
easier for users to access subfolders, you can make several separate Jobs pointing to each folder 
instead of one big Job. 

Once you create the new Job, you add other computers and their Agents to the Job. You do not have to 
do this for backup; the Server is your vault. 

An Agent should be installed on each computer/Server from which the data will be accessed, usually one 
Server per site. 

Think of each Job as an independent link between the Agents and the Server, in a hub-and-spoke 
topology. Each Job ensures your Agents are part of a WAFS. You can have up to 60 Jobs per Agent and 
multiple Agents per Server. 

The Server operates under the credentials of SYSTEM account, and therefore every file and sub-folder 
must allow full control to SYSTEM. Before selecting a folder with data, you may want to ensure that all 
files and sub-folders have ACL security allowing full access to SYSTEM. The Server runs a check on a 
sample of files to see if the files have full SYSTEM rights. If they do not, it offers to add SYSTEM access 
to every file and folder. 

 

On Windows 2008/Vista, WAFS/CDP runs as an application; therefore, the user account running 
the application must also have full control to all files and folders within the Job's dataset. 

Using the procedure below, create the Job using the Agent on the computer that contains the data. 

To create a new Job 

1. Do one of the following: 

 If you have no Jobs defined or have unlinked from all Jobs, a dialog box appears 
automatically when the Agent starts in which you must specify the initial source of the 
data (whether this is a brand new Job or if the Agent will pull data that is already being 
replicated from another Agent), then click Next.   
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 On the Windows system tray, click the Agent  icon, then click Create a new WAFS or 
Mirror Job, to specify the local NTFS folder that contains the data that will be shared 
between several computers.  

 On the Windows system tray, click the Agent  icon, then click Create a New File 
Backup Job, to specify the folder that contains the data to be backed-up. Once 
specified, the data is uploaded to the Server's vault, and any changes made to the data, 
such as by copying, deleting, or editing information, is sent to the Server. This transfer is 
byte level/compressed, so traffic is negligible.  

The Select a folder dialog box appears. 

 

2. Click Browse to specify the folder that you will link to the Job, then click Next. The Create a New 
Availl Job dialog box appears. 
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3. In the Server area, specify the IP address and port (if not port 80) of the Server computer. 

4. In the Job's name area, specify a name for the Job or leave the default of the folder's name. 

5. Click Next. The unmonitored data access options appear. 

 

6. Specify whether to Prohibit or Provide access to the replicated data when the Agent is not 
running. Prohibit is recommended. Refer to WAFS Agent Replicated Data Access for more 
information. 

7. Click Next. The offline Agent options appear. 
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8. Specify whether to Provide read-only access or full access to the replicated data when the 
Agent is offline. Read-only is recommended. Refer to WAFS Agent Replicated Data Access for 
more information. 

9. Click Next. The Job Summary appears. 

 

10. (Optional) To specify file types to exclude or include, click Edit Filters (or Set up Filter). Refer to 
Filtering Jobs for details of defining filters. 

11. Click Link to Job. A message appears reminding you to verify that no user or program is using 
any file in the specified folder when you attempt to link the folder to a Job.  

12. Click OK. The folder is linked to the Job and a verification message appears. 
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Linking (Adding) a Folder to an Existing Job 

After you create a Job, you can link to a Job at any other computer running an Agent. 

 If the link is to a WAFS Job, the folder's data is fully accessible in read/write; i.e., you can modify, 
add, and delete data, and each Agent reflects these changes. 

 If you link to a backup Job, the data from the source Server is immediately available in the 
specified folder in read-only or slave mode. In backup mode, there is only one master (the Agent 
that created the Job). Any backup Job can have any number of slave Agents, and so for a given 
Job you can have either point-to-point backup topology, or one-to-many content replication 
topology in which each slave Agent immediately reflects changes in the master. 

To link to an existing Job 

1. Create a new empty folder to link to the Job. It can have any name, but do not rename it or move 
it once you link to it.  

2. On the system tray, click the Agent icon , then click Add this computer to an existing WAFS 
or Mirror Job. The Select a Folder dialog box appears. 

 

3. Specify the local folder to which you want to link the Job, then click Next. The Link to an 
existing Availl Job dialog box appears. 
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4. Specify the Server to which you want to link the Job, then click Next. The unmonitored data 
access options appear. 

 

5. Specify whether to Prohibit or Provide access to the replicated data when the Agent is not 
running. Prohibit is recommended. Refer to WAFS Agent Replicated Data Access for more 
information. 

6. Click Next. The offline Agent options appear. 
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7. Specify whether to Provide read-only access or full access to the replicated data when the 
Agent is offline. Read-only is recommended. Refer to WAFS Agent Replicated Data Access for 
more information. 

8. Click Next. The Job Properties page appears. 

 

9. (Optional) To specify file types to exclude or include, click Edit Filters. Refer to Filtering Jobs for 
details of defining filters. 

10. Click Link to Job. A message appears to remind you to verify that no user or program is using 
any file in the specified folder when you attempt to link the folder to a Job.  

11. Click OK. The folder is linked to the Job and a verification message appears. 
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Unlinking (Removing) a Folder from a Job 

Unlinking a Job permanently breaks the link to the folder. The folder and its data remain on the computer, 
but they are no longer replicated to the vault. Alternately, you can suspend mirroring temporarily on the 
Schedule tab of the Agent Setup and Preferences dialog box. 

To unlink a job 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options. The Job Properties and Options dialog box appears. 

 

2. In the Server and Job list, click the down arrow to select the Job. The Linked folder path 
appears below the Server and Job list. 

3. Click Unlink. A confirmation message appears.  

4. Click OK unlink the folder. 

Viewing a List of Jobs 

In the Job Administration Web interface, you can view a list of all Jobs defined on the Server. 

To view a list of Jobs 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

2. The Job Administration interface appears and displays the Job List. 
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Viewing Information about a Job 

In the Job Administration Web interface, you can view information about a Job, such as the owner, size, 
quota, timeout, and linked folders. To manage Jobs, refer to Viewing and Managing a Job's Contents. 

To view information about a Job 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

The Job Administration interface appears and displays the Job List. 

 

2. Click Details. The Job Information page appears. 

 

3. At the top-right of this page are links to Edit or Delete the Job from the Server.  
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4. When you have finished viewing the Job's information, click Done. 

Viewing and Managing a Job's Contents 

In the Job Administration Web interface, you can view the contents of Job (the files and folders it 
contains). The Job Administration Web interface allows an administrator to examine the Server's status 
and manage Jobs.  

An administrator can access the interface remotely by logging in to the Server's admin function from any 
Web browser. For example, http://server8.yourCompany.com/admin. 

 

If you are running the Server using a port other than 80, you need to specify the port number in the 
URL.  

e.g., http://server8.yourCompany.com:711/admin 

In the Job Administration console, you can perform the following tasks: 

 View Server Statistics  

 View Opened Files/Dirs 

 View Information about a Job 

 Delete a Job 

 Edit a Job (change the Job Name, Job Type, Job Owner/Password, Quota, or timeout). 

 View and manage a Job's contents (upload files, create folders, etc.)  

 

The Job "FirstFolder" is a default Job created by the application. You can delete the Job 
named "FirstFolder" if you are not using it and you have created other Jobs. 

To view a Job's contents 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

The Job Administration interface appears and displays the Job List. 

 

2. In the Job Name column, click the Job's name. All of the files currently in the Job are listed in the 
Job's File Retrieval list.  
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3. In the File Retrieval page, you can download, rename, and delete files, create new folders, and 
upload files to the Job: 

 To rename a file or folder, open the Job that contains the file folder, then next to the file 
or folder, click Rename.  

 To delete a file or folder, open the Job that contains the file, then next to the file or folder, 
click Delete.  

 To upload files to a Job, open the Job, then click Upload. When the upload form 
appears, browse for a file to upload, then click Upload. 

 To create a new folder in a Job, open the Job, then click New Folder. When the New 
Directory Name box appears, type a name for the directory, then click Create. 

 To go back to the list of all Jobs defined on this Server, click Job List.  

 To see past versions of a file, restore past versions of a file, or restore deleted files, refer 
to Restoring a File in the Job Administration Web Interface. 

 

Viewing and Closing Opened Files and Locked Directories 

Opened Files 

A file handle is a number that the operating system assigns temporarily to a file when it is opened. The 
operating system uses the file handle internally when accessing the file. Once an application has modified 
and saved a file, the WAFS Agent retains the handle to the file while it is waiting to be uploaded or is in 
the process of uploading the file to the WAFS Server. This prevents simultaneous modification of the file 
across multiple Agents.  

Locked Directories 

When a user tries to open an application, save a file, or open a directory, there is usually more than one 
"file open" or "file close" operation performed. As a performance enhancement, when the first open 
occurs, the WAFS Agent tries to lock the parent directory. If the Agent obtains the lock, the Agent 
performs the open or close file operations locally. When these operations are performed locally, the Agent 
does not have to send communications messages to the Server and thereby reduces the effect of latency 
on the performance of the system.  

Before the Agent releases the lock, the Agent combines all open operations together within one “burst” 
open operation and sends it to the Server. If the directory has already been locked by another Agent, 
none of the files in this directory can be opened until the locking Agent relinquishes the lock.  
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Effects of loss of communications 

To ensure file coherency, the WAFS system must retain handles on files and the current set of directory 
locks when and Agent loses connection with the WAFS Server. Open file handles and locked directories 
can be viewed and manually closed at the WAFS Server via the Web interface. (The handle will be closed 
automatically when no longer needed.) Additionally, the opened file handles and directory locks will be 
automatically released based on a configurable timeout value. 

The behavior during a loss of communications depends on the type of disconnection, defined as follows: 

 When an Agent ungracefully disconnects from the WAFS Server (e.g., the application 
crashes, the computer is cold booted, or a loss of network occurs), the WAFS system retains 
directory locks. These directory locks can be viewed and released at the WAFS Server via the 
Web interface.  

 For graceful disconnections (e.g., Agent replication suspended, goes into period of non-
replication based on scheduled replication settings, or Agent is shut down), the WAFS System 
converts directory locks to opened file handles. 

 If an Agent goes offline after locking a directory, the Server does not release the locked 
directory. When a directory is locked by an offline Agent, the Server returns an error if another 
Agent tries to open it. When the Agent reconnects to the Server, the Server releases the lock on 
the directory.  

Opened file handles and locked directories by offline Agents are automatically closed after the time 
specified in the Editing Job Information page. 

To view opened files and directories 

1. Do one of the following: 

 In the Windows system tray, click the Server  icon, then click Display the Server 
control panel. The Server Console appears. Click Server > Manage Jobs.  

 In the Windows system tray, click the Agent  icon, then click Job Properties and 
Options. The Job Properties and Options dialog box appears. Click View and 
Retrieve.  

The Job Administration Console appears. 

 

Click Opened Files/Directories. The Opened File List appears. 

 

The Opened File List displays opened file handles and locked directories.  
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The Since column displays the date and time the file was opened or the directory locked. If a file 
or directory was locked by an offline Agent, the name and IP address of the Agent is shown in red 
in the By column. 

 

To close the file or directory manually, click Close. 

To change the amount of time to retain opened file handles for disconnected Agents, refer to Editing Job 
Information. 

Filtering Jobs 

By default, when an Agent creates a new Job or links to a Job, the Agent synchronizes with the Server. 
Using filters, you can exclude certain files, file types, or folders from being replicated. You can set the 
filter parameters for each Job, and can specify filter parameters that apply to all Jobs.  

 You can filter a specific file name (e.g., desktop.ini) or using wildcard patterns. For example, to 

exclude any mp3 files from replication, you can filter files named *.mp3.  

 You can add a folder filter (relative to the Job's root folder) to prevent an entire folder from being 
replicated (e.g., Marketing\Promotions\OldLiterature). 

Filters are Agent specific; that is, you must set up the filters at each Agent. The filters are stored as XML 
files in a folder called Filter in the AVCStuff folder (e.g., C:\AVCStuff\Filter). These filter files can be 
copied from one Agent to another so that you do not have to redefine them for each Agent. 

In some cases, the filtering functionality may be used to increase the performance of the WAFS system 
by filtering out unnecessary files. Such files might include temporary files ("*.tmp") that are often used on 
a temporary basis while performing a save operation. When handling I/O requests for filtered files, the 
Agent can skip expensive operations such as network communications with the Server. This reduction in 
expensive operations can lead to performance gains. 

Note that incorrectly filtering out files may lead to unexpected behavior within user applications. Care 
should be taken when adding or modifying the set of filters through careful testing. 

Creating Filters 

You can create Filters when you create a new Job, when you link to a Job, or any time that the Agent is 
running. (To remove a filter, refer to Removing Filters.) 

To filter a Job 

1. Do one of the following: 

 When you create a new Job: 

a. Create a New Job. 

b. On the Job summary page, click Set up Filter. 
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 When linking to a Job: 

a. Link to the Job. 

b. On the Link to an existing Availl Job page, click Edit Filter. 

 

 In the Job Properties and Options dialog box: 

a. On a computer on which the Agent is installed and running, in the system tray, 
click the Agent icon , then click Job Properties and Options.  

b. On the Change Options tab, click Filter. 
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The Filter Editor appears. 

 

In the Filter Editor, you can add a filter to All Jobs on this Agent or a Specific Job on this 
Agent.  
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 To add a filter to all Jobs on the Agent, click the All Jobs tab.  

 To add a filter to a specific Job, click the Specific Job tab. 

 

2. If you clicked the Specific Job tab, the tab and the Server and Job name list display the 
selected Job. If you have previously defined filters on the selected Job, its filters appear in the 
File Filters and Folder Filters areas. 

To filter out specific files or file types:  

a. In the File Filter area, define the file filter pattern for those files that you do NOT want to 
replicate: 

 Use the asterisk (*) to replace zero or more characters. 

 Use the question mark (?) to replace exactly 1 character. 

Examples of file filter patterns: 

*.bak - Will not replicate files that end with .bak extension 

tmp* - Will not replicate files that start with "tmp" 

*.mp? - Will not replicate files with an extension of .mpX, where X is any one 
character. 

b. Click Add. The filter pattern is displayed.  

c. Click OK to save the filter. 

To filter out entire folders: 
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a. In the Folder Filter area, define the folder filter pattern for those folders that you do NOT 
want to replicate (i.e., none of the files in the folder will be replicated).  

 You can use wildcard patterns or the full path, relative to the Job's root folder.  

 When setting folder filters that apply to all Jobs, it might not make sense to use a 
full path, unless the same path applies to all Jobs.  

Examples of folder filter patterns: 

*temp* - Excludes any folder that has "temp" in its name 

\Local? - Excludes any folder in the job root folder that starts with "Local" and has 
exactly one character at the end (e.g., "Local7") 

b. Click Add. The filter pattern is displayed.  

c. In the Specific Job folder filter, you can click Browse and Add to browse for and add a 
folder to exclude from replication. The Browse for Folder dialog box opens to the Job's 
root folder and displays all of the folders in the Job. 

 

d. Specify the folder that you do not want to replicate, then click OK. The folder is added to 
the Filter Editor. 

3. Click OK to close the Filter Editor and, if you are creating or linking a Job, continue with that 
procedure, as usual; click Apply to save the changes and leave the Filter Editor open. 

Removing Filters 

To remove a filter 

1. Open the Filter Editor, as described above. 

2. Click the filter pattern that you want to remove, then click Remove. 

3. The files and/or folders that were not being replicated will now replicate. 
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Deleting a Job 

You can delete a Job in the Job Administration Web interface. For example, the "FirstFolder" Job is 
created by default. You may want to remove this sample Job after you have created the Jobs that you will 
be using. 

To delete a Job 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

The Job Administration interface appears and displays the Job List. 

 

2. Next to the Job you want to delete, click Details. The Job Information page appears. 

 

3. Click Delete. A confirmation message appears. Click Yes. The Job is deleted and you are 
returned to the Job List page. 
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Editing Job Information 

You can edit information about a Job in the Job Administration Web interface. On the Editing Job page, 
you can change the Job's name, type, owner, password, quota, and timeout. 

To edit a Job 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

The Job Administration interface appears and displays the Job List. 

 

2. Click Details. The Job Information page appears. 

 

3. Click Edit. The Editing Job page appears. 
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 To change the Job's name, in the Job Name box, type a new name. 

 To change the Job's type, refer to Changing a Job's Type. (There is usually no reason to 
change a Job's type.) 

 To change the Job's owner, in the Job Owner box, type the username, then in the 
Password and Repeat Password boxes, type the password. 

 To change the Job's quota, in the Quota box, type the new quota in MB. Quota is the 
amount of space in MB that this Job is allowed to occupy on the disk. This number sets 
an artificial hard limit based on disk size per Job. This means that if you set the quota to 
200GB and someone tries to put in 201GB they will get a disk full message, even if the 
disk is not full. The purpose of this quota is to be able to deal with different servers of 
different capacities on Agents. For example, suppose Agent A has 200GB free and Agent 
B has 100GB free. When someone drops 150GB on Agent A (with the 200GB) free, 
Agent B (with only 100GB) free will have errors when it attempts to replicate the data on 
Agent A.  

 To change the number of minutes after which the Server will close opened file handles 
and locked directories held by offline Agents, in the Automatically close opened 
handles after box, type the number, in minutes. Type -1 to leave the opened handles 
opened indefinitely.  

4. After you have finished editing the Job, click Save.  

Restoring a File in the Job Administration Web Interface 

If a user has accidentally deleted or modified a file, you can restore a previous version of the file via the 
Job Administration Web interface. 

Users can also access this interface by going to http://server:port (":port" is optional if the port is set to the 
default of 80), clicking Login to Web interface, then typing the Job's name and appropriate username 
and password (see Manage Passwords Tab).  

Clicking View and Retrieve in the Job Properties and Options dialog box automatically logs in the user 
with the Agent's credentials. 

To restore a file 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  
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The Job Administration interface appears and displays the Job List. 

 

2. In the Job Name column, click the Job's name. All of the files currently in the Job are listed in the 
Job's File Retrieval list. 

 

 To make a previous version of a file the current version 

o Click the filename of the file you want to restore. The View and Retrieval page 
for that file displays all available past versions. You can then Download any 
version of the file or make a specific past version of the file the current version by 
clicking Make Current.  

 

 To restore a previously deleted file 

a. Click Deleted Items. The File Retrieval page for deleted items appears. 
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b. Next to the file you want to restore, click Restore. 

3. When you have finished restoring, click Done - Go Back until you are returned to the Job List. 

Taking a Snapshot of a Job 

The Server's snapshot option allows you to take periodic snapshots of your Job's data. You can manually 
take a snapshot at any time, and for every Job, you can take up to eight snapshots per day and store 
them at a location of your choosing. A snapshot includes the latest copy of all the files in the chosen Job 
at the instant the snapshot was taken (no past versions or deleted files are included in a snapshot). There 
is no affect on ongoing use of files at any Agent during the snapshot. The snapshots are stored in a folder 
named target\NAME.TIME where target is the specified target folder, NAME is the Job name and TIME is 
in the format YYYYMMDD_hhmm specifying the date and time when the snapshot started. (e.g., 
C:\DOCUMENTS.20090303_1029).  

Be careful which folder you specify so that do not create a loop. That is, if you are replicating 
C:\Documents and Settings\All Users\Documents, do not save your snapshots in that directory. 

 

If files are opened (by a user, through an Agent) at the time of the snapshot, the snapshot process opens 
it in read-only mode for the purpose of reading the data from it and copying it. Only if the file is opened in 
exclusive mode by one of the Agents (rare), would it be skipped.  

The snapshot process creates a snapshot folder (e.g., DOCUMENTS.20090303_1029) and a log file at 
the top level of the snapshot folder (e.g., ~copyLog_20090303_1029_001.txt). If there are any copy 
errors, they are listed in the log file. The log appears similar to the example below: 
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Log opened 03/03/2009 16:29:37 GMT 

            Software: Availl Server 

            Revision: 3.6.1.9302 

            Computer: KLM-WAFS-SERVER 

                User: SYSTEM 

            Platform: Windows 2003  (Windows 5.2 Build 3790  Service Pack 2 ) 

     Physical memory: 255 MB 

    Time zone offset: 6.0 hours 

 In daylight savings: No 

10 | 03/03-10:29:37:000 | INFO | NONE | *snapshot DOCUMENTS* copied         62 

bytes "desktop.ini" 

10 | 03/03-10:29:37:218 | INFO | NONE | *snapshot DOCUMENTS* copied       1250 

bytes "My Music\Sample Playlists\000F03C0\Favorites -- 4 and 5 star rated.wpl" 

10 | 03/03-10:29:37:218 | INFO | NONE | *snapshot DOCUMENTS* copied       1049 

bytes "My Music\Sample Playlists\000F03C0\Favorites -- Have not heard recently.wpl" 

10 | 03/03-10:29:37:218 | INFO | NONE | *snapshot DOCUMENTS* copied       1474 

bytes "My Music\Sample Playlists\000F03C0\Favorites -- Listen to late at night.wpl" 

10 | 03/03-10:29:37:234 | INFO | NONE | *snapshot DOCUMENTS* copied       1477 

bytes "My Music\Sample Playlists\000F03C0\Favorites -- Listen to on Weekdays.wpl" 

  

Refer to Automating CDP Failover for details of the Automatic failover section of the dialog box. 

To specify a snapshot schedule for a given Job 

1. In the Server Console, click Server > Manage Snapshots and Failover. The Snapshots and 
Failover dialog box appears. 
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2. Next to the Job box, click the down arrow to select the Job for which you want to define snapshot 
and recovery options.  

3. In the Target folder box, specify the folder in a local or network drive in which snapshots will be 
stored. (Specify a different folder outside of the one you are replicating.) 

4. Select the Perform periodic data snapshots check box, then type the time(s) to take the 
snapshots. The time is specified as HH:MM where HH is the hours (0 to 23), and MM is the 
minutes (0 to 59).  

5. In Snapshot quota, specify a disk quota, in gigabytes (GB), for all of the snapshots. As many 
snapshots as will fit in the quota are kept, and when the quota is reached, old snapshots are 
erased.  

6. To take a snapshot now, click Perform a Snapshot Now. The Snapshot status area displays 
"Running" while the snapshot is in progress. 

7. Click Apply if you want to specify snapshots for other Jobs, or click OK to save the settings and 
close the dialog box. 

8. If you want to specify snapshots for several Jobs, you can specify the same target folder for all 
Jobs, or specify a unique target folder for each Job.  
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Configuring Job Properties and Options 

The topics below describe the features of the Job Properties and Options dialog box. 

Jobs Properties and Options 

Make changes and monitor Jobs in the Job Properties and Options dialog box.  

To open the Job Properties and Options dialog box 

 On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

 

The Job Properties and Options dialog box displays the following information: 

 Server and Job name - Select the Job you want to work with from the drop-down menu. This 
menu displays the name of the currently selected Job, the Server it is running on, and the port 
number (if other than the default port 80). If the Job you are looking for does not appear in the list, 
you can type it in the box. 

 

Take care not to rename a linked folder. If you must rename it, contact support for 
assistance. 

 Linked folder - This lists the path of the local folder that is linked to the Job selected in the 
Server and Job name list.   

 - The upper right-hand corner of the Job Properties and Options dialog box shows 
the connection status of the Agent with the server.  

o A green light indicates a good connection. 

o A yellow light indicates that the Agent is offline because connection with the Server has 
not been established.  

o A red light indicates that the Agent was connected to the Server but is now offline 
because the connection has been broken. 
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 Unlink - Unlinks the folder from the selected Job. Note that unlinking affects the data in the 
folder, but since the folder is no longer part of that Job, WAFS makes no further changes to those 
files. 

 Explore - Opens the linked folder in Windows Explorer. 

 View and Retrieve - Opens the Job Administration console for the selected Job in your default 
browser.  

o The Job Administration console displays the Jobs defined on the Agent, and the files 
and directories in the Job, including current and past versions. It allows users to 
download files, upload files, or restore previous versions of files or even deleted files. The 
Web view is how users without the Agent installed on their computers can access the 
Job's data. For example, Macintosh users and Linux users can share data with each 
other and with Windows users via this Web interface.  

 
 
You can set security to allow users certain access rights using the Agent's password settings 
or using the Web interface settings on the Server Parameters dialog box. 
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Refer to the following topics for information about each tab of the Job Properties and Options dialog 
box: 

o Job Info 

o General File Info 

o Communication Info 

o Change Options 

o Manage Passwords 

 

Job Info Tab 

To view the Job Info tab 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

2. Click the Job Info tab. 

The Job Info tab displays the number of files and directories in the linked folder, as well as the 
total Job size, or the quota, and the amount used. In addition, the access mode or permission 
level displays, which can be either full or read-only. 

 

 Files, Folders, and Used display a count of the number of files and folders in the Job, 
their total size in megabytes, and the amount used in megabytes. 

 Access mode depends on your configuration: 

o Full = Regular WAFS Job or CDP Master Agent 

o Read-only = CDP Slave Agent Read only access 

 Count Now updates the Job information, used mainly when running FastMerge. Job 
information is automatically updated at regular intervals, but forcing a count ensures that 
the information is current. When you click Count Now, if the Agent is online, a warning 
message appears: 
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o Click Yes to run full system audit. The Agent matches its data, folder by folder, 
with that of the Server. This operation might take a relatively long time, 
depending on the number of folders in the Job. 

o Click No to run a quick audit. The Agent scans its folders and consults with the 
Server only for folders that require it. 
 
When the audit is complete, a data count message appears: 
 

 

o Click OK to dismiss the message. The Job Info tab is updated with the count. 

 

General File Info Tab 

To view the General File Info tab 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

2. Click the General File Info tab. 

The General File Info tab displays the status of the selected Job.  

 

To ensure you have the latest information, on the Job Info tab, click Count Now. 
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Percent of disk quota filled - The progress bar displays how much of the Job's quota is 
currently in use. Click Details to display general mirroring information about all the files in the 
Job. 

Local data that needs to be uploaded to the server - When you modify files in the folder, the 
changes must be uploaded to the server. The progress bar displays the percentage of all the files 
that need to be uploaded. Typically, if you work online, the upload is quick, because only the file 
changes are mirrored. If you are working offline, modifications and new files are reflected in the 
progress bar. Click Details to view a list of modified files that are queued to be uploaded. 

Server data that is not yet fully mirrored on this computer - The progress bar displays the 
amount of data that needs to be downloaded from the server. This refers either to data that is not 
yet mirrored on your computer or mirrored data that needs to be updated because of a 
modification made by another user. Click Details to display the status of files that need mirroring, 
including percentage mirrored. This can be useful if you are connected to the server and want to 
disconnect and work offline. Note that in offline mode, you can only access files that are fully 
mirrored to the local folder.  

 

 

Communication Info Tab 

The Communication Info tab of the Job Properties and Options dialog box displays real-time file transfer 
information. When a file is being mirrored out, the uploading area displays a progress bar of the upload. 
When a file is mirrored in, the downloading area displays a progress bar of the download. 

The upload or download throughput, in bytes/second, is different among files. In addition to the speed of 
the link and the latency between the Server and Agent, throughput also depends on the number of 
changes (the difference between the previous version of the file and the current) and the type of data and 
how compressible it is.  

To view the Communication Info tab 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

2. Click the Communication Info tab.  
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 The R and T lights blink when packets are exchanged between the Server and your 
system.  

 The Uploading and Downloading areas display a progress bar of the download. 

  

 

 

Change Options Tab 

To view the Change Options tab 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

2. Click the Change Options tab. The Change Options tab allows you to control various aspects of 
the selected Job. 

Job Type - This is a read-only display of the Job type. Changing a Job type (which is rare) must 
be done from the Server.  

 The Master and Slave check boxes apply only to CDP. If you link to a backup Job, the 
data from the source Server is immediately available in the specified folder in read-only 
or slave mode. If you attempt to change the Agent from a slave to a master or master to 
slave, the following message appears: 
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o Click Yes to make this Agent the master (read-write) or No to leave it as the 
slave (read-only). 

Bandwidth Throttling - Auto is selected by default. Both the upload and the download activities 
are performed at a relatively low priority, so that bandwidth use remains low, ensuring optimal 
performance for users and local applications. WAFS will automatically use the setting of 
Norm/Low when user activity is detected and VHigh/High only when user activity is idle. The 
Server sends only compressed, byte-level differences, so it does not need much bandwidth for 
standard operation. 

Bandwidth settings have been improved in v3.7.1. There are now three settings: Low, High, and 
Auto. The new setting labeled Low is closest to the setting previously labeled Normal. The new 
High setting is closest to the previous setting VHigh, but with significant improvements. Auto 
behaves as it did previously, dynamically changing the throttling based on recent activities. As 
before, upload and download are each set separately. Due to the performance improvements in 
this release, „High‟ is now the recommended setting for most users. Low is only recommended for 
users that have very slow network connections. Auto remains the default for both upload and 
download. When Auto is selected, the Agent will check the activity on regular intervals to 
determine whether to use high or low bandwidth. This interval can be set in the registry. 

3.6.2 3.7.1 

Normal Low 

High High 

VHigh High 

Auto (default) Auto (default) 

Password - The Save check box, selected by default, saves the password so that you are not 
prompted for the password each time the Agent starts. If you clear the Save check box, you must 
type the password each time the Agent is started. Change opens the change your password 
dialog box to change the password for accessing the Job.  

 

 Type the current password and the new password, then click OK. 

Replicated Data Access Options allows you to change the WAFS Agent replicated data access 
modes. 
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o When Agent is not running: 

o Prohibit access - Prohibits access to the replicated data when the Agent is not 
running. 

o Provide access - Allows users to access replicated data when the Agent is not 
running (can cause file conflicts once Agent is not running) 

o When disconnected from Server, provide: 

o Read-only access - Users cannot create or edit files and folders, but can still 
open them. (Recommended) 

o Full access - Users can continue to create or edit files and folders. 

Sync Security ACLs opens the ACL Security Manager dialog box. 

The ACL Security Manager allows you to replicate between Agents the Windows security 
settings for all files and sub-folders in the displayed linked folder.  

 

You can select whether the current Agent is the master (ACL Source) or the slave Agent (ACL 
Target) that receives the data. If your replication mode is unidirectional (CDP), the direction of the 
ACL copy is automatically set from master to backup slave. You can select whether you want the 
ACLs to replicate automatically whenever they are changed on the master (Auto), or you can 
select Manual and click Start to replicate once. On all slave Agents, select Auto. ACL replicating 
in Manual mode updates the AVmgr file. The targets attempt to read the AVmgr file 
approximately every 30 Minutes. Manual is recommended when you have a large number of files. 
See Access Control Lists (ACLs) for more information. 

Sync burst - The Sync burst check box, to the right of Sync Security ACLs, has nothing to do 
with ACLs, but is used to increase performance during searches. The Sync burst check box 
allows the Server to recognize multiple directory sync requests, which can degrade performance. 
For example, if someone is searching a large directory looking for a particular file type, if the 
Sync burst check box is selected, the Server does not do a synch while the directories are 
searched. If the Sync burst check box is not selected, the user's computer could freeze or get an 
error message while doing a find or search on a large group of folders, and require them to reboot 
their computer. 

Edit Filters - Opens the Filter Editor in which you can exclude certain files, file types, or folders 
from being replicated.  

Server Move - If the location of the Server has changed or if its port number has changed, click 
Server Move to relocate the Server for this Job. 
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Manage Passwords Tab 

Users only need an account if they use the Web interface, administer the Server or Agent, or manage 
Jobs. Users can continue to use Windows Explorer on their local computer for file management, and 
open and save files within programs, as usual. When a CDP/slave Job is accessed on a computer 
running the Server, you cannot manage passwords. You can manage passwords on any other Agent 
connected to the Job.  

Each Job has its own set of usernames and passwords that are independent of logins for other Jobs. For 
example, if Job A has username management, and Job B has username management, the two logins are 
still in no way related and may have different passwords or access levels.  

To view the Manage Passwords tab 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

2. Click the Manage Passwords tab. 

The Manage Passwords tab displays the list of usernames and passwords that can be used to 
link to a Job.  

 

If the Job is linked using the owner username and password, the list can be viewed and edited. 
The Manage Passwords tab does not indicate if the Job was created using credentials other 
than owner. Owner usernames and passwords can be created or modified only at an Agent 
where the Job has been mounted with owner credentials or at the Server from the Server's Web 
interface. There is only one owner username and password per Job.  

For details of user administration, refer to Creating, Modifying, and Deleting Users. 
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Creating, Modifying, and Deleting Users 

You create, modify, and delete users on the Manage Passwords tab of the Job Properties and Options 
dialog box.  

 

When a CDP/slave Job is accessed on a computer running the Server, you cannot manage 
passwords. You can manage passwords on any other Agent connected to the Job. 

You can define a username with one of the following permissions:  

 Owner - Complete access to and control of the Job 

 Full - Read and write access to the Job, but does not allow password changes 

 Read-only - Only has read access to the Job. 

Although it is often not needed, a multi-user setup may simplify your organizational structure. For 
instance, management may only need read access to one Job, but they might want read-write access to 
another Job. 

 

Each Job has its own set of usernames and passwords that are independent of logins for other Jobs. 
For example, if Job A has username management, and Job B has username management, the two 
logins are still in no way related and may have different passwords or access levels.  

To view or edit a Job's usernames 

 In the Server and Job name list, click the down arrow and select the Job. The usernames that 
have access to the Job appear on the Manage Passwords tab. 

 

To add a user 

1. On a computer on which the Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options. The Job Properties and Options dialog box appears. 

2. Click the Manage Passwords tab. 

 

3. In the User name box, type a username. 
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4. In the Password box, type a password. 

 

You can use any username and password, and users can easily change their password later 
at their Agent's Change Options tab. 

5. Full access is automatically assigned. Clear the Full Access check box if the user is to have 
read-only access. 

6. Click Add, then click Save.  

 

Whenever you make changes to the list, you must click Save to save these changes on the 
Server. If you do not, any changes are discarded. 

 

To modify a username or password 

 

To modify the owner's username and password, you must be logged in as the owner.  

1. Click the row with the user information. The information appears in the boxes to the right of Full 
Access. 
 

 

2. Edit the username or password, click Modify, then click Save. 

 

Whenever you make changes to the list, you must click Save to save these changes on the Server. 
If you do not, any changes are discarded. 

 

To delete a username 

 Click the row with the user information you want to delete, click Remove, then click Save. 

 

If you modify or delete a username that is in use by an Agent to link to a Job, the Agent disconnects. 
After two minutes, the Agent tries to re-connect, and prompts for a valid username and password.  
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To invite a user to share this Job and become part of the workgroup 

1. Click the row with the user information, then click Invite. The Send an Invitation dialog box 
appears. 

 

2. Click anywhere in the message, then click Copy. 

3. Create an email message, paste the copied text, and send the message.  

4. When the user clicks the link or copies and pastes the URL from the message into their Web 
browser, a message appears with instructions on how to mount the Job. 
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Using FastMerge 

The FastMerge tool allows you to use an alternate copy of a Job's data to initially populate a linked folder. 
The topics below describe how to configure and use FastMerge. See also Turning Off Thumbnail Caching 
for important information about unnecessarily replicating thumbs.db files. 

Getting Started with FastMerge 

When an Agent links to a Job for the first time, the Agent must perform an initial replication of the Job's 
data by downloading all of the Job's files from the Server. It will put the files in place during the linking 
process and start streaming their contents to the Job in the background, so the files are available to 
users. If someone opens a file whose information has not yet downloaded, it will focus the download 
bandwidth to stream that file as fast as possible, and then resume background downloads for the rest of 
the data. 

Still, this initial replication can take a lot of bandwidth if the Job is large, and access to large files can be 
slow if they have to be streamed as they are opened. The FastMerge tool allows you to use an alternate 
copy of the Job's data to populate the linked folder initially. For instance, it may be convenient to have the 
original Agent write it to a DVD-R or USB drive, formatted as NTFS, and ship that to the other Agents to 
use for their original replication. 

 

The disk that the files are transferred with must be formatted as NTFS. If you format the disk with 
FAT32, FastMerge will not transfer the files properly, since the file system time stamp is local time 
instead of Greenwich Mean Time (GMT). 

You should disable thumbnail caching on Windows workstations in a WAFS/CDP environment.  

Of course, if the Job has been changed between the creation of the alternate source and the FastMerge 
replication, it will recognize those changes and update either the new Agent's local copy or the Job's 
version, depending on the rules described below. In other words, either the Agent's version will override 
the Job's, or the Job's will override the Agent's; either way, every computer linked to the Job will remain 
synchronized. 

Frequently Asked Questions 

What is FastMerge? FastMerge acts as an accelerator to the procedure of adding a computer to 
an existing Job. You begin by following the standard procedure of installing 
an Agent at each site and then use FastMerge to complete the initial data 
replication using a local copy of the data. 

FastMerge is effective when the content of the local folder is the same or 
almost the same as the content of the corresponding Job.  

During the time that FastMerge is running, you should make sure that the 
local copy of the data is not modified; otherwise, the FastMerge may result 
with incorrect initial replication. 
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Why FastMerge? The initial mirror of data from one location might take a long time in cases 
of a large amount of data, especially if combined with a high latency and/or 
a limited bandwidth network.  

If the data is already available at the remote sites, or can be made available 
on the remote computers, you can use that data locally to perform an initial 
population instead of downloading it over the WAN using 
WAFS. FastMerge is a utility that reads the existing data from a local 
location and inserts it into the Agent. It assures coherency with the data that 
may already be in the remote Agents, and sets up the metadata for the 
ongoing mirroring that takes place after this initial merge is done. 

The standard way to move data is to install an Agent on a Windows Server 
at all locations and then connect each one to existing Jobs. The files 
appear in seconds on the other computers - immediately accessible and 
useable even if they are still transferring over the network. Any selected file 
is streamed in immediately. FastMerge replaces the transfer over the 
network by copying local files. 

When can I use 
FastMerge? 

You should consider using FastMerge in extreme cases of very large 
amounts of data, combined with long distance, which may cause the initial 
mirroring (via WAFS) to take a long time. FastMerge can be used for data 
that is already mirrored on the site, or you can transfer the data (media, 
FTP). 

FastMerge can be used in the following configurations: 

 Any Agent of a WAFS Job 

 Agent of a file backup Job that is not co-located with the server. 

If you have a large amount of data that you plan to use with WAFS, 
FastMerge is a utility that expedites the process of getting the data for the 
initial mirror into WAFS at all the remote locations. If the data is already at 
the remote site or you have an expedited method of transfer, WAFS will 
merge the data that is already local, instead of downloading all the files 
over the network. The data at each site does not have to be exact. 
FastMerge will determine and merge the differences.  

How long does 
FastMerge take? 

FastMerge execution time is the same order of magnitude as the time that it 
would take to do a local copy of the dataset (i.e., copy the folder to another 
folder on the same computer).   

What is the definition 
of "the files are the 
same"? 

FastMerge compares the time stamp and size.  

What if the time 
stamp is a little off, 
because the two 
computers are not in 
sync? 

FastMerge has a window in time in which it considers the time stamp to be 
the same. By default, this window is 60 seconds. The default can be 
changed by selecting Advanced > Managing Time Differences. 
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Can I see ahead of 
time which files 
FastMerge is going 
to mirror (i.e., 
upload)? 

Yes. After Scan and Check is complete, you can click Show Audit File to 
view the FastMerge audit file, which contains a full list of what FastMerge is 
going to do, and why. You can share this file with users. The file is located 
in C:\AVCStuff\FastMerge_logs\. 

Can I see 
retroactively which 
files FastMerge 
decided to mirror 
and why? 

Yes, the audit file is kept, and can be viewed at 
C:\AVCStuff\FastMerge_logs\. There is a folder for each Job.  

Running FastMerge 

When adding a remote computer to an existing Job (already linked at another Agent), you are asked to 
select an empty folder, and this folder is linked and populated with the Job's data. When using 
FastMerge, follow the same procedure. That is, provide an empty folder at the remote site, and let the 
Agent finish the initialization of the Agent's linking. Then, stop the Agent and use FastMerge. 

FastMerge uses a copy of the data at this same location, and merges it into the linked folder. The local 
data does not have to be identical to the Job's data, but the assumption is that it is very similar. For each 
file, FastMerge checks whether the local data can be used. This check is based on the file's time stamp 
and file size. In cases of differences, FastMerge decides which file becomes the master based on a 
simple set of rules. In case of conflicts, you will be notified and asked to remove the conflicts, typically by 
deleting the inconsistent local file.  

You should already be familiar with creating Jobs and linking to Jobs before you use FastMerge.  

 

If you are using CDP, you can only use FastMerge to replicate data on an Agent that is not 
colocated with the Server. 

You should disable thumbnail caching on Windows workstations in a WAFS/CDP environment. 

 The Agent must be stopped prior to running FastMerge. 

 The local folder containing the data is not the folder that will be linked; the data will be transferred 
from the local folder into the empty folder you chose to link to the Agent (which is also local). 

 By default, FastMerge copies the data from the local location into the linked folder. Optionally, 
FastMerge can be configured to perform an in-place merge, in which data will be moved instead 
of copied. 

On the computer on which the Job was created 

1. Install an Agent, create a new Job, and make sure that the Job data completes uploading.  

2. Click the Agent icon , then click Job Properties and Options.  

3. Click the Job Info tab, then click Count Now. 
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A message box appears that displays the count statistics. 

4. Click OK. 

5. Click the General File Info tab.  

 

6. Wait until the Local data that needs to be uploaded to the server progress bar is dimmed, 
indicating that all the files have been uploaded.  

7. (Optional) Click the Change Options tab.  
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8. Set the Bandwidth Throttling upload speed to VHigh to expedite the upload. If you do so, do 
not forget to restore the setting to Auto after all the files are uploaded. 

On each remote computer to which you want to connect the Job 

1. Prepare the copy of the data:  

 If the data is in a local folder then you are all set.  

 If you transferred the data on other media, then connect the media to your local 
computer. 

2. Click the Agent icon , then click Add this machine to an existing Job and follow the wizard 
instructions. The folder you select will be the permanent folder that is used at this site. 

3. When asked, provide an empty folder with the permanent name. This will be the permanent 
mirrored folder that is connected to the Job. 

4. Double click the Agent icon. The Agent Job Properties and Options dialog box appears. 
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5. Click the Job Info tab, then click Count Now and wait for it to complete (a message box 
appears). You must wait for count now to complete before beginning FastMerge. 

6. Close the Agent Job Properties and Options dialog box. 

7. Stop the Agent.  

8. Run FastMerge.  

Running FastMerge 

1. Open FastMerge (Start > Programs > Availl > FastMerge).  

 

2. (Step 1) In the Job Name box, click the down arrow to select the Job. The path of the empty local 
folder that you gave when you added this computer to an existing Job appears next to Linked 
Folder.  

3. (Step 2) In the Local Folder box, click Browse to specify the location of the local data; this is the 
data that will be inserted at this site to avoid resending it. 
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4. (Step 3) Click Scan and Check. FastMerge scans the local folder and checks for differences and 
conflicts with the Job's data. If there are conflicts, error messages appear. You cannot continue 
until the conflicts are addressed. 

After the scan is completed, the results appear in the Scan and Check Results area. The results 
display the number of files and folders and their size. 

5. Click Scan and Check again to confirm. 

 To view a text file of the scan, click Show Audit File. You can also view the audit log in 
C:\AVCStuff\FastMerge_logs\<Job_name>. 

 To view a text file of the conflicts reported, click Show Conflict File. You can also view 
the conflict log in C:\AVCStuff\FastMerge_logs\<Job_name>. 

Refer to Log Files for more information about the Audit and Conflict logs. 

6. Resolve conflicts, if any: 

 Click Advanced to manage differences and conflicts between the local directory and the 
Job's data. 

 Delete any file(s) that create the conflict from the local directory (if it is R/W). 

 (Also refer to Resolving Conflicts between a Job and a Merged Folder.) 

7. (Step 4) Click Merge Now. FastMerge copies the files from the local folder into the folder that is 
mirrored by this Job. 

8. Restart the Agent. 

 

 

Resolving Conflicts between a Job and a Merged Folder  

Because users may have accessed the Job between the time that the snapshot was created and the time 
that the Agent on the new computer takes its inventory, FastMerge may find conflicts. Some files or 
folders may be present in the Job but not in the snapshot or vice-versa, or file contents may have been 
changed. 

FastMerge compares files by looking at their sizes and the dates they were last modified. Depending on 
the nature of the conflict, either the local (snapshot) copy or the Job's copy is favored or you must resolve 
the conflict manually. See FastMerge's Rules for a table that describes the rules that FastMerge is using 
for each file in the local directory when comparing it to the Job's data. 

If there is a file conflict, you can either set the action that will be taken for all conflicts of this nature or 
delete the file from the snapshot. If you chose to delete the file, the Job's version of the file will be chosen. 
Once you have solved all conflicts, click Scan and Check again. 

If a file has the same time stamp on the local copy and Job, but different file size, the local copy is most 
likely corrupted. Check to see if it is; if not, delete the file from the snapshot if you want to keep the Job's 
version or click Local for this type of conflict if you want to keep the snapshot's version. See Advanced 
FastMerge Features for more information. 

 

You should disable thumbnail caching on Windows workstations.  

FastMerge's Rules 

Ideally, the local data is the same as the Job's data, and FastMerge simply copies (or moves) the data 
from the local temporary folder into the folder that is linked to the Job. FastMerge checks the Local folder 
against the Job's data, and has a set of simple rules to decide whether to use the local file ("Local") or the 
Job's file ("Job").  
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FastMerge can make the following decisions: 

 Local - FastMerge will mark this file for "copy (or move)" from the local location to the Job's linked 
folder. 

 Job - FastMerge will mark this file for "do nothing"; when the Agent starts again this file will be 
mirrored (if exists on the Job) as part of the normal functionality. 

 Conflict - FastMerge will write the information into the Conflicts file, and the "Conflicts" count is 
incremented. 

It is also possible to modify the rules so that a certain condition is flagged as a Conflict. You can then 
decide how to handle it. 

The table below describes the rules that FastMerge is using for each file in the local directory when 
comparing it to the Job's data: 

Condition Action-
Default 

Action-
Options 

Cause - example 

Same: Time Stamp? 

Local and Job same 

Local - The ideal case 

Newer: Time Stamp? 

Local is Later than Job's 

Local -  Agent was offline when the files were updated and 
local data captured 

New: File Exist? 

File exists on Local, but and 
not on Job 

Local  Job Conflict File was deleted since Local was captured 
      or 
Agent was off line when the file was created and Local 
was captured 

Older: Time Stamp? 

Local is Older than Job's 

Job  - File was updated since local data was captured 

Inconsistent:  

Time same, size different 

Conflict Local or Job  Something happened to the files; user needs to decide 
what to do with files 

  

 

If the file does not exist in the local location and does exist in the Job, FastMerge will not detect it 
since its scan is done on the local folder. When the Agent starts, this file will be mirrored.  

 

 

FastMerge Log Files 

FastMerge audit and conflict log files are created when you perform a Scan and Check and are stored in 
C:\AVCStuff\FastMerge_logs\<Job_name>.  

The information in the audit file is the superset of the information in the conflicts file. 

The log files created are: 

 AVFL_YYMMDD_hhmm_Conflicts.txt - The conflicts file that contains conflicts (if any) that 
require your resolution before the Link step. 

 AVFL_YYMMDD_hhmm_Audit.txt - The audit file that, in addition to the conflicts (if any), 
contains a list of files in the Local folder that were not the same as in the Job, and the Action that 
FastMerge decided to take.  

By default, the audit files include files that have a potential conflict. You can customize the audit to include 
more, in the Advanced area of the FastMerge dialog box.  
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To specify the information to include in the log 

 In the Customizing the Audit File area, select the check boxes for the information that you want 
to include in the audit log. New and Inconsistent are selected by default. 

Refer to FastMerge's Rules for information about Managing Differences and Conflicts and Advanced 
FastMerge Features for information about the other settings in the Advanced area. 

 

 

Advanced FastMerge Features 

You can manage conflicts and customize the Audit file in the Advanced panel of FastMerge. 
 

 

To open the Advanced panel 

1. Open FastMerge (Start > Programs > Availl > FastMerge).  

2. In the Job Name box, click the down arrow to select the Job. The path of the empty local folder 
that you gave when you added this computer to an existing Job appears next to Linked Folder.  

3. Click Advanced. When you click Advanced, the FastMerge dialog box expands to display the 
following options:  

o Restore Factory Settings - resets all advanced settings back to their original defaults 

o Stop on first error - If there are any errors during the merging process (such as not 
being able to write over a read-only file), FastMerge will stop. If this check box is cleared, 
when the merge is complete, you are notified of the last error and asked if you want to 
look at the log file to see any others that might have occurred. 

o In-Place merge - By default, FastMerge copies data from the snapshot to the local folder 
that is being replicated. If this box is selected, FastMerge will move the files instead. 
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o Merging time differences - To allow for computer clocks not being perfectly 
synchronized, FastMerge treats two timestamps within <n> seconds of each other as 
being the same time. In most cases, 60 seconds is sufficient; however, it is possible for 
this time difference to create a conflict. For example, if a file is changed, a snapshot 
taken, and the file on the Job (but not in the Snapshot directory) is changed again, all 
within the time span specified, the Job's file and the Snapshot's file will have different 
sizes but the "same" time stamp, creating a conflict. For more information, see Resolving 
Conflicts between a Job and a Merged Folder. 

o Managing Differences and Conflicts - Allows you to specify the action to take for two of 
the situations in which the Job and snapshot differ. If you want the local copy used for 
some files but the Job's copy used for other files, you can do one of the following: 

 Click local and then delete from the Snapshot all of the files for which you want 
to use the Job's copy. 

 Click Job to use the Job's version for all files. After the merge is complete and 
the Agent started again, copy the files you want to keep from the Snapshot. 

o Customizing the Audit File - The Audit file (which you can see by clicking Show Audit 
file in the top part of the dialog box) shows which actions FastMerge will take. You can 
select which situations will be logged in this file. (This has no affect on the actions 
FastMerge will take.) This file is also available at 
C:\AVCStuff\FastMerge_logs\JobName\. Refer to FastMerge Log Files for more 
information. 
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Backup and Recovery 

The topics below describe how to backup and recover files and folders. 

Automatic Recovery and Snapshots 

The Server supports automatic recovery operations, including the ability to take snapshots of data. 
Snapshots and auto-recovery operations are defined for each Job separately.  

In addition to the Server's capability of keeping the most current version of all replicating files and past 
versions, including deleted files, the Server's snapshot option allows you to take periodic snapshots of 
your Job's data that capture the state of the data at a specified point in time. You can manually take a 
snapshot at any time. For every Job, up to eight snapshots can be taken daily at any Agent location. A 
snapshot includes the latest copy of all the files for the chosen Job at that instant. Past versions and 
deleted files are not included in snapshots. There is no impact on the files at the time of the snapshot at 
Agents; users can access files normally, and you do not need to schedule downtime. 

For more information on configuring Snapshots, see Snapshots and Failover. 

Failover and auto-recovery mechanisms are offered for CDP Jobs to handle cases when a master 
(source) Agent disconnects from its Server. Note that the Auto Failover and Alarm options are not used 
for WAFS Jobs. 

 

 

Restoring a File in the Job Administration Web Interface 

If a user has accidentally deleted or modified a file, you can restore a previous version of the file via the 
Job Administration Web interface. 

Users can also access this interface by going to http://server:port (":port" is optional if the port is set to the 
default of 80), clicking Login to Web interface, then typing the Job's name and appropriate username 
and password (see Manage Passwords Tab).  

Clicking View and Retrieve in the Job Properties and Options dialog box automatically logs in the user 
with the Agent's credentials. 

To restore a file 

1. Do one of the following: 

 Click the Server icon  in the host server's system tray. The Server Console dialog box 
appears. Click Server > Manage Jobs. 

 Open a Web browser. Browse to the Server's URL. For example, 
http://server8.yourCompany.com/admin.  

The Job Administration interface appears and displays the Job List. 
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2. In the Job Name column, click the Job's name. All of the files currently in the Job are listed in the 
Job's File Retrieval list. 

 

 To make a previous version of a file the current version 

o Click the filename of the file you want to restore. The View and Retrieval page 
for that file displays all available past versions. You can then Download any 
version of the file or make a specific past version of the file the current version by 
clicking Make Current.  

 

 To restore a previously deleted file 

a. Click Deleted Items. The File Retrieval page for deleted items appears. 

 

b. Next to the file you want to restore, click Restore. 

3. When you have finished restoring, click Done - Go Back until you are returned to the Job List. 
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Restoring the Server 

The Server keeps past versions stored in the Vault, the working space that stores a Job's current file 
versions, past versions, deleted files, and log files. The default location of the Vault is C:\AD. 

If you restore and replace the Server's Vault, it will set all of your Agents' data back to the date and time 
that you performed the backup of the Vault. Therefore, if you want only certain files or folders, it is best to 
either restore the Vault or a specific Job folder to some other location, locate the files or directories that 
you want to restore, and copy them into an Agent.  

If the Server's hard drive fails 

1. Make a copy of the data at one of your systems running an Agent. You can make an entire copy 
of the replicating directory or do a Windows search and copy only the files that changed since 
your last server backup date (since the date of the Vault that you plan to restore to the Server). 

2. Restore the previous backup Vault to the Server and restart the Server. The Agents will 
reconnect and their replicated data will revert to the date and time that the Vault was backed up. 

3. On the system where you made a copy of the data in step 1, copy the desired files to the 
replicating directory. It will then send only the file differences out to the other Agents, and they will 
be made current. 

  

Restoring a Single directory 

1. Navigate into the backup copy of your Vault (or running Vault) and into the desired Job directory.  

2. Navigate into the "P" folder, which contains the current copies of the "physical" files and folders.  

3. Locate the directory that you need, and copy it into one Agent. It will replicate the file differences 
out to all other Agents. 

  

The Agent 

If you restore from a tape made at an Agent, do not restore the mount points. Do not restore over 
existing AVMO, AVMF.  

 In BrightStor, on the screen on mount points: select the data one level below the junction point 
instead of the junction point. 

 In Veritas: In Settings > Advanced > Junction points, click Preserve existing junction points 
and restore files and directories from backup media. 

  

ShadowCopy 

ShadowCopy is not supported, because it does not support junction points. ShadowCopy has to be told to 
traverse mount points and junction points.  

If you must use ShadowCopy, use the following workaround: 

1. Create a read-only share folder on the /AVMF/xxxx/P folder which is the junction point linked to. 

2. If you have multiple jobs, you might create a read-only shared folder on the AVMF folder instead 
of creating each share folder on each P folder. 
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CDP Recovery and Failover (Redundant Servers) 

In a Continuous Data Protection (CDP) deployment, there is always one (and only one) master Agent on 
which files can change. This master Agent is typically connected at all times to the Server that keeps the 
data continuously backed up, but you should prepare for an unanticipated disconnection, in case your 
backup computer should go down or lose connection for some reason. 

Through the Snapshots and Failover dialog box in the Server Console, you can configure the software to 
detect automatically when a master is disconnected unexpectedly, and take steps to redirect end-users to 
a new file server. This new file server is updated automatically with the original master's most recent data, 
and will act as a temporary master. 

 

A CDP deployment can have as many slave Agents as needed, each with its own local copy of the 
Job’s files. Additionally, each is able to become a master Agent at any time. This process occurs 
automatically; the switch does not need any manual intervention. 

 

Configuring CDP Failover 

 

All failover options described below are configured on a per-Job basis. Select the Job for which you 
want to set failover options from the pull-down menu at the top of the dialog box. If you want all Jobs 
protected by failover recovery, you must set each individually.  

To set up a file CDP failover system 

You should configure a second slave Agent at your backup site. It will be kept updated with a read-only 
copy of the Job's data; if your master Agent is disconnected, you can then use this second Agent as a 
temporary master so that users can continue to read and write files as usual. When the original Agent 
comes back online, it will replicate any changes that were made on the temporary master, and you can 
then redesignate it as master. To automate this process, see Automating CDP failover.  

  

Setting up the second, slave Agent 

If you have already deployed an Agent on the computer on which the slave will run, in the system tray, 
click the Agent icon , click Add this computer to an existing backup Job, then follow the directions. If 
you have not deployed an Agent on the computer on which the slave will run, download the Agent 
installer, click Next until you reach the Deploy Backup Agent option, then follow the wizard's 
instructions.  

It is common to use a cohosted topology for this. That is, the second, slave Agent is on the same 
computer as the backup Server. The slave Agent does not have to be a cohosted with the Server, but if it 
is not, the Server will have to access the slave Agent remotely in order to automatically become the new 
master. 

 

If you plan to set up a cohosted slave Agent, when you first connect it to the Job, you must specify 
the server name using its IP address instead of its computer name. If you specify the Server using 
the computer name, you will not be able to switch the Agent's mode. 

See Example: Setting up CDP Failover for an example configuration. 
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Automating CDP Failover 

In the Server Console, click Server > Manage Snapshots and Failover. 

 

In the Automatic failover section, define an auto-recovery failover mechanism that will take effect when 
the Server detects that the connection with the Job is unexpectedly broken (such as due to a 
communication problem, malfunction at the master Agent's computer, or other reasons; it will not be 
executed when the Agent is shut down normally). If you select the Copy data into check box, you can 
also specify a directory into which a snapshot of the Job's current data will be written.  

If you enable the alarm and auto-recovery option for a given Job, the following occurs when 
communication with the master Agent is broken 

1. The Server waits the time specified in the seconds box. If communication is resumed with the 
Master during that time, the auto-failover process is aborted. 

2. If the Copy data into check box is selected, the Server copies all the data for this Job's data into 
the folder specified, which is typically on another computer. Note that the specified folder must 
already exist, and should be empty.   

3. Next, the Server starts the script specified in the Then run this script box. You must provide this 
script or leave this field blank. This script is passed three parameters: 

 Job's name 

 pathname of the folder in the Vault that contains the Job's data 

 path to the program that can be used for "setmode," as explained below. 

4. Typically, this script would alarm IT, redirect users and processes, and turn the slave Agent into 
the master. The script can be any executable, such as an .exe file, .bat file or Perl script.  
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5. The data on any slave Agent is available in read-only mode. To get full read-write access, a slave 
needs to change mode and become a master. The script you supply can do this automatically by 
using the "setmode" argument with the Agent executable, the path to which is supplied as the 
third argument to the "run this script field" script. The format of this call is: 

AvlAgt.exe -setmode MODE "\\server\Job" 

MODE is the mode the Agent changes to, and can be one of the following: 

 w - WAFS 

 um - unidirectional (CDP) master 

 us - unidirectional slave 

The server name is specified without the port. For example, if the server is 192.168.0.1 and the 
Job's name is Bills, this entry should be "\\192.168.0.1\Bills" (include the double-quotes). 

Unless you change its setting, when the original server comes back online it will still be in master 
mode. If this happens, it and the new temporary master will "ping-pong," each rewriting its 
versions of its local folder's contents to the server. To avoid this, you should set the original 
master to slave mode before it comes back online. When the connection is reestablished, the 
original master, now in slave mode, will then start replicating whatever changes were made to 
files on the temporary master. When the replication completes, you can manually change the 
temporary master back into a slave and then the original master back to master mode.  

You can have the original Agent master change its mode automatically by creating a script 
srv_Disconnect.bat in the same folder as the Agent executable, which is by default 
C:\AVCStuff. This script will be run whenever the Agent disconnects from any of its Servers for 
any reason (including exiting normally, as when you shut down the Agent server).  

srv_Disconnect.bat is passed two arguments: 

 the name of the server that the Agent has disconnected from 

 the reason for the disconnection, which may be: 

o exit - Agent exited normally) 

o scheduledDisconnect - Agent is on a schedule and disconnected accordingly) 

o disconnect - generic error; Agent did not expect to be disconnected) 

  

 

 

Example: Setting up CDP Failover 

Suppose you have a CDP Job called "Bills" with its master on computer SRC-LA and with a Server and 
slave Agent on computer BCKUP-SD, with an IP address of 192.168.0.1.  

The following are complete setup instructions 

1. Deploy the Server on BCKUP-SD. 

2. Deploy a master Agent on SRC-LA and create a file backup Job Bills linked to BCKUP-SD. Your 
data is now continuously backed up to BCKUP-SD. SRC-LA is running an Agent in master mode. 

3. Deploy a backup Agent on BCKUP-SD and link to the Job using the Add this computer to an 
existing backup Job. Make sure the server is specified using its IP address (in this example, 
192.168.0.1) and not the computer name. You now have a slave mode Agent cohosted with the 
Server on BCKUP-SD and connected to the Job Bills. 
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4. On the Server computer BCKUP-SD, create a file C:\Availl_disconnected.bat with the following 
contents: 

REM We are passed three variables: 

REM %1 is this Job's name 

REM %2 is the location of this Job's data in the Vault 

REM %3 is the path for the Agent's executable, which we need in 

order to set its mode 

REM set this computer's cohosted Agent to master mode 

REM change this IP to the Availl Server's IP. 

%3 -setmode um "\\192.168.0.1\%1" 

REM log this event 

set logFile="C:\AD\_Logs\disconnect-log.txt" 

echo Master server disconnected at %DATE% %TIME% >> %logFile% 

echo Job: %1 >> %logFile% 

echo Vault: %2 >> %logFile% 

echo AvlAgt: %3 >> %logFile% 

echo. >> %logFile% 

REM as an easy way of popping up an alert, launch notepad with a 

defined message 

set messageFile="C:\AD\_Logs\message.txt" 

echo The master has just disconnected! > %messageFile% 

echo Setting cohosted Agent on this computer from Slave to Master. 

>> %messageFile% 

echo at %TIME% on %DATE%. >> %messageFile% 

notepad %messageFile% 

This sample switches the slave Agent that is cohosted on the server to master mode, makes a 
log of the switch and creates and opens a text file with a message to alert the administrator at the 
backup computer. Your script could contain e-mail notifications, DFS commands, or other actions 
to automate redirecting other computers to the new master. 

5. On the master computer SRC-LA, create a file C:\AVCStuff\srv_Disconnect.bat with the following 
contents:  

REM We are passed two variables: 

REM %1 is the name of the server we're disconnected from 

REM %2 is the reason why we were disconnected 

REM set this Agent to slave mode 

REM change this Job name to your Job's name 

C:\\AVCStuff\AvlAgt.exe -setmode us "\\192.168.0.1\Bills" 

REM log this event 

set logFile="C:\AVCStuff\disconnect-log.txt" 

echo Disconnected from server at %DATE% %TIME% >> %logFile% 

echo server: %1 >> %logFile% 

echo reason: %2 >> %logFile% 

echo. >> %logFile% 

REM as an easy way of popping up an alert, launch notepad with a 

defined message 

set messageFile="C:\AVCStuff\message.txt" 

echo We have just disconnected! > %messageFile% 

echo Setting Agent on this computer from Master to Slave. >> 

%messageFile% 

echo at %TIME% on %DATE%. >> %messageFile% 

notepad %messageFile% 

6. At the backup site, click the Server's icon in the taskbar to open the Server Console. Click 
Server > Manage Snapshots and Failover. 
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7. Click the Job Bills in the Job list.  

8. Select the Enable auto-recovery after master Agent disconnect check box, and be sure that 
the Copy data into check box is cleared.  

9. In the text field next to Then run this script, type: 

C:\Availl_disconnected.bat 

10. Specify the appropriate number of seconds the master must be disconnected before the script is 
run; 120 is a good default. (You may want to set this to something very short initially, such as 5 
seconds, so that testing the setup is quicker. Once you test the setup and see that it works, you 
can change this back to a more reasonable time.) 

Your failover setup is now complete. Check both the master and slave Agents to make sure they are 
configured correctly by opening their Job Properties and Options dialog box and looking at the Change 
Options tab. They should both be set to CDP - continuous backup, and the cohosted Agent should be 
in slave mode, while the other is in master. You can test this by making a change to the linked folder on 
the master system and making sure that it is replicated at the cohosted Server/Agent system.  
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To test the failover 

You must simulate an unexpected disconnect; just shutting down the master Agent service will not trigger 
failover. Two easy options for doing this are to disconnect the master Agent's network connection or to 
change the Server computer's firewall to block the Agent (e.g. blocking all activity on the Job's port, which 
is 80 by default).  

Once the master has disconnected, wait the number of seconds specified in the Snapshots and Failure 
dialog box. A Notepad window should pop up on the server computer saying that its cohosted Agent has 
switched to master mode; go to its Job Properties and Options dialog box to confirm that this is the 
case.  

Now reconnect the Agent and follow the instructions above to reestablish the original master and slave 
setup. 

Using Microsoft DFS for Failover 

Microsoft DFS can provide a simple and fast automatic failover. The failover of any user or application to 
any replica that you specify will occur if the primary source becomes unavailable.  

Distributed File System (DFS) allows you to group shared folders located on different servers and allow 
access to users as a virtual tree of folders known as a namespace. Users and IT do not have to "hunt" the 
network--the files all appear to be in one location. DFS does this by redirecting users to the share where 
the data is located when you access a given unified path. All file server access first goes through the 
Active Directory-integrated DFS root.  

DFS‟s unified namespace for all shares and folders can be used to redirect all users‟ access to files to an 
alternative location, if the primary local server becomes unavailable. DFS does so by redirecting all the 
client/user file requests to a secondary backup server (running another Agent) where the data is also 
located, when this client accesses that same given DFS path. DFS initially will go to the local server, but if 
it does not respond, it will redirect the request to the backup server. Remember, all file server access 
goes through the Active Directory integrated DFS root. So as long as any Active Directory is available, 
access to the files continues. DFS is designed to provide:  

 A unified namespace that makes it easy for users to find files which are actually distributed 
across multiple physical locations.  

 Abstraction layer. Many file paths are hard coded in user configurations (such as mapped drives), 
which makes it difficult to have users redirect to other servers easily. With DFS, you can keep the 
namespace constant, while the data is actually on another server.  

 Failover. Gives networked applications and shares high availability since DFS in Windows 2000 
and 2003 supports automatic failover of DFS root folders to a second mirror.  

The DFS Root  

All file server access is made through a hierarchy exposed directory string such as \\Company\project. If 
you want to access the networked file system, open Windows Explorer and type the path in the Address 
field. The figure below illustrates two namespaces as users would see them. Notice how the address 
format differs: one begins with a server name, Software, and the other begins with a domain name, 
Contoso.com. These differences illustrate the two types of roots: stand-alone roots, which begin with a 
server name, and domain-based roots, which begin with a domain name. Valid formats for domain names 
include \\NetBIOSDomainName\RootName and \\DNSDomainName\RootName. Use Domain name.  
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A root can have one or more root targets. A root target, also known as a root server, is a physical server 
that hosts a namespace. A domain-based root can have multiple root servers to provide redundancy and 
high availability, whereas a stand-alone root can only have one root server. Root servers are transparent 
to users, who see only a single folder, whereas administrators can view the physical root servers by using 
the DFS snap-in, the DFScmd.exe command-line tool, or the DFSutil.exe command-line tool (part of the 
Windows Support Tools). The following figure illustrates roots and root servers.  

  

 

What you will see are DFS links. These are references to real file server shares where the data is actually 
stored. These in turn are ordinary file shares. You can find out where your files are currently located by 
selecting an object and open its property page. If it is accessed through DFS, you will have a DFS tab 
that shows you alternative access paths.  

Active Directory resiliency: \\Company\project would be an Active Directory integrated DFS root share, 
which makes it possible to keep the links themselves replicated (by Active Directory) for availability. If one 
of the servers providing the DFS root share goes down, the clients automatically use another copy of the 
DFS root on some other Active Directory server and keeps on using DFS and data on other servers.  

Understanding the Protocol:  The underlying DFS mechanism is simple. The Windows client (user) and 
Windows server each have special agents installed on them that allow the server to signal, and the client 
to understand, instructions to redirect a network connection to a different server. A DFS share is 
essentially a standard network share with additional functionality. This functionality does not come into 
play until the client accesses a subdirectory that is actually a mapped shared folder; until then it looks and 
acts just like any other share. However, specifics of the DFS protocol begin to appear the moment a client 
requests a directory that is actually a mapped shared folder.  

To configure Failover Setup of DFS  

1. Set up the system, i.e., install Agents, create Jobs, select and mirror data among your sites.  

2. Create a DFS root. (Do not link Jobs to the root.) DFS roots must be created by you, domain 
based, on partitions generated with Windows 2000 or 2003. You will have multiple targets in the 
root target referral list.  

3. Add DFS links. (These link folders can be linked to your Jobs.) You can add DFS links under the 
DFS roots to reference (referral) any root or link in the DFS tree.  

4. Specify replicas or link targets for a DFS root or link. Multiple DFS Targets.  

Your setup resulted in mirror copies on two or more Windows servers, which update as the files change. 
These mirrors at your Agents are accessible by Active Directory and can therefore be link targets. All 
copies are referred to as replicas, including the local version on your primary. DFS-aware clients will 
automatically select the nearest replica based on the site topology information. They only redirect to the 
alternate replica if the original is unavailable.  
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DFS can sometimes see a directory as "not exactly" NTFS. The error message may refer to "parse 
point." If so, type in the root directory, a layer above the actual folder. In other words, have the 
replica name in the root be one level above the folder that is actually being replicated. For instance, 
if the replicating folder is C:/USA/Texas/Dallas, then put C:/USA/Texas as the replica. Or add a new 
level C:/USA/Texas/DfsReplica/Dallas and make DFSReplica the replica in the root. At the other 
sites (the backup site), add this same level (DFSReplica), but share out the correct folder (Dallas), 
and just ignore this new level.  

Some systems require a different set of steps: After you create the DFS root, you might then need to 
configure DFS Replication in a full mesh environment. Setup the rights to allow write to the share. 
Then create a new folder, and after that folder has been created in the other computers too, stop 
replication in DFS. Then setup the Agents to replicate anything in this folder.  

Refer to Microsoft Technet to help configure your DFS shares http://technet.microsoft.com/en-
us/library/bb727150.aspx  

 

In Windows 2000, if there are no available root targets in the client's site, the client will randomly 
connect to another DFS root target in any site. With Windows 2003, if a root target is not available in 
the client's site, it will randomly look for a target in the next closest site, and so on. This feature, 
called Closest Site Selection automatically connects the client to the closest possible DFS target.  

For Closest Site Selection to work on link targets, Intersite Topology Generator (ISTG) must be 
running on Windows 2003. All domain controllers in a domain must be running Windows 2003 for 
Closest Site Selection to work on domain root targets. 

 

What Happens During Failover  

In DFS failover, clients attempt to access another target in a referral after one of the targets fails to 
respond or is no longer part of the namespace. Clients must access a domain-based namespace by 
using the format \\DomainName\RootName. If a client accesses a domain-based namespace directly on 
the root server (\\RootServer\RootName), root target failover does not occur. DFS failover is only 
performed when a client opens a file or folder. If a client has files or folders open and attempts to read or 
write to them when the target server is unavailable, the application will receive a failure on that operation.  

Switching Between Replicas During Failover  

Referrals are cached locally to maintain performance, and if replicas are available, all replicas are 
provided to the DFS client. The client chooses which referral to use as a failover and preference is still 
given to replicas within the same site as the client. After a referral is selected, a session setup is 
performed (credentials are passed to the new server if a prior connection does not exist). If the selected 
referral fails, a failover process begins. The speed and implications of the failover depend on what the 
client was doing at the time of the failure, how the failure occurred, and how tolerant of delays an 
application is.  

To configure user connections to the local DFS image 

1. At each client workstation, map a network drive to the data folder you set up via DFS. 

2. Right-click this new network drive, then click Properties.  

3. On the DFS tab, specify the server you want to go to and set it to Active.  

http://technet.microsoft.com/en-us/library/bb727150.aspx
http://technet.microsoft.com/en-us/library/bb727150.aspx
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The Partition Knowledge Table (PKT)  

The DFS topology is stored in the server–based Partition Knowledge Table (PKT). When DFS roots and 
links are accessed by users, the computer caches that portion of the PKT and connects to one of the 
servers in the referral list. The PKT maps the logical DFS namespace into physical referrals, as shown 
below. (Replicas appear as a list for a single DFS link.)  

DFS path  Link [server and share]  Time-To-Live  

DFS name #1  UNC name #1  5 minutes (default)  

 UNC name #2  5 minutes  

 UNC name #3  5 minutes  

DFS name #2  UNC name #4  5 minutes  

 UNC name #5  5 minutes  

The PKT also stores site information, which is used to connect users to DFS roots and links in the same 
site. The PKT is a sorted lookup table. One PKT resides in Active Directory for each DFS root in a 
domain-based DFS. The PKT for a stand-alone DFS resides locally in the registry. This table determines 
the failover.  

Multiple remote shares will correspond to a single mapped shared folder. The client requests information 
about a mapped shared folder and the DFS server provides it with a listing of the servers. This is shown 
in the SMB portion of the packet description provided by Network Monitor:  

SMB: R transact2 NT Get DFS Referral (response to frame 55)  

SMB: Transaction data  

   SMB: DFS Path Consumed = 36 (0x24)  

   SMB: DFS Number of Referrals = 4 (0x4)  

   SMB: DFS Server Function = 2147450878 (0x7FFF7FFE)  

SMB: DFS Version 2 Referral  

    SMB: DFS Version Number = 2 (0x2)  

    SMB: DFS Server Type = Unknown Server Type 

    SMB: DFS Proximity = 0 (0x0)  

    SMB: DFS TimeToLive = 604800 (0x93A80)  

    SMB: DFS Filename = \TONY\DFS\Test\DFS  

    SMB: DFS 8.3 Filename = \TONY\DFS\TEST\DFS  

    SMB: DFS Sharename = \TONY\DFS4  

SMB: DFS Version 2 Referral  

    SMB: DFS Version Number = 2 (0x2)  

    SMB: DFS Server Type = Unknown Server Type 

    SMB: DFS Proximity = 0 (0x0)  

    SMB: DFS TimeToLive = 604800 (0x93A80)  

    SMB: DFS Filename = \TONY\DFS\Test\DFS  

    SMB: DFS 8.3 Filename = \TONY\DFS\TEST\DFS  

    SMB: DFS Sharename = \TONY\DFS2  

SMB: DFS Version 2 Referral  
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    SMB: DFS Version Number = 2 (0x2)  

    SMB: DFS Server Type = Unknown Server Type 

    SMB: DFS Proximity = 0 (0x0)  

    SMB: DFS TimeToLive = 604800 (0x93A80)  

    SMB: DFS Filename = \TONY\DFS\Test\DFS  

    SMB: DFS 8.3 Filename = \TONY\DFS\TEST\DFS  

    SMB: DFS Sharename = \TONY\DFS1  

SMB: DFS Version 2 Referral  

    SMB: DFS Version Number = 2 (0x2)  

    SMB: DFS Server Type = Unknown Server Type 

    SMB: DFS Proximity = 0 (0x0)  

    SMB: DFS TimeToLive = 604800 (0x93A80)  

    SMB: DFS Filename = \TONY\DFS\Test\DFS  

    SMB: DFS 8.3 Filename = \TONY\DFS\TEST\DFS  

    SMB: DFS Sharename = \TONY\DFS3  

As you can see, the client determines which network share it will attempt to access. It always goes to the 
local one, unless there is a problem. For example, a user connects to a DFS branch that mapped to four 
shares and creates a new file. The server fails and the client redirects. The client might issue the next 
commands through an SMB session connected to a different share. Therefore, only with a real-time mirror 
can alternate shares ever work with read/write files, if they were redirected to a different server site. This 
is because the file updates always take place across sites.  

Scenario 1  

A client is browsing through a replicated folder. The computer hosting the replica loses power or drops off 
the network for some reason. In order to fail over, the client computer must first detect that the hosting 
computer is no longer present. How long this takes depends on which protocol the client computer is 
using. Many protocols, such as TCP/IP, account for slow and loosely connected WAN links before the 
protocol itself times out. After that occurs, DFS immediately selects a new replica. If no protocols are 
available from the local cache, the DFS client consults with the DFS root to see whether the administrator 
has modified any PKT entries and initiates a fresh replica selection and session setup.  

Scenario 2  

A client is browsing through the folder. The computer hosting the replica loses the hard disk containing 
the replica, or the replica itself is deactivated. In this scenario, because the server hosting the replica is 
still responding to the client request, the failover to a fresh replica occurs at near-LAN speed.  

Scenario 3 

A client has open files. The computer hosting the replica loses power or drops off the network for some 
reason. In this scenario, you have the same protocol failover process described in Scenario 1. New 
attempts to open files trigger the same failover process that is described in Scenario 1. Operations on 
already open files fail with appropriate errors.  

Scenario 4  

A client has open files. The computer hosting the replica loses the hard disk containing the replica, or the 
replica itself is deactivated. In this scenario, you have the same rapid failover process that is described in 
Scenario 2. In addition, the failover depends on the application that previously had file handles from the 
previous replica to detect the change and establish new handles.  
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It then establishes an SMB connection to the server and share referenced and does whatever it needs to 
do in normal SMB fashion. Once the referred computer is connected to, traffic is no longer DFS specific. If 
the client already has a connection to a given share, a new connection is not established. Connections 
are reused whether or not the original connection was established through DFS. You should reference 
the fewest number of network shares possible.  

Failback  

Prior to Windows Server 2003 Service Pack 1, there was no way for administrators to configure clients to 
fail back to their local servers; this behavior can be problematic in branch office environments when 
clients continue to access the hub server even after the branch server is restored.  

The failback settings for roots and links can be set using the /TargetFailback option of DFSutil. In 
addition, the DFS Client Failback QFE for Windows XP and Windows Server 2003 must be installed to 
enable the client to perform the failback. Setting the  

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Dfs\Parameters\SysvolNet

logonTargetFailback  registry key and restarting the DFS service on the domain controller enables 

target failback for SYSVOL/NETLOGON  referral requests handled by that controller.  

Key Terms Associated With DFS  

 DFS topology. Overall logical hierarchy of a distributed file system, including elements such as 
roots, links, shared folders, and replica sets, as depicted in the DFS administrative console. This 
is not to be confused with DFS namespace, which is the logical view of shared resources seen by 
users.  

 DFS root. The share at the top of the DFS topology that is the starting point for the links and 
shared files that make up the DFS namespace. A DFS root can be defined at the domain level for 
domain-based operation or at the server level for stand-alone operation. Domain-based DFS can 
have multiple roots in the domain but only one root on each server.  

 Root replica. The server that duplicates a DFS root to provide greater availability. The server 
that is hosting the DFS root is responsible for handing out referrals to clients for shared folders. If 
that server becomes unavailable and a root replica has not been created, the DFS namespace 
becomes inoperative. Replicas can also be created for existing DFS links.  

 DFS link. Part of the DFS topology that lies below the DFS root and forms a connection to one or 
more shared folders or another DFS root. It does this by mapping a DNS name to the standard 
UNC of the target shared folder.  

 DFS shared folder. Files or folders in the DFS namespace that are shared by users with proper 
permissions. Shared folders can exist at the root level (domain-based DFS only) or be referred to 
by DFS links.  

 Partition knowledge table (PKT). A table that maps root and replica nodes in the DFS 
namespace to Active Directory sites and physical servers. For a domain-based DFS root, the 
PKT is stored in Active Directory and made available to each domain controller in a domain. For a 
stand-alone DFS root, the PKT is stored in the individual server's registry. When a DFS client 
gains access to a shared folder in the DFS namespace, it caches that portion of the PKT for the 
length of time specified in the TTL. 

 Referral. The referral is the physical server and share residing in the PKT that clients connect to.  

 Time-To-Live (TTL). The length of time that a DFS client stores the referral information from the 
PKT when it accesses a shared folder. DFS clients request a new portion of the PKT when the 
TTL expires or when the client is restarted. The TTL resets if the shared folder is visited before 
expiration. It is configurable on a per-link basis.  
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 Revision level. Refers to DFS client compatibility. There are three revisions of DFS clients that 
can be viewed in Network Monitor traces. Clients that are running Windows NT version 4.0, 
Windows 98, and Windows 95 support DFS revision level 2; clients that are running Windows 
2000–based support revision level 3. Version 1 clients do not exist. DFS clients and servers 
negotiate the highest common protocol revision supported.  

Configuring DFS 

The instructions below use the following information. (Substitute your information when performing the 
procedure.)  

 Active Directory name is koenigshouse.com   

 Win2003 server name is Storage   

 DFS Root name is Documents   

 DFS Link name is Public   

 The folder that is replicating on the server is shared as NetworkData  

Creating the DFS Root  

1. Open DFS. (Start > Run> type dfsgui.msc > ENTER.)  

 

2. Click Action, then click New Root. The New Root Wizard appears. 

3. Click Next. 

4. Ensure Domain Root is selected, then click Next.  

5. In the Domain name, ensure that your domain is listed (\\koenigshouse.com in this example), 
then click Next. 

6. In the Server name box, type the server name that will hold the DFS Root (in this example, 
storage.koenigshouse.com), then click Next.  

7. Type the name of the DFS Root (in this example, Documents) and any comments, then click 
Next to continue.  

8. Type the location of an empty folder on the server that will be used as the DFS placeholder, then 
click Next to continue. (If necessary, create one.) 

9. Click Finish. 
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Creating the first DFS Link  

1. Open DFS. (Start > Run> type dfsgui.msc > ENTER.)  

2. Click Action, then click Show Root.  

3. In the Show Root dialog box, click your DFS Root that you created in the previous procedure. 

4. Right click your DFS Root, then click New Link. Type the DFS Link name (Public in this 
example), the location of the Shared Folder on the server (\\Storage\NetworkData in this 
example), and any comments. You now have a DFS Link called Public that points to a share 
called NetworkDat on the \\Storage server.  

5. Open Explorer and type \\koenigshouse.com. You will see the DFS Root called Documents 

that you set up in the previous procedure. 

6. Open Documents, and you will see the DFS Link called Public.  

Adding Additional DFS Targets to a DFS  

1. Open DFS. (Start > Run> type dfsgui.msc > ENTER.)  

2. Click Action, then click Show Root.  

3. In the Show Root dialog box, click your DFS Root. 

4. Click the DFS Link and you will see the DFS Target on the right.  

5. Right-click the DFS Link, then click New Target.  

6. Type or browse for the path to the shared folder. (Be sure to clear the replication set check box.)  

Now you should have two servers available to which clients can connect. You can add all server shares 
that are being replicated.  

Restoring Files and Folders in a Master Agent Server CDP 
Deployment 

Several scenarios are described below regarding how to restore files, depending on the various 
deployment possibilities for CDP. Follow the procedures in Placing the Agent Offline and Opening the Job 
Administration Console before you begin. 

Restoring a File in a Master Agent Server CDP (No Slave) Deployment 

To restore a single deleted file or previous version of a file 

1. Place the Agent offline and open the Job Administration console. 

2. In the Job List, click the Job from which you want to restore the file. The File Retrieval menu for 
the Job appears.  
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3. In the File Retrieval menu, click Deleted items. The list of deleted files appears. 
 

 

4. To restore the most current version of a file, click Restore; to restore a prior version of the file, 
click Done - Go Back, then click the file's hyperlink to view a list of the current and prior versions 
of the file. The View and Retrieval list appears. 
 

 

5. Next to the version of the file you want to restore, click Download. If the file is a type that the 
browser can display, such as text, graphics, HTML, and so on, the file displays in the browser. If 
the file cannot be displayed in the browser, the File Download dialog box appears. 

 

6. Save the file to a location independent of the folders, such as the desktop. 

7. Place the Agent back online. 

8. After the (Master) Agent shows a green light (on-line), copy (or move) the downloaded file into the 
original location. The file is restored. 
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Restoring a File in a Master Agent Server CDP (with Slave) Deployment 

To restore a single deleted file or previous version of a file 

1. Place the Agent offline and open the Job Administration console. 

2. In the Job List, click the Job from which you want to restore the file. The File Retrieval menu for 
the Job appears.  

 

3. In the File Retrieval menu, click Deleted Items. The list of deleted files appears. 
 

 

4. Next to the file you want to restore, click Restore. After you restore the file, to promote the 
restored version of the file to a newer version, click the file, then click Make Current. 

5. On the Slave Agent, verify that the file appears in the normal file structure. You can then copy it to 
another location or the same location on the Master Agent. 

6. Put the Master Agent back online. 
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Restoring a Folder in a Master Agent Server CDP (No Slave) Deployment 

To restore a deleted folder 

1. Place the Agent offline and open the Job Administration console. 

2. In the Job List, click the Job containing the folder you want to restore. The File Retrieval menu 
for the Job appears.  

 

3. In the File Retrieval menu, click Deleted Items. The list of deleted files and folders appears. 
 

 

4. Next to the folder you want to restore, click Restore. 

5. In Windows Explorer, navigate to the Server Vault:  

a. To find the path, in the Server Console, click Server > Edit Parameters. The Server 
Parameters dialog box appears. 



WAFS/CDP User Guide 

150 

 

b. In the Server working space box, copy the path to the Vault (in this example, D:\AD). 

6. In the Vault, click the Job that contains the folder you want to restore (in this example, 
D:\AD\THINGS).  
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7. Open the P directory. The folder you restored appears in this directory. 
 

 

8. Copy the folder you have restored to another location; if possible, copy it to the original location 
on the Master Agent.  

9. Put the Agent back online. 

Restoring a Folder in a Master Agent Server CDP (with Slave) Deployment 

To restore a deleted folder 

1. Place the Agent offline and open the Job Administration console. 

2. In the Job List, click the Job containing the folder you want to restore. The File Retrieval menu 
for the Job appears.  

 

3. In the File Retrieval menu, click Deleted Items. The list of deleted files and folders appears. 
 

 

4. Next to the folder you want to restore, click Restore. 
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5. Open your Slave Agent folder and copy the recovered folder to the same folder location on the 
Master Agent. 

6. Place the Master Agent back online. 
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Technical Notes 

The topics below are for advanced configuration. In many cases, you should consult with GlobalSCAPE 
Technical Support before implementing these procedures. 

Agent-Server Communication Compression 

 

This is an advanced topic. If you are not comfortable with making these settings, do not attempt this. 
Contact GlobalSCAPE Support for assistance. 

In many cases, the Agent and Server are connected via the Internet. In such a connection, bandwidth 
savings is a prime concern. Because of that, all traffic between the Agent and the Server is compressed, 
and transfers only byte-level changes. 

Essentially, compression is a trade-off of CPU time for bandwidth. Even when both the Agent and the 
Server are on a LAN, it might still make sense to compress data. This is especially true if both the Server 
and the Agent are relatively fast computers, and the network is relatively limited. 

You might want to disable Agent/Server compression in the following instances: 

 The Agent and Server are on the same LAN, and either or both are very loaded. In this case, the 
extra CPU cycles required to compress the transfer might not be worth it. In other words, the 
cycles for compression are more valuable than transfer savings. 

 The Agent and the Server are cohosted on the same computer. In this case, compression does 
not improve performance. 

 The vast majority of the data transferred between the Server and the Agent is already 
compressed, such as with most multimedia files. 

When you disable one Agent's compression, the communications between it and the Server are not 
compressed. This setting does not affect the communication compression of the same Server with any 
other Agents. 

To disable or enable compression on an Agent 

1. Stop the Agent service. 

2. Download and unzip AvaillCompress.zip. 

 To disable compression, execute noCompress.reg.  

 To enable compression, execute Compress.reg. 

3. Restart the Agent. 

Agent Connect and Disconnect Scripts 

When the Agent service starts up or shuts down, or when the Agent connects or disconnects from a 
Server, the Agent is capable of executing customizable scripts. These scripts must be located in the 
C:\AVCStuff folder on the computer running the Agent. None of these scripts exists by default, but if you 
create any of them, they will be executed by the Agent at the appropriate time. Typically, these scripts 
would be used for notifications, alert messages, email scripts, and so on. (See also Server Connect and 
Disconnect Scripts.) 

If you need assistance creating scripts, contact the GlobalSCAPE Professional Services team. 

At startup and shutdown, the Agent can run the following scripts: 

 pre_init.bat - This script runs before the Agent mounts its data, and before any replication activity 
starts.  

http://www.globalscape.com/support/techsupport.aspx
file:///D:/WorkFolder/Technical%20Writing/WAFS/Source/zip/availlcompress.zip
http://www.globalscape.com/support/professional_services.aspx
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 post_init.bat - This script runs a few seconds after the Agent mounts its data and starts 
replication.  

 pre_shutdownC.bat - This script runs when the Agent is stopped; typically when the service is 
stopped. In other words, it runs before the Agent confirms (hence the "C") that no file in the 
folders is opened. The script can shut-down applications that open files on the Agent, so that 
stopping the Agent would proceed correctly. If later the Agent cannot be stopped (because a file 
is opened), and the IT manager makes another attempt to stop the Agent, the script is executed 
again.  

 pre_shutdown.bat - This script runs before the Agent starts the shutdown process. This script 
runs after the pre_shutdownC script.  

 post_shutdown.bat - This script runs after the Agent completes the shutdown process, stops all 
activities. 

The scripts run at the appropriate time when the Agent service is started or stopped. They are not called 
with any arguments. 

When the Agent connects to or disconnects from a Server, it can run the following scripts: 

 srv_connect.bat - This script runs when the Agent is connected to a Server and is passed the 
Server's name. 

 srv_disconnect.bat - This script runs when the Agent is disconnected from a Server and is 
passed the following arguments: 

o The Server's name  

o The reason for the disconnection, which is one of: 

 "exit" - disconnect due to Agent exiting normally 

 "scheduledDisconnect" - Agent is on a schedule and disconnected accordingly 

 "disconnect" - generic error; Agent did not expect to be disconnected  

Antivirus Settings 

Your antivirus configuration can affect file-access performance when using the system. This section 
describes how to optimize your antivirus setup for use with WAFS/CDP.  

Choose from the following antivirus configurations based on your particular needs: 

Antivirus at each end-user's workstation - If each of your end-users' workstations are protected, the 
possibility of an infected file is eliminated and there is no need to run antivirus on the computer running an 
Agent. This is the most effective level.  

Protection at the server running the Agent - Instead of managing antivirus software on each user's 
workstation, some IT managers prefer to run antivirus software on the servers that run the Agent. When 
not done properly, this can affect the performance of user file access. Refer to "To configure antivirus 
software at the computer running an Agent" below for important exclusion setup notes.  

Protection at Server - All files move through the Server. You can, therefore, run antivirus software on the 
Server and scan the Server's root before propagating files to the Agents.  

Running antivirus software on an Agent can degrade the performance if not properly configured. The 
performance hit is caused by the antivirus software thinking that multiple copies of a file are opening. It 
may scan the same file up to 3 times when a user opens the file once. It may also perform background 
scans that appear as regular CPU cycles (Norton, E-Trust, NOD32, etc), as well as process scans of the 
application. If the file is in a linked folder, then the antivirus software scans the file from the original 
location upon open, AND from inside the replicate drive (e.g., F:\_MySrv\MyVol). Finally, the file is seen 
internal to the engine (e.g., C:\WINDOWS\AVMF or D:\AVMF), and scanned again.  
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In addition to on-the-fly scan when a file is changed, some antivirus software includes a daily scan. In this 
case, if it is necessary to do this daily scan, it might be useful to do it when the Agent is offline. For 
example, you can schedule the Agent so that it is online 22 hours a day, and offline for two hours during 
times when users are less likely to use the Agent. During that time, the computer running the Agent can 
do backups, virus scans, and so on. 

To configure antivirus software at the computer running an Agent 

Antivirus applications typically allow directories to be excluded from the antivirus scan (often called 
"exclusions"). When available, the following exclusions should be made at each Agent: 

 Exclude directories AVM0 and AVMF. All data mirrored on the C drive will be in 
C:\Windows\AVMF and all data on any other drive will be in <drive_Letter>:\AVMF (e.g., 
D:\AVMF).  

 Exclude the entire new drive letters (e.g., F:\_MyServer ).  

 If your antivirus scans processes (especially E Trust, Innoculan, Symantec Tamper Protection, 
Trend Micro OfficeScan/Server protect), always exclude AvlAgt.exe. 

 

Some local server antivirus applications in corporate environments, like McAfee, are controlled by a 
central monitor service run by your IT at headquarters. Exclusions must be specified at that central 
console; the console then pushes them out. The exclude list you see at each remote site is ignored 
in these hierarchical topologies. 
 
If slowness persists for user access to CAD files, exclude the CAD file extension from the 
workstation antivirus, and check the performance again. 

 

AutoCAD Tips 

 

WAFS/CDP versions 3.5.2.8916 and later are compatible with AutoCAD Architecture 2009. 

To optimize settings for using WAFS with AutoCAD 

1. On the General tab of the Agent Setup and Preferences dialog box, select the Delay file 
upload check box.  

 

This will cause the Agent to upload only after the file closes, as opposed to each time a flush is 
issued.  
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Do not enable digital signature. For details, see 
http://management.cadalyst.com/cadman/article/articleDetail.jsp?id=133347 or your 
AutoCAD documentation. 

(Your interface will differ slightly, depending on the version of AutoCAD and OS you are using.)  

 

2. In the File Save area, set the Incremental save percentage to 50% or more. This will save the 
changes made at the end of the file, rather than write the entire file. This is faster in terms of I/O, 
but also leads to smaller deltas. 

 

You can turn off the backup feature on the Open and Save tab of the Options dialog box. If 
you want AutoCAD to save your drawing to a file automatically, you can use Security 
Options to specify a time interval between save operations and a file name for the temporary 
drawing. 

When doing a "save as," realize that you are creating a new file that must replicate across 
multiple other servers. If the file is large, this is not instantaneous like a normal save. 

 

Enable Save IPJ file in Workspace Directory as default in the Security Options to ensure 
a fast change from fixed path to relative path. Use Relative Path allows use of the file at 
any other location without worrying about the paths in the project file because they are 
relative to where the project file (.IPJ) is placed. 

3. You can also configure AutoCAD to not write the tmp files into the Availl volume, to keep them 
from replicating.  

(Your interface will differ slightly, depending on the version of AutoCAD you are using.)  

http://management.cadalyst.com/cadman/article/articleDetail.jsp?id=133347
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Keep items like shared menus out of the Agent or set the folder to read only. 

Make sure the Project File (.ipj) and all files associated with the project are in subfolders of one 
folder that the Agent is mirroring. IPJ must be saved regularly. 

CDP for System State 

System state of any Server can be included in the backup topology very easily. Once an Agent is installed 
on any Server, it is a matter of ensuring that the correct data is included in the CDP backup set. 

According to Microsoft, system state includes: 

 The registry 

 COM+ Class Registration Database 

 System Boot Files 

 Files under Windows file protection 

 If this information is available, a failed Windows server can be completely restored by reinstalling 
the same Windows Server operating system version, and then restoring this system state 
information. 

Microsoft Windows 2000 and 2003 provide a simple utility, \windows\system32\ntbackup.exe, that can 
run at any time, during any level of use.  

To run the Windows Backup or Restore Wizard 

The default path to the Backup or Restore Wizard is Start > Programs > Accessories > System Tools 
> Backup.  

1. To start the tool, click Advanced > Backup wizard. You will be prompted to select only System 
State data. 
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2. The wizard then asks you to determine where to place this file. Do one of the following: 

 Make sure you select a directory that is part of the system. 

 On the backup tab of the utility, click My Computer > System State. Click Start backup 
(make sure Replace the data on the media is selected), save it, and then schedule it.  

 Click Advanced, and make this a daily event. 

Changing a Job's Type 

Each Job has a type that is specified when you create it. When an Agent is attached to a WAFS Job, its 
type is displayed on the Job's Options tab. A Job type can be modified from the Server. Typically, there 
is no reason to change a Job type; however, if you change a Job type, it is changed for that Job on all 
Agents.  

To change a Job's type 

1. In the Windows system tray, click the Server icon   then click Display the Availl Server 
control panel. The Server Console appears. 

2. Click Server > Manage Jobs. The Job Administration console appears in the default Web 
browser.  

 

3. Click Detail for the Job whose type you want to change. The Job Information page appears. 

 

4. Click Edit. The Editing Job page appears. 
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5. In the Job Type box, click the down arrow to select the type of Job (Wide Area File System or 
Continuous File Backup). 

6. Click Save, then restart the Server to save the changes. 

Changing a Linked Folder's Name 

 

Registry editing is for advanced users only. Incorrectly editing the registry can severely damage your 
system. You should always back up (export a copy of) the registry before you make any changes to 
it.  

To change a linked folder's name 

1. Stop the Agent.  

2. Export the Agent's HKEY_LOCAL_MACHINE\SOFTWARE\Availl\AvaillClient registry tree. 

(Click Start > Run, then type regedit. Click the branch of the tree that you want to export, then 

click File > Export.) 

3. Search the copy of the registry file that you exported and modify it so that every instance of the 
location and name are changed to where/what you want it to be.  

4. Restore (import) the registry that you exported. 

5. Restart the Agent. 

Changing the Default Administrator Account 

It is a good idea to change the administrator's username and password to prevent unauthorized access. 
The username/password is required when logging in to the administration functions from a remote web 
browser (see Managing Jobs).  

For security reasons, changing of the name/password can only be done from the Server computer.  

To change the administrator account information 

1. In a text editor, open Root.txt, stored in the Server directory. The file consists of two lines. The 

first line is the username and the second is the password. 

2. Edit the username and password, using only alphanumeric characters and no blanks, and save 
your changes. 

3. You must stop and restart the service before the changes take effect. 

You can store the file in a different directory, as long as a link to the file named Root.txt exists in the 

default Server directory. 
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Changing the Default Location of the Agent Logs 

Each time the Agent is started, it creates a new log file. Log files are written by default to the folder 
C:\AVCStuff\logs.SYSTEM. Each time the Agent runs, it creates a new log file with a name containing 
the date and time when it was started (e.g., Agn_20080604_1100_001.txt). You can also change the 
default location of the logs.  

 

Registry editing is for advanced users only. Incorrectly editing the registry can severely damage your 
system. You should always back up (export a copy of) the registry before you make any changes to 
it.  

To change the default location of the Agent Logs 

1. Create the folder to which you want to save the log files. (Availl will NOT create this folder for you. 
You must create it before you point the registry to it.) 

2. Stop the Agent. 

3. Open the Windows Registry. (Click Start > Run, type regedit, then press ENTER.) 

4. Expand HKEY_LOCAL_MACHINE\Software\Availl\AvaillClient\Settings. 

5. Right-click Settings, then click New > Key. 
 

 

6. Name the key altLOGFolder. 

7. In the right pane, double-click the new key. The Edit String dialog box appears. 
 

 

8. In the Value data box, provide the full path to log file folder, then click OK. For example, type:  
 

e:\Availl_Logs 

(Availl will NOT create this folder for you. You must create it before you point the registry to it.) 

9. Close the Registry. 

10. Restart the Agent. 

11. Verify that a new AGN log is created in the new default location when the Agent is started. 
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Changing the Server's IP Address and Port 

When an Agent connects to a Server, it must know the address of the computer running the Server 
software. It communicates using standard HTTP or HTTPS. The address of the computer running the 
Server is specified either as the: 

 DNS, such as wafs02.myCompany.com 

 local computer's name on the LAN, such as AVL002. This is valid only if the Agent is on the 

same LAN as the Server. 

 IP address such as 100.120.130.123 This syntax can be appended with a port number if the 

port is different from the default (port 80), for instance 100.120.130.123:711. 

Sometimes it is necessary to modify the Server‟s address or to move the Server software to a new 
computer. After the change, the Server‟s address must also be modified on each Agent connected to the 
Server.  

Reasons to change the Server's IP Address and Port 

 IT reconfiguration. For example, using a new ISP carrier, repartitioning an existing network, 
relocating an office, etc. 

 In order to expedite the initial replication, the computer running Server is brought physically near 
the Agent, thus using fast LAN connection between the Agent and the Server. Once the initial 
replication is over, the Server is moved back to its permanent physical location, where its address 
is different from what it was during the initial replication. 

 The Server software needs to be moved from one computer to another. 

 Port conflict resolution. You need to change the port number used by the Server.  

  

To relocate the physical Server without redoing any replication 

 

This method is not necessary if the Server has only been renamed or the port number changed.  

1. Stop each of the Agents and the Server. 

2. Install Server on the new computer. The installation creates a file system root directory (C:\AD by 
default).  

3. Stop the Server on the new computer. 

4. Delete the file system root directory from the new computer (C:\AD by default). 

5. Move the file system root directory (C:\AD or whatever you set it up to be) from the old computer 
to this new computer. 

6. Start the Server on the new computer. 

7. If you have a permanent license code, make sure you delete it from the old Server computer and 
move it over to the new Server computer.  

8. On each computer on which an Agent is installed, in the system tray, click the Agent icon , then 
click Job Properties and Options.  

9. Click the Change Options tab.  
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10. Click Server Move. The Move Availl Server dialog box appears. 

 

11. In the Server box, specify the IP address or name of the Server and port, if necessary, then click 
OK. All of the Jobs connected to the Server are moved to the new Server. 

 

Why is the Server Move function in the Job Properties and Options dialog box instead of the 
Server Console? Because you are telling the Jobs where the Server moved. 
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Conflict Confirmation 

When several users share files, each time a file is opened by one of the users, only the latest version of 
the file is available. If user A modified a file and then user B opens the same file, user B will get the latest 
version modified by A. 

When an Agent is offline, the following can occur 

1. A file exists on a volume and is mirrored by two Agents X and Y, in two different locations. 

2. Agent X is disconnected from the Server, and switches automatically to offline mode.  

3. A user on X modifies a file while X is offline. 

4. A user on Y modifies the same file. 

5. The connectivity between Agent X and the Server resumes.   

At this point, there are two different versions of the file: one on Agent X and the other on the Server and 
on Agent Y. This is called a file collision. The action taken to resolve it is called conflict resolution. 

What does WAFS do when a file collision is detected? 

When an Agent comes online (as in step #5 above), it performs an initial synchronization with the Server 
in order to catch file collisions. When a file collision is found, the Agent simply makes its copy of the file 
the most current. In the example above, X's version of the file becomes the "last version" and thus 
becomes the "current version" on Y as well. 

Since all past versions of all files are kept on the Server, a user can always restore any past version of 
the file, including the version that was modified on Y when agent X was offline. 

Can the conflict resolution behavior be altered? 

If the Agent is used in an interactive environment, it is possible to alter the default behavior so that when 
the Agent that was offline comes online and finds a collision, it will prompt the user for an action. The user 
can chose one of the following options: 

1. Upload the user's version of the file to the Server, thus making it the current version on all the 
other Agents. 

2. Download the version from the Server, overriding the local version. 

3. Save the file locally with a new name, before overwriting the file with the other Agents, allowing 
the user to compare versions later. 

 

Registry editing is for advanced users only. Incorrectly editing the registry can severely damage your 
system.  

You should always back up (export a copy of) the registry before you make any changes to it.  

 

To enable interactive collision resolution, edit on each Agent 

1. Stop the Agent. 

2. Open the Registry Editor. (Click Start > Run, type regedit, and then press ENTER.) 

3. In the registry tree (in the left pane), click the registry key that you want to edit:  
HKEY_LOCAL_MACHINE\SOFTWARE\Availl\AvaillClient\Settings\enbCollPrompt 

and set the value to 1. (To restore the automatic conflict resolution, set the value to 0.) 

4. Restart the Agent. 
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If the enbCollPrompt value does not exist, create it and set its value 1: 

1. Stop the Agent. 

2. Open the Registry Editor. (Click Start > Run, type regedit, and then press ENTER.) 

3. In the registry tree (in the left pane), navigate to 
HKEY_LOCAL_MACHINE\SOFTWARE\Availl\AvaillClient\Settings 

4. Right-click Settings, then click New > DWORD Value. 

5. In the right pane, change the "new value" key name to enbCollPrompt.  

6. Double-click enbCollPrompt and set its value to 1. (To restore the automatic conflict 

resolution, set the value to 0.) 

Deploying a Multiple-Server Configuration 

 

This is an advanced topic. It is not necessary to be familiar with this information to operate a system 
successfully. 

A typical deployment includes one Server and several Agents. Each Agent connects to the Server, which 
acts as a "traffic cop" and keeps all the Agents in complete sync. 

The time it takes to open a file on a given Agent is comparable to opening a file on your LAN, depending 
on the following factors: 

 Is the data already fully mirrored (maybe it is a new file, or large changes)? If not, the data needs 
to transfer and the time will depend on the connection speed between the Server and the Agent.  

 What is the latency of the connection between the Server and the Agent?  

Even if a file is fully mirrored locally, the Agent must still report to the Server that a file is being opened. A 
very small packet is sent to the Server. The farther geographically the Agent and the Server are, the 
longer it takes for the packet to arrive at the Server. In some cases, e.g., if the Server is in India and the 
Agent in the US, the latency can be 350 ms or more. 

The Agent contains many optimizations that dramatically reduce the need for communication between the 
Agent and the Server when opening a large number of files in a short amount of time; however, in some 
situations, an even faster response time is desired. For that, a multiple-Server configuration may provide 
the solution. It is a very simple configuration to deploy. 

What is involved in multiple-Server deployment? 

Typically, the data that is shared between Agents can be partitioned logically into several volumes. In 
many cases, most of the access to the data in a given volume is done in one location, while other 
locations access it less frequently. 

Consider the following example:  

 Volumes 1, 2, and 3 contain information that is frequently accessed and modified in India, and is 
accessed and modified, but less frequently, in the US. 

 Volumes A and B contain information that is frequently accessed and modified in the US, and is 
accessed and modified less frequently in the India. 

In this case, you could deploy a Server in India to act as the "traffic cop" for volumes 1, 2, and 3, and 
another Server in the US to act as the "traffic cop" for volumes A and B. After that, an Agent is deployed 
in the US and another one in India. Both of these two Agents mount all the volumes 1, 2, 3, A, and B. The 
result is that the LAN in both India and the US would have the five volumes, and they would all be fully 
accessible to all the authorized users; however, access to volumes 1, 2, and 3 would be faster in India 
because the Server is local (no latency), and likewise the access to A and B would be faster in the US.  

In fact, the Agent in each country can be colocated with the Server on the same computer. 
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Firewall and Router Configuration 

Typical configurations that allow Agents to connect to the Server over the Internet involve placing the 
Server inside a firewall and connecting to the Internet using a router. 

Routers typically provide DHCP services. This means that computers inside the firewall ask the router to 
assign them a unique IP address in a given range, and that IP address would change from time to time. 
Routers typically support static IP addresses of computers inside the firewall. (Static IP addresses do not 
change and are assigned permanently to the computers.) 

For example, a router could be configured as follows: 

 The router itself has an IP address 192.168.1.1. 

 The router runs a DHCP server that automatically assigns IP addresses to the computers inside 
the firewall in the range 192.168.1.50 to 192.168.1.255.  

In this example, IP address 192.168.1.2 to 192.168.1.49 would be available as static IP addresses for 
computers inside the firewall. So you could, for example, set the TCP/IP protocol of the computer running 
Server as follows: 

IP address 192.168.1.20 

subnet mask 255.255.255.0 

default gateway 192.168.1.1 

After setting up the computer in this way, make sure you can browse the Internet from the computer. If 
not, double check that the IP address is within the correct range, and that the gateway's address is that of 
the router. 

Thus far, you are allowing outbound Internet traffic from the computer using a static IP address. However, 
the firewall still does not allow any inbound traffic; that is, it does not route requests coming from outside 
of the firewall to reach the Server. To achieve that, you would need to setup port forwarding on the router.  

Port forwarding is a mechanism that routes requests coming from the Internet (into the router) on a given 
port to a specific computer inside the firewall. For example, suppose the Server is listening on port 80 
(which is the default port). You would configure the router to direct any incoming traffic on port 80 to IP 
address 192.168.1.20 (the Server computer) port 80. Note that it is not necessary to use the same port 
number in the mapping. For example, you could configure the router so that requests on port 711 are 
directed to the server computer's port 80. 

 

Issues with Other Applications 

Below are a few tips and tricks for using other applications on the same computer with WAFS. 

Veritas File Screen Server or StorageExec/QuotaAdvisor  

Veritas has a known bug in versions of File Screen Server, StorageExec (formerly WQuinn QuotaAdvisor) 
that causes 0x0000007f BSODs. Microsoft Knowledge Base article #300225 describes this Veritas 
problem. The issue is with FileScreenFilter.SYS, qafilter, WQFSSvr, WQQASvr, and nmsvfst processes. 

A patch from Veritas is available. You can also try the following to resolve the issue: 

 Rename FileScreenFilter.SYS (located in windows/system32/drivers) and then disable the File 
Screen Server service. 

 Rename the processes listed above, then disable the Windows Services StorageExec or 
QuotaAdvisor, and FileScreen Server. (Seen often on Iomega NAS, HP NAS, Dakota NAS and 
some less well known NAS brands). 

 

http://support.microsoft.com/kb/300225/en-us
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PowerQuest V2i 

Symantec acknowledges a bug in its interaction with Windows in older versions of PowerQuest (now 
called Symantec LiveState Recovery Advanced Server). You can uninstall PowerQuest prior to installing 
(it will be in Services as V2i Protector and runs as the task PQ***.exe). Symantec states that they have 
resolved the issue in versions above V2i Protector 2.03 and LiveState Recovery. Contact Symantec for 
the update. 

 

Veritas Volume Manager or Dell Disk Management Service (same product) 

This service (a Veritas monitoring tool) runs the executable vxsvc.exe. The service has a known bug that 
makes it spike 40 -50% CPU in the Windows Task Manager, which can cause the computer to reboot. 
You can shut off the service with no affects, but it will restart if you start the monitor again. Veritas has a 
patch available at http://seer.support.veritas.com/docs/256184.htm. 

 

CA Brightstor Open File Manager 

If you have this service running, and experience a BSOD, disable this service. There is a potential 
problem with a revision of their driver. 

 

EMC SAN 

Powerpath and Navisphere are known to cause performance issues. Stop these two Windows Services 
(neither is critical to ongoing use or operation of any device or application) and retest your performance. 

 

Ultrabac 

This snapshot application had a Windows file conflict problem with their optional Locked File driver that 
affects many applications. It is resolved in UltraBac version 7.1.5 and beyond in Windows 2000. It is an 
issue in >2003 pre SP1. If you have an issue, you can upgrade UltraBac or uninstall it, then rename or 
remove the file DF2K.sys prior to loading the software. Ultrabac will work fine without DF2K.sys (it is an 
optional feature).  

Use the following procedure to uninstall Locked File Backup through the Windows Device Manager: 

1. Open the Windows Computer Management console. (Start > Run, type compmgmt.msc, press 

ENTER.) 

2. Click to select Device Manager, right-click Device Manager, then click View > Show Hidden 
Devices. 

3. Right click Device Manager again, move your cursor to View, then click Devices by 
Connection. 

http://www.symantec.com/business/support/overview.jsp?pid=52704
http://seer.support.veritas.com/docs/256184.htm
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4. Scroll to and right-click UltraBac Locked File Backup Driver, then click Properties. 
 

 

5. Click the Driver tab, then click Uninstall. When you reboot the computer, the driver will be 
uninstalled. 

Sharing from the Drive 

When you configure the software, you map (link) a folder to a Job. For example, you might link 
C:\Marketing\Travel to a Job named Travel.  

In addition to the normal access to the data on the replicated folder, the software provides access via its 
"Drive." For example, if the drive is G: and that the server name is AVAILLSERVER, an alternate access 
to the same physical data is via G:\_AVAILLSERVER\Travel. 
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Sharing Data via Network-Share 

You can share any folder, whether it is inside the Job (e.g., C:\Marketing\Travel\US) or above it (e.g., 
C:\Marketing). 

Most users who use network shares to enable users to access the data, share the actual data being 
mirrored. However, sometimes IT managers prefer to share the data via its drive access, rather than the 
actual data. If you map the Job to a network drive, the data is not available when the Agent is stopped or 
disconnected from the Server. If files are modified and there are conflicts, the conflicts must be addressed 
manually. 

Server Connect and Disconnect Scripts 

Agents attempt to connect to the Server when they start. Once connectivity is established, they stay 
connected (online) until either the Agent is shut down, or until a communication problem breaks the 
connection (and then the Agent automatically switches to offline mode and starts an endless series of re-
connect attempts). 

When an Agent connects to the Server, it is considered a "connect" event. Likewise, at the time that the 
Agent stops being connected, it constitutes a "disconnect" event. 

In addition to Agent connects and disconnects, there is also a "diskOff" event, occurring when the disk on 
which the Server files reside is unavailable, or any of its directories are unavailable. This might happen if 
the disk is detachable, is iSCSI or SAN and becomes disconnected, etc. 

What are "connect" and "disconnect" scripts? 

If your Server is licensed for the failover option, you can provide two scripts that would be run 
automatically by the Server after a connection or disconnection event. The scripts are stored in the folder 
_Scripts (which you must create) under the Server's working space folder. For example, if the Server's 
working space folder is C:\AD, then the scripts folder would be C:\AD\_Scripts. The connection and 
disconnection scripts, if they exist, have to be named connect.bat and disconnect.bat.  

These scripts are optional; if there is no script for a given event, then there is no special user-provided 
processing done at that time. 

The connect script is called when an Agent connects to the Server. It is called with three parameters, all 
quoted (i.e., the double-quotes are passed into the BAT file):  

 The name of the computer running the Agent, e.g., "SRV-DC1"  

 The IP and port of the Agent, e.g., "102.65.3.1:80"  

 An application to be used to set the mode of a job (see below), e.g., "AvlAgt.exe"  

The disconnect script is called when the connectivity with a given Agent is lost. It is called with four 
parameters, all quoted (i.e., the double-quotes are passed into the BAT file):  

 The name of the computer running the Agent, e.g., "SRV-DC1"  

 The IP and port of the Agent, e.g., "102.65.3.1:80"  

 Or if the disconnect was because of an Agent shutdown (e.g., by stopping its service, or by a 
scheduled computer restart), or any other reason, (e.g., communication line problems, Agent 
computer's malfunction, etc.)  

 An application to be used to set the mode of a job (see below), e.g., "AvlAgt.exe"  

If your Server cannot reach any of the folders on which data is stored, it automatically aborts all 
replication, and refuses any new connection requests. It stays in this mode until an operator 
acknowledges the situation. 
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When a "diskOff" event occurs, the Server runs file C:\AvaillDiskOff.bat (if it exists), with a single 
argument being the folder that was not accessible when the event happened. Note that the script should 
be placed at the root of the C drive and not in the scripts folder. If the disk with the scripts folder is 
unavailable, it is still desirable to be able to locate the "diskOff" script. 

What should the scripts do? 

There are many applications for the scripts, limited only by the user's imagination. However, there are two 
common uses: 

1. Notification. For example, you can write a disconnect script that sends an automatic e-mail every 
time an Agent disconnects. You can qualify the type of disconnect using the third parameter, and 
only send an e-mail if the reason for the disconnect is unplanned. 

2. Setting the replication mode of one or more jobs on an Agent colocated with the Server on the 
same computer.  
 
For example, in backup situations, you will likely have the Server and a backup "slave" job on a 
remote computer, and a backup "master" on another computer. If the connectivity with the master 
is severed, you may want to switch the mode of the "slave" backup job to "master" automatically 
so that users can failover to that computer and keep having full read/write access to the files. In 
fact, you can even switch the mode to "WAFS." 

Setup for Windows Cluster 

You can install the Server and/or Agents on Microsoft Windows Cluster platforms such as Advanced 
Servers and Datacenter Servers. The clusters will then be a highly available source and target of any 
WAFS or backup should one cluster node fail. You can cluster just the Server, just Agents, just some 
Agents, or everything. 

Ensure that a shared disk is set up between cluster nodes. Server and Agent setups are 100% 
independent of each other. Do them separately. 

 Server - In the Cluster setup for one Server, the Server software is installed on both cluster 
computers. You will need to locate the AD directory (the Server's working space and storage) on 
a shared drive. The AD directory is home for 100% of all of the Server store and operations.  
 
During Server installation, you can keep the default location during both Server install wizards, 
and then move/change the AD directory location to the drive shared by both cluster computers 
later after you complete the installation. Once you move AD per these instructions, it will be used 
from the same location for both Servers. In other words, after install, when you click the 
"parameter" button on either Server (on each cluster computer) they will point at the exact same 
location for "Working Space" AD. 
 
You will need to enter your one license code into each Server on the cluster. In some setups, this 
will require a quick registry edit, because the license key is not set on both computers. Call us for 
the registry location for this manual entry. 
 
Once the install of the Servers is done, then set up the Cluster to start the second Server service 
(it is a generic service resource) upon failover from the primary node. 

 Agents - You will likely have multiple sites running Agents. You can choose to cluster none, one, 
or many of these Agents. They are generic service resources. 
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Program Install in a Windows Cluster 

Install an Agent on the Cluster Active Server, then change the default installation directory to a directory 
within the shared storage area (for example R:\ClusterApps\Availl).  

To change the default installation directory 

1. Stop the Agent service.  

2. Navigate to the AVCStuff folder.  

3. Copy the AVCStuff folder to the new drive location within shared storage.  

4. Delete the existing service: 

a. At a DOS command line, type: 

C:\avcStuff\AANTS.exe REMOVE 

b. In the new AVCStuff folder, click AvlAgt.exe. 

Delete the original AVCStuff folder.  

Install an Agent in the default directory of the Cluster Passive Servers. 

Services Install in a Windows Cluster 

1. On the Cluster Active Server, open Cluster Administrator and the Active Resources directory 
of the current active cluster node, which should be the first node in the cluster.  

2. Right-click in the right pane of the Cluster Administrator dialog box, point to New, then click 
Resource. The New Resource dialog box appears. 

3. Add the Agent service to the cluster: 

a. In the Name field, type a display name for the Agent.  

b. In the Description field, provide an optional description.  

c. On the Resource type menu, click Generic Service. 

d. On the Group menu, click Disk Group 1 (or the name of your Disk Group).  

e. Click Next.  

f. In the Available nodes list, click the cluster nodes you want to run the Agent on and 
move them to the Possible owners column.  

g. Click Next.  

h. In the Available resources column, click the shared cluster disk and move it to the 
Resource dependencies column.  

i. Click Next.  

j. In the Service name box, type the service image name: AvaillRAgent.  

k. Click Next.  

l. In the Registry Key dialog box, click Add. 

m. In the Root Registry Key box or Registry replication path, click Add, then type: 
SOFTWARE\Availl 

4. Click Finish. The new service is offline. Leave it offline for now.  

5. To move the cluster to the next node, open the Active Groups directory, right-click each Active 
Group and select Move group. The cluster reactivates on the next node.  

6. Verify the services are installed. Look in the Windows Services dialog box of the new node.  
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7. In the Cluster Administrator window, right-click offline resources, then click Bring Online 
(should be on the new node). This will start all Availl services. 

When a Cluster active node fails, it takes 60 seconds for a program to time out and quit its 
operation.  

 

You can configure the Agent to wait for a clustered disk. This is controlled by setting the following 
registry key  HKEY_LOCAL_MACHINE\SOFTWARE\Availl\AvaillClient\Settings\chkCluster 
to 1 (create the key if does not exist). Do this only after talking to GlobalSCAPE Support. 

Overviews of Microsoft Advanced Server and Datacenter Server can be found at these Microsoft’s 
Website:  

http://www.microsoft.com/windows2000/datacenter/evaluation/business/overview/default.asp  

http://www.microsoft.com/windows2000/advancedserver/evaluation/business/overview/advanced.asp  

Support for Microsoft Project 

Most modern applications perform file locking, which allows multiple users to access files without 
overwriting each other's work. 

Microsoft Project does file locking in a special way that is supported by Agents with a special module. 
Without this module, two users working off of two Agents could open the same Microsoft Project file, and 
in some cases would not receive warnings from Microsoft Project that the file is already open. 

To enable or disable Microsoft Project file locking 

1. Stop all Agents. 

2. Download MSProject.zip. This archive contains two .reg files: MSProject_Enable.reg  and 
MSProject_Disable.reg. 

 To enable full support Microsoft Project file lock, run MSProject_Enable.reg. 

 To disable full support Microsoft Project file lock, run MSProject_Disable.reg. 

3. Restart all Agents.  

 

Perform the above procedure on every Agent editing or accessing Microsoft Project files. 

Turning Off Thumbnail Caching 

Windows creates a small file in some directories called thumbs.db. This file is a cache of thumbnail 
pictures in a directory to speed up the display of thumbnails when viewing a folder in Thumbnail view. 
This file is a database file and, by design, WAFS/CDP does not mirror databases multi-directionally. 
These files are constantly recreated and unnecessarily mirrored, resulting in excessive network traffic, 
which can contribute to performance issues. You should disable this "feature" on Windows workstations in 
a WAFS/CDP environment and delete all thumbs.db files from your local copy. 

To turn off thumbnail caching 

1. Open Windows Explorer. (e.g., on the desktop, double-click My Computer.)  

2. Click Tools > Folder Options. The Folder Options dialog box appears.  

http://www.microsoft.com/windows2000/datacenter/evaluation/business/overview/default.asp
http://www.microsoft.com/windows2000/advancedserver/evaluation/business/overview/advanced.asp
file:///D:/WorkFolder/Technical%20Writing/WAFS/Source/zip/msproject.zip
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3. Click the View tab.  

4. In the Advanced settings area, select the Do not cache thumbnails check box. 

5. In the Folder views area, click Apply to All Folders. 

6. Click OK to save the changes. 

Using Microsoft's Terminal Services to Remotely Manage the Agent  

This method applies to MS NetMeeting, RDP, and similar remote Agent software. 

To log on to the remote computer using the Console of Microsoft Terminal Services 

 Open a command prompt and type the following command  

mstsc /v:<servername> /admin 

Note that there is a space before /v and /admin. <servername> is the server you want to manage. Type 

its IP address or server name.  

 

As of Windows XP Service Pack 3, Windows Vista Service Pack 1, and Windows Server 2008, the 
/console switch for the Windows Remote Desktop Connection Tool is not available. Use the 
/admin option instead.   

To log off from the Terminal Services Console on Windows Server 2003 

1. Click Start > Run, type tsadmin, then press ENTER. 

2. On the server, on the right side is the account you are logged in as. 

3. Right-click and choose log off. 
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On Windows 2000: 

In Microsoft Terminal Services for Windows 2000, remote users can log in to see ONLY those resources 
to which they have been provided access. The software runs under the System account. You typically log 
on through Terminal Services under an administrator account, which does not allow you access or view 
SYSTEM activities. If you use Terminal Services to access a Windows 2000 computer running the 
software, you must stop the service, then start the software as an application. You cannot manage it while 
it runs as a Windows Service. 

PCAnywhere, CarbonCopy, RealVNC (free www.realvnc.com), DAMEWARE, GOTOMYPC etc. are not 
limited like Microsoft Terminal Services for Windows 2000. If using Windows 2000, we recommend the 
use of one of these products to help manage this functionality.  

Configuration Notes 

1. When connecting via Terminal Services to the Windows computer running an Agent, you must 
log on to the computer using the highest possible access levels. Otherwise, your changes may 
not be saved when you set it to operate as a Service. Check the owner status of files/folders 
before making permission security changes. 

2. Microsoft Terminal Services does not allow you to view activity on a remote computer; it shows 
only a portion (a session specific to your administrator login). Many items that are visible on the 
actual screen are not displayed. This includes icons, warnings on shutdown, progress bars, 
status, etc. When you run the Agent as a Windows Service, Terminal Services will not display the 
icon or menu. You cannot perform Agent management functions while it is running as a Windows 
Service if you use Terminal Services. You must stop the service and restart it as a program.  

3. Shutdown messages are not displayed, so you must wait for the Agent service to shut off. It may 
take a minute for the warning screens to timeout. 

4. When logged on via Terminal Services and now running the software as a program (not as a 
Service), Terminal Services displays all the icons and you can do all Agent management. Note 
that you do not have access to your files while running as a program instead of a service. Finish 
making your changes, then restart as a service. Either log on with Terminal Services and run as a 
program and manage it, or run it as a Service and you can access the files. Perform your 
management from Terminal Services, and then restart as a Windows Service. (Preferences, Run 
as NT Service check box.)  

5. If the Agent is running as a Service, and you attempt to start the Agent from the Start menu, you 
will receive a message that the Agent is already running. It is even possible that another user 
session started the Agent, and Terminal Services does not show the Windows Service. Look in 
Task Manager for AANTS, which is the service. Make sure that show processes from all users 
is selected.  

6. To check on local users' file access, go to Network Neighborhood on your computer (not using 
Terminal Service), and browse to the files just as a user does. You will be seeing the files exactly 
as your users do. 

7. Set directory permissions when running as a service. Otherwise, upon a reboot, Windows may 
not automatically reapply the share setting. 

8. If you do decide to use a different product, such as VNC, shut off the Agent before you log out of 
Terminal Services. Otherwise, upon connect the Agent will be running, and you may not be able 
to tell, not even in Task Manager. This will be quite confusing as you start and stop the service 
but nothing happens and nothing shows up in Task Manager. 

9. Terminal Services has limitations for remote management in Windows 2000. It has more 
functionality in Windows 2003 and XP when using the console command. 
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To Manage a Remote Agent with Terminal Services 

1. Login to the remote computer using Terminal Services. 

2. Go to services and stop the Agent. Wait at least 30 seconds.   

3. Start the Agent as a program. 

4. Perform your management. 

5. When complete, click the icon once, click Preferences > run as NT Service. It needs to run as a 
Service to provide local user access to the files, and is the best method for share and security 
setting. 

Using Third-Party Backup 

 

WAFS/CDP versions 3.5.2.8916 and later are compatible with BackupExec version 12. 

One of the most important tasks of an IT manager is to protect data and back it up. With WAFS, each 
time any user modifies a file or adds a new file, that change is replicated. By having each file replicated n 
+ 1 times (to n other Agents and to one Server), and having access to previous versions of files, backup 
becomes far easier and safer. 

However, although backup copies of each file are maintained, most IT managers prefer to further backup 
the data using a traditional backup medium such as tape. Described below are best practices for backup.  

Choice 1: Backup Server 

You should run backup for the replicated data (e.g. to a tape) only on the Server's file Vault. By default, 
this is directory C:\AD on the computer running the Server. If you are not sure where the Vault directory 
is, on the Server Console, click Server > Edit Parameters.  

 

The root is listed in the Server working space box. You can back up the entire AD directory to get the 
current file AND the past versions, or just backup the P directories inside AD and get just the latest 
versions. 
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Backup of the replicating data on your Agents is unnecessary for several reasons: 

1. Backup of the Server includes the Agents' data, so adding backup of Agents is redundant. 

2. The backup can affect Agents' performance (depending on the backup technology and amount of 
data), which may adversely affect users and applications. 

3. Each Agent does not necessarily contain all of the data. Central backup of the server (D:\AD) 
gets all the data. 

4. Backup of Agents will not expedite the recovery from hardware problems. If the hardware running 
an Agent breaks, it is easy to deploy a replacement Agent. The Agent downloads the data from 
the Server and makes the data available to users in seconds, even before all of the data is 
downloaded. So as long as the Server is up, operations can resume immediately after a problem, 
without any need to restore from tape. 

5. A backup of the Server includes past versions of files. Only the Server keeps past versions. 

Choice 2: Back up Data at the Agent 

You should back up the data at the Server; however, if you decide to backup the data at the Agent, the 
important thing to remember is that your backup software will think it sees the same data multiple times. 
Backup only the AVMF and AVMO directory. Exclude the original data location, and the new drive letter. 
Restore files from AVMF, which you will see inside the P directories. Do NOT restore AVMF to the 
original location, or directly replace files into the P. Restore to a different location and then move the 
files/folders that you want back into the folder out of which your users work. 

 

If you decide to backup the data at the Agent, and your specific backup software shows errors in the 
backup, simply change the exclusions. Exclude (2 at a time): both AVMO and AVMF; any new drive 
letters; the original mapped folder. Test to make sure the backup AND the restore both work. 

 

Web Interface Security: Limiting User Access to Certain Files 

By default, a user can easily browse an entire Job from the Web interface if he has a login for the Job. In 
some situations, however, it may be necessary to restrict which folders are available to which users. 

When a user with only read-only access rights (see Manage Passwords) views a Job through the Web 
interface, the browser will display one of the following: 

 If the directory does not contain index.htm, the Web-interface displays a directory list (which also 
includes tools for renaming files, deleting files, etc.). 

 If the directory includes index.htm, the Web-interface displays it rather than display the directory 
listing. This file can contain HTML or just plain text. 

 

This file must be named index.htm. Other file names, such as index.html will not work. 

Because a user without full access is shown the contents of index.htm, if such a file exists, the Web 
interface allows for access in read-only mode to be restricted only to given folders. 

To limit user access to certain files 

1. Make sure the Job's folder does not contain a file named index.htm. You will add this file later. 

2. On a computer on which the Agent is installed, double-click the Agent system tray icon . The 
Job Properties and Options dialog box appears. 

3. On the Manage Passwords tab, create a new user. Ensure the Full Access check box is 
cleared. 
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4. Log on to the Server as the user you just created:  

a. In a Web browser, navigate to the Server address http://server:port. For example, if the 

Server is on the local computer with the default port, type http://localhost:80. The 

login page appears. 

b. Click Login to the Web interface. The login page appears. 

c. Type the Job name and the user name and password for the new read-only user, then 
click Fast Login. The File Retrieval page appears. 

d. Next to Path, above Deleted Items, click root. This expands the URL in the browser's 
Address field. 

e. Append the path to the top-most subdirectory to which you want the user to have access. 
This should be in the form of subdirectory1/subdirectory2/subdirectory3. Provide this 
URL to those who need access to the directory. 

5. Put the index.htm file in the Job folder's root and in any other subdirectory you want restricted. 

Your users do not need to know their username or password, because this information is encoded in the 
URL. If they click LEVEL UP at the topmost directory to which they have access or attempt to view the 
Job's root level, they will only see the index.htm file of the directory they are attempting to access. 

 

Restricting users to certain folders in a Job can only be implemented for users without full 
(read/write) access to the Job, and it can only be done through the Web interface. Users with read-
write permissions or who have access to a computer with an Agent connected to the Job will be able 
to browse the entire Job. Even if users have only read-only access and are using the Web interface, 
they will be able to navigate the full directory structure, if they know it, by manually editing the URL. 
They will be able to see any file whose name they know, as well as the contents of any directory that 
does not have an index.htm file. 
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Getting Help 

We have made every attempt to provide an in-depth and user-friendly help file; however, customers often 
encounter situations and configurations that might not yet be covered in this help file. GlobalSCAPE 
support technicians are available via e-mail or on the phone to answer any questions you have that are 
not sufficiently explained in the help. 

Finding Information in the Help 

You can find information in the Help using the Contents, Index, Search, and Print: 

Tab/Button Description 

Contents Displays a logical organization of the help topics, similar to chapters in a book. Click a 
main heading (represented by a book icon ) to display pages that link to topics, and 
click each sub heading (represented by a page icon ) to display the corresponding 
topic in the right pane. 

 

You can close the Table of Contents by clicking the x in the corner of the 
Contents pane; click Contents on the toolbar to display the Table of 
Contents, if hidden. 

 

Index Displays an alphabetical listing of all of the topics in the help file. 

Search  Allows you to locate words or phrases within the content of the topics. Type the word 
or phrase in the text box, press ENTER, then click the topic you want from the list of 

topics. In the application's help, you can search using Boolean (OR, AND, and NOT) 
and wildcard expressions (*, ?). Wildcard searches are not available in Web Help. 

Print Opens your computer's Print dialog box from which you can specify a printer to print 

the topic that is displayed in the right pane. In the application help, you have the option 
of printing the topic only, or the main heading topic and all subtopics in that heading. 

(Alternately, see Printing a Help Topic below.)  

Searching the Help File or globalscape.com 

We have attempted to provide intuitive names for the topic titles. The Table of Contents and the Index 
contain the topic titles of every topic in the help file. For example, if you are looking for a procedure on 
how to create a Job, click the Index tab and scroll to the topic Creating a New Job. (You can also perform 
keyword searches and click links in the PDF of the user guide.) 

When searching, try several different words for the same concept. When you search globalscape.com, 
you are searching across all GlobalSCAPE products, not just WAFS or CDP. However, globalscape.com 
uses Google search, but the help and Knowledge Base have their own proprietary search engines. Try 
globalscape.com first, then the online help, then the Knowledge Base, then the user forum. If you still 
cannot find the answer to your question, contact GlobalSCAPE Technical Support. 

Printing a Help Topic 

To print a Help topic 

1. Click Print Topic on the Navigation pane, or right-click in the topic (in the right pane), then click 
Print. The Print dialog box for your operating system appears. 

2. In the Print dialog box, click Print. The topic is printed to the specified printer. 

Sharing Topic Links 

In the online (HTML) help, the address bar displays the IP address (URL) of the help file, not the URL of 
the specific topic. If you right-click in the topic, then click Properties, you can copy of the URL of the topic 
from the dialog box; however, the URL displays only the topic, without the Table of Contents. The 
procedure below describes how to send a topic's URL with the Table of Contents.  

http://help.globalscape.com/help/guides/index.html
http://kb.globalscape.com/
http://forums.globalscape.com/tt.aspx?forumid=6
http://www.globalscape.com/support/techsupport.aspx
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To copy a topic URL that includes the table of contents 

1. Open the topic in Internet Explorer.  

2. Right-click within the topic (the right frame), then click 
Properties. 

3. Select/highlight the URL of the topic, right-click the selection, 
click Copy, and then close the Properties dialog box by 
clicking Cancel.  

4. Right-click in the address bar of your browser, click Paste, 
and then press ENTER. The topic displays, but not the Table 
of Contents (TOC). 

5. You can share the URL of just the topic only. However, if you 
want to share the topic and display the TOC, click Show. 
The URL will update in the address bar and the TOC will 
appear to the left of the topic. (Your recipients can also click 
Show if they want to view the TOC.)  

6. Copy the URL that is in the address bar then paste it into an 
e-mail, IM, text document, etc. Notice how the address 
contains index.htm, then a number sign #, then the filename of the topic: 
http://help.globalscape.com/help/wafs3/index.htm#GlobalSCAPE_Replication_Software.htm. 
 

Support Center 

For fast answers to most questions, please visit the Support Center. Our Customer Support team can 
answer your questions about software activation or help with order problems. If you need technical 
assistance with your software, call or submit your question to the technical support team.   

http://www.globalscape.com/support/
http://www.globalscape.com/support/techsupport.aspx
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